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About This
Manual

About This Manual

The Aspen Plus User Guide consists of three volumes that provide step-by-step
instructions for using Aspen Plus® to build and use a process simulation model.

Volume 1 describes the Aspen Plus user interface and explains how to perform
the basic tasks for creating and running simulations. Topics include:
• Creating a simulation model
• Defining the flowsheet
• Entering the required information, such as components, streams and physical

property data
• Running the simulation
• Examining results

Volume 2 contains procedures for using additional Aspen Plus capabilities:
• Convergence
• Sensitivity
• Design specifications
• Optimization
• Property analysis
• Data regression

Volume 3 contains information about:
• Pressure relief calculations
• Stream libraries
• Working with other Windows™ programs
• The Aspen Plus ActiveX® automation interface
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For More Information

Online Help  Aspen Plus has a complete system of online help and
context-sensitive prompts. The help system contains both context-sensitive help
and reference information. For more information about using Aspen Plus help, see
the Aspen Plus User Guide, Chapter 3.

Aspen Plus Getting Started Building and Running a Process Model  This
tutorial includes several hands-on sessions to familiarize you with Aspen Plus.
The guide takes you step-by-step to learn the full power and scope of Aspen Plus.

Aspen Plus Getting Started Modeling Processes with Electrolytes  This
tutorial includes several hands-on sessions to familiarize you with simulating
electrolyte systems with Aspen Plus.

Aspen Plus Getting Started Modeling Petroleum Processes  This tutorial
includes several hands-on sessions to familiarize you with simulating petroleum
processes with Aspen Plus.

Aspen Plus Getting Started Customizing Unit Operation Models  This
tutorial includes several hands-on sessions to familiarize you with the
customization of unit operation models with Aspen Plus.

Aspen Plus User Guide  The three-volume Aspen Plus User Guide provides
step-by-step procedures for developing and using an Aspen Plus process
simulation model. The guide is task-oriented to help you accomplish the
engineering work you need to do, using the powerful capabilities of Aspen Plus.

Aspen Plus reference manual series  Aspen Plus reference manuals provide
detailed technical reference information. These manuals include background
information about the unit operation models and the physical properties methods
and models available in Aspen Plus, tables of Aspen Plus databank parameters,
group contribution method functional groups, and a wide range of other reference
information. The set comprises:
• Unit Operation Models
• Physical Property Methods and Models
• Physical Property Data
• User Models
• System Management
• System Administration
• Summary File Toolkit

Aspen Plus application examples  A suite of sample online Aspen Plus
simulations illustrating specific processes is delivered with Aspen Plus.
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Aspen Plus Installation Guides   These guides provide instructions on
platform and network installation of Aspen Plus. The set comprises:
• Aspen Plus Installation Guide for Windows
• Aspen Plus Installation Guide for OpenVMS
• Aspen Plus Installation Guide for UNIX

The Aspen Plus manuals are delivered in Adobe portable document format (PDF)
on the Aspen Plus Documentation CD.

Technical Support
World Wide Web  For additional information about AspenTech products and
services, check the AspenTech World Wide Web home page on the Internet at:

http://www.aspentech.com/

Technical resources  To obtain in-depth technical support information on the
Internet, visit the Technical Support homepage. Register at:

http://www.aspentech.com/ts/

Approximately three days after registering, you will receive a confirmation e-mail
and you will then be able to access this information.

The most current Hotline contact information is listed. Other information
includes:
• Frequently asked questions
• Product training courses
• Technical tips
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AspenTech Hotline  If you need help from an AspenTech Customer Support
engineer, contact our Hotline for any of the following locations:

If you are located in: Phone Number Fax Number E-Mail Address

North America & the
Caribbean

+1-617/949-1021

+1-888/996-7001
     (toll free)

+1-617/949-1724 support@aspentech.com

South America
   (Argentina office)

   (Brazil office)

+54-11/4393-5308

+55-11/5506-0756

+54-11/4394-8621

+55-11/5506-0567

tecnoba@aspentech.com

tecnosp@aspentech.com

Europe, Gulf Region, & Africa
   (Brussels office)

   (UK office)

+32-2/724-0100

+44-1223/312220

+32-2/705-4034

+44-1223/366980

atesupport@aspentech.com

Japan +81-3/3262-1743 +81-3/3262-1744 atjsupport@aspentech.com

Asia & Australia

   (Hong Kong office)

   (Korea office)

+85-2/2838-6077

+82-2/761-5800

+85-2/2833-5642

+82-2/761-5803

atasupport@aspentech.com

❖     ❖     ❖     ❖ 
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17 Convergence

This chapter includes the following topics about convergence:
• Flowsheet recycles and design specifications
• Convergence Options
• Specifying tear streams
• User-defined convergence blocks
• Convergence Methods
• User-defined convergence order
• Specifying the calculation sequence
• Initial guesses
• Flowsheet sequencing
• Checking results
• Control panel messages
• Strategies for flowsheet convergence

Flowsheet Recycles and Design
Specifications

Aspen Plus performs flowsheet calculations using the sequential modular method.
Each unit operation block is executed in sequence. The calculated output streams
of each block are used as feed to the next block.

Flowsheets with recycle loops, design specifications, or optimization problems
must be solved iteratively. Execution requires that:
• Tear streams are chosen. A tear stream is a recycle stream with component

flows, total mole flow, pressure, and enthalpy all determined by iteration. It
can be any stream in a loop.
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• Convergence blocks are defined to converge the tear streams, design
specifications, or optimization problems. Convergence blocks determine how
guesses for a tear stream or design specification manipulated variable are
updated from iteration to iteration.

• A sequence is determined, which includes all of the unit operation and
convergence blocks.

If you do not specify the tear streams, convergence blocks, or sequence,
Aspen Plus determines them automatically. Every design specification and tear
stream has an associated convergence block. The Aspen Plus generated
convergence block names begin with the character “$.” User-defined convergence
blocks should not begin with the character “$.”

Aspen Plus automatically determines any additional specifications needed to
execute the flowsheet. By default, Aspen Plus also checks the user-specified
sequences to ensure that all loops are torn.

Convergence specifications you can make are:

If you want to specify Use this Convergence form For more details see this section in this chapter

Convergence parameters and/or methods for
convergence blocks

 Conv Options Convergence Options

Some or all of the tear streams needed for
system-generated convergence blocks

Tear Specifying Tear Streams

Some or all of the convergence blocks needed Convergence Specifying User-Defined Convergence Blocks

Convergence order for some or all of the user-
defined convergence blocks

Conv Order Specifying Convergence Order

Sequence for all or part of a flowsheet Sequence Specifying the Calculation Sequence

Convergence Options

Use the Convergence ConvOptions sheets to specify the following for convergence
blocks:
• Tear Convergence tolerance
• Convergence methods for tear streams, design specifications, and

optimization problems used in convergence blocks generated by Aspen Plus
• Parameters that affect sequencing
• Convergence parameters for each method. The specified parameters are used

as defaults for convergence blocks you define and convergence blocks
generated by Aspen Plus.
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Specifying Tear Convergence Parameters
A tear stream is converged when the following is true for all tear convergence
variables:

− ≤
−

≤tol
X X

X
tolcalculated assumed

assumed

For streams, the default convergence variables are total mole flow,all component
mole flows, pressure, and enthalpy. When the Trace Option is Cutoff (specified on
the Convergence ConvOptions Defaults TearConvergence sheet), Aspen Plus
bypasses this convergence test for components that have a mole fraction less
than the Trace threshold. The default Trace threshold is Tolerance/100. The
alternative trace option, Trace-option = Gradual, adds a 100*Trace threshold
term to the denominator. This setting gradually relaxes the convergence test for
trace components.

To specify tear convergence parameters for convergence blocks:
1. From the Data menu, point to Convergence, then Conv Options.

2. Click the Tear Convergence sheet.

3. Specify tolerance and other convergence parameters, such as Trace Threshold
and Trace Option.

The following parameters are available on the Tear Convergence sheet:

Field Default To

Tolerance 0.001 Specify Tear convergence tolerance

A tear stream is converged when the following is true for all stream variables:

− ≤
−

≤tol
X X

X
tolcalculated assumed

assumed

Trace
Threshold

Tolerance/100 Specify the trace component threshold

Aspen Plus bypasses this convergence test for components that have a mole
fraction less than the Trace threshold.

Trace
Option

Cutoff Select the Convergence test option for trace components. Trace option =
Gradual adds 100*TraceThreshold term to the denominator. This setting
gradually relaxes the convergence test for trace components.

Component
Group

All components Identify the Component group ID for components to be converged in tear
streams

Component groups are defined on the Components Comp-Group form (see
Chapter 6). Use a component group when you know that some components
have zero or constant flow rates. A Component Group may cause
convergence problems if the unconverged components have significant flow.

Component group specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix size
and the number of numerical derivative perturbations.

Continued
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Field Default To

State Pressure & Enthalpy Select the State variables to be converged.

You can select a State option other than the default (Pressure and enthalpy)
when pressure is known to be constant or enthalpy is not calculated
(mass-balance-only simulations).

State specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix size
and the number of numerical derivative perturbations.

Restore
Tears on
Error

checked Restore tear to last guessed value when there is a convergence error.

Flash Tear
Streams

checked Flash tear streams after being updated by the convergence block.

Check Flash Tear Streams if you access the temperature, density or entropy
of the tear stream through in-line Fortran or if you need to see or use
intermediate or partial convergence results. Do not check Flash Tear Streams
if you want to save calculation time or if you do not need intermediate
convergence results. Flashing tear streams is independent of the
convergence method, with one exception. If Chemistry is associated with the
tear stream, then the default is not to flash for tear streams, irrespective of
your selection.

Diagnostics Display Maximum Error /
Tolerance

Specify whether tables of all variables or only the variable with the maximum
error should be generated.

Specifying Default Methods
You can specify the numerical methods to be used by the system-generated
convergence blocks. See Convergence Methods, this chapter, for information on
the numerical methods.

To specify the numerical methods to be used by the system-generated
convergence blocks:
1. From the Data menu, point to Convergence, the Conv Options.

2. Select the Default Methods sheet.

3. You can specify the numerical methods to be used by the convergence blocks.
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The following parameters are available on the Default Methods sheet:

Field Default To specify the convergence method for system-generated

Tears Wegstein Tear convergence blocks
The other methods available are Direct, Broyden, and Newton.

Single Design
Spec

Secant Single design-spec convergence blocks
The other methods available are Broyden and Newton.

Multiple Design
Specs

Broyden Multiple design-spec convergence blocks
The other method available is Newton.

Tears & Design
Specs

Broyden Combined tears and design-specs convergence blocks
The other method available is Newton.

Optimization SQP Optimization convergence blocks

Specifying Sequencing Parameters
You can specify parameters to control tear stream selection and automatic
sequencing.

To specify the tearing and sequencing parameters:
1. From the Data menu, point to Convergence, then Conv Options.

2. Select the Sequencing sheet.

3. You can specify the tearing and sequencing parameters.

The following parameters are available on the Sequencing sheet:

Field Default To specify

Design Spec Nesting Inside Whether design specifications should be nested inside tear stream loops,
outside tear stream loops, or converged simultaneously with tear streams

Design Spec Nesting does not apply to convergence blocks specified in
the Convergence Order form.

When the tear of an outer loop is recalculated in an inner loop, the actual
sequence generated may not strictly follow the loop-order preference
specified in the Design Spec Nesting and User Nesting fields.

User Nesting Outside User Nesting lets you specify a preference for whether convergence
blocks specified on the Conv Order form should be nested inside or
outside other convergence blocks (user-defined or system-generated)

The User Nesting field has precedence over the Design Spec Nesting
field.

When the tear of an outer loop is recalculated in an inner loop, the actual
sequence generated may not strictly follow the loop-order preference
specified in the Design Spec Nesting and User Nesting fields.

Continued
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Field Default To specify

Variable Weight 1 Tear variable weighting factor for tearing algorithm

If Variable Weight is a large number, the tearing algorithm minimizes the
number of torn variables.

Loop Weight 1 Loop weighting factor for tearing algorithm

If Loop Weight is a large number, the tearing algorithm minimizes the
number of loops torn.

Tear Fortran Write
Variables

not checked Whether Fortran block variables can be torn when Fortran blocks appear
in feedback loops

See Chapter 19, Fortran, in the section, Converging Loops Introduced by
Fortran Variables for more information and an example

Check Sequence checked Whether Aspen Plus checks a user-specified sequence to ensure that all
loops are torn

Specifying Convergence Method Parameters
You can specify additional parameters for each numerical method. Select the
appropriate tab for the convergence method. See Convergence Methods, this
chapter, for information on the numerical methods.

To specify the additional parameters:
1. From the Data menu, point to Convergence, then Conv Options.

2. In the left pane of the Data Browser window, select the Methods form.

3. Select the appropriate sheet for the convergence method.

4. Specify the parameters for that method.

Specifying Tear Streams

Use the Tear Specifications sheet to identify tear streams to be converged by
system-generated convergence blocks. If you specify an incomplete tear set for your
flowsheet, Aspen Plus automatically chooses the remaining set of streams. If you
specify a redundant tear set (too many tear streams), Aspen Plus may ignore some
tears or find an inefficient sequence.

To specify a tear stream:
1. From the Data menu, point to Convergence, then Tear.
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2. In the Stream field, use List and select a stream ID.

The stream must be in a recycle loop in the simulation flowsheet.

Note  When a Fortran block is in a recycle loop, you can tear variables
designated as Write Variables on the Fortran Sequence sheet.

3. Specify any of the remaining optional fields, as you choose.

The following parameters are available on the Tear Specifications sheet:

Field Default To

Tolerance 0.001 Specify Tear convergence tolerance

A tear stream is converged when the following is true for all stream
variables:

− ≤
−

≤tol
X X

X
tolcalculated assumed

assumed

Trace Tolerance/100 Specify the trace component threshold

Aspen Plus bypasses this convergence test for components that have a
mole fraction less than the Trace threshold.

Componen
t Group

All components Identify the Component group ID for components to be converged in tear
streams

Component groups are defined on the Components Comp-Group form
(see Chapter 6). Use a component group when you know that some
components have zero or constant flow rates. A Component Group may
cause convergence problems if the unconverged components have
significant flow.

Component group specifications are intended primarily for use with the
matrix convergence methods (Broyden, Newton, and SQP) to reduce the
matrix size and the number of numerical derivative perturbations.

State Pressure & Enthalpy Select the State variables to be converged

You can select a State option other than the default (Pressure and
enthalpy) when pressure is known to be constant or enthalpy is not
calculated (mass-balance-only simulations).

State specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix
size and the number of numerical derivative perturbations.

Initial Estimates for Tear Streams
You can use the Stream sheets to provide an initial estimate for the tear stream.
An initial estimate generally aids recycle convergence, and is sometimes
necessary, especially for recycle loops involving distillation blocks. For more
information on specifying streams see Chapter 9.
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Specifying User-Defined Convergence
Blocks

Use the Convergence sheets to specify convergence method, tolerance, and
convergence variables for user-defined convergence blocks. System-generated
convergence blocks generated by Aspen Plus do not use these specifications.

To define a convergence block:
1. From the Data menu, point to Convergence, then Convergence.

2. In the Convergence Object Manager click New.

3. In the Create New ID dialog box, enter an ID or accept the default name.

4. In the Create New ID dialog box, select the type of convergence block you
want to create.

Use this method To converge

BROYDEN or
NEWTON

Tear streams; two or more design specifications; or tear streams and design specifications
simultaneously. Use when the recycle loops and/or design specifications are highly interrelated.
Use Newton when Broyden is unable to converge.

COMPLEX Optimization with inequality constraints

DIRECT Tear streams by simple direct substitution. Convergence may be slow, but sure.

SECANT Single design specifications. Recommended for design specification convergence blocks.

SQP Sequential quadratic programming. Optimization with any combination of tear streams, equality
constraints, and inequality constraints.

WEGSTEIN Tear streams. You can apply Wegstein to any number of streams simultaneously.
Recommended tear stream convergence method.

For more information on the numerical methods, see Convergence Methods,
this chapter.

5. Click the Tear Streams, Design Specifications, Fortran Tears or Optimization
tab to select the elements that you want the convergence block to solve.

6. To specify optional parameters, click the Parameters sheet.

Convergence Methods

This section describes the convergence methods available in Aspen Plus.
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The parameters for each method can be found on the Convergence ConvOptions
Methods form and on the form for the Convergence block.

WEGSTEIN Method
The classical bounded Wegstein method is usually the quickest and most reliable
method for tear stream convergence. It is an extrapolation of Direct substitution
iteration. Interactions between variables are ignored; therefore, it does not work
well when variables are strongly coupled.

Wegstein method can only be used for Tear streams. It is the default method for
Aspen Plus tear stream convergence. Apply it to any number of streams
simultaneously. You can control the Wegstein bounds and the frequency of
acceleration.

You can control the Wegstein method by specifying:

Field Default To specify the

Maximum Flowsheet
Evaluations

30 Maximum number of flowsheet evaluations

Wait 1 Number of direct substitution iterations before the first acceleration
iteration

Consecutive Direct
Substitution Steps

0 Number of direct substitution iterations between acceleration
iterations

Consecutive Acceleration
Steps

1 Number of consecutive acceleration iterations

Lower Bound -5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound 0 Maximum value for the Wegstein acceleration parameter (q)

Wegstein Acceleration Parameter

You can control the Wegstein method by specifying upper and lower limits for:
• Acceleration parameter q (Upper Bound and Lower Bound)
• Number of direct substitution iterations before the first acceleration (Wait)
• Number of direct substitution iterations between acceleration iterations

(Consecutive Direct Substitution Steps)
• Number of consecutive acceleration iterations (Consecutive Acceleration

Steps).

In the bounded Wegstein method, the acceleration parameter q is calculated for
each tear stream variable as follows:
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Where:

X = Estimate of the tear stream variable

G(X) = Resulting calculated value of the variable

k = Iteration number

The new estimate calculated by Wegstein is:

X qX q G X

X q G X X
k k k
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1
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The following shows the effect of q on convergence:

q Convergence

q < 0 Acceleration

q = 0 Direct substitution

0 < q < 1 Damping

Because oscillation or divergence can occur if q is unbounded, limits are set on q.
The default lower and upper bounds on q are -5 and 0, respectively. For most
flowsheets, these limits work well and do not need to be changed.

Normally, you should use an Upper Bound of the Wegstein acceleration
parameter of 0. If iterations move the variables slowly toward convergence,
smaller values of the lower bound of the Wegstein acceleration parameter
(perhaps -25 or -50) may give better results. If oscillation occurs with direct
substitution, values of the lower and upper bounds between 0 and 1 may help.
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DIRECT Method
For direct substitution, the new value of the tear stream variable is the value
resulting from the previous flowsheet calculation pass:

X G Xk k+ =1 ( )

Where:

X = Estimate of tear stream variable

G(X) = Resulting calculated value of the variable

k = Iteration number

With direct substitution, convergence is slow but sure. It is available for those
rare cases where other methods may be unstable. Direct substitution can also
make it easy to identify convergence problems, such as component build-up in the
system. Direct substitution is equivalent to Wegstein with lower bound=upper
bound=0.

Secant Method
Secant is the secant linear approximation method, with higher order
enhancements. You can select a bracketing/interval halving option. Select this
option whenever the function is discontinuous, non-monotonic, or flat over a
region. Bracketing will eliminate the flat region and switch back to Secant
method if possible.

You can use Secant for converging single design specifications. Secant is the
default method for design specification convergence, and is recommended for
user-generated convergence blocks.

You can control the Secant method by specifying:

Field Default To specify

Maximum Flowsheet
Evaluations

30 Maximum number of flowsheet evaluations

Step Size 0.01 Initial step size, as a fraction of range, for the design specification
manipulated variable

Maximum Step Size 1 Maximum step size, as a fraction of range, for the design specification
manipulated variable

Continued
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Field Default To specify

X Tolerance 1e-8 Alternative tolerance on the manipulated variable

Iteration stops when the change in the scaled manipulated variable is less
than X Tolerance.

X Final on Error Last value Which value of manipulated variable to use as the final value when the
convergence block encounters an error

Options are Last value, Initial value, Minimum value of function, Lower
bound, and Upper bound.

Bracket No If the Secant algorithm should switch to a Bracketing algorithm.

Bracketing attempts to find a variable range where the design specification
function changes sign and performs interval halving when Secant is not
making progress.

When Bracket is specified as No, then Bracketing is not used. Since
bracketing may add extra iterations, in some cases, particularly with a
nested secant loop, you might want to specify Bracket as No.

When Bracketing is specified as Yes, Bracketing is tried if the function is
not changing. The Bracket = Yes option is useful for functions that are flat
over a portion of the variable range.

When Bracket is specified as Check Bounds, Bracketing is tried if the
function is not changing or if the Secant algorithm has moved to a variable
bound. The Bracket = Check Bounds option is useful for functions that are
flat over a portion of the variable range. It can also be useful for non-
monotonic functions. This option ensures that if the Secant algorithm
becomes stuck at a variable bound, the other variable bound will also be
tried.

Find Minimum Function
Value if Bracketing Fails to
Detect a Sign Change.

Not checked Find the minimum function value if bracketing fails to detect a sign change.

BROYDEN Method
The Broyden method is a modification of Broyden's quasi-Newton method. The
Broyden method is similar to the Newton method, but it uses approximate
linearization. This approximation makes Broyden faster, but occasionally not as
reliable, as the Newton method.
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Use Broyden to converge tear streams, two or more design specifications, or tear
streams and design specifications simultaneously. Broyden is useful for multiple
tear streams and/or design specifications, tear variables that are highly
interdependent, or recycle loops and design specifications so interrelated that
nesting is impractical. When converging both tear streams and design
specifications, you can specify that tear streams be converged or partially
converged first. The simultaneous convergence of both tear streams and design
specifications then follows.

You can control the Broyden method by specifying:

Field Default To specify

Maximum Flowsheet Evaluations 30 Maximum number of flowsheet evaluations

X Tolerance 0.001 Alternative tolerance on the manipulated variables

The iteration stops when the change in the scaled manipulated
variable is less than X Tolerance

Wait 2 Number of direct substitution iterations before the first acceleration
iteration

Tear Tolerance (on Advanced
Parameters dialog box)

Tear tolerance. Used if initializing tears by converging tears (to
specified tolerance) before design specifications are included

Tear Tolerance Ratio (on Advanced
Parameters dialog box)

Tear tolerance ratio. Used if initializing tears by converging tears (to
a tolerance relative to the tear tolerance) before design
specifications are included

Maximum Iterations (on Advanced
Parameters dialog box)

Maximum number of flowsheet iterations to solve tears before
design specifications are included

Lower Bound (on Advanced
Parameters dialog box)

-5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound (on Advanced
Parameters dialog box)

0 Maximum value for the Wegstein acceleration parameter (q)
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NEWTON Method
NEWTON is an implementation of the modified Newton method for simultaneous
nonlinear equations. Derivatives are calculated only when the rate of
convergence is not satisfactory. The implementation allows bounds on the
variables, and includes a line search for improved stability. NEWTON is useful
when the recycle loops and/or design specifications are highly interrelated, but
convergence is not achieved using the Broyden method. Numerical derivatives
are calculated frequently. Use NEWTON for tear streams only when the number
of components is small or when convergence cannot be achieved by the other
methods. When converging both tear streams and design specifications, you can
specify that tear streams be converged or partially converged first. The
simultaneous convergence of both tear streams and design specifications then
follows.

When you use the Newton or Broyden methods to converge design specifications,
and one or more manipulated variables have reached their lower or upper limits,
a solution is found that minimizes the sum of squares of design specification and
tear stream errors, divided by their tolerances. Iterations stop when the root
mean square of the changes in the scaled manipulated variables is less than
X tolerance. Aspen Plus scales each manipulated variable, dividing it by the
absolute value of the lower or upper limit, whichever is larger.

You can control the Newton method by specifying:

Field Default To specify

Maximum Newton Iterations 30 Maximum number of Newton iterations

Maximum Flowsheet
Evaluations

9999 Maximum number of flowsheet evaluations

Wait 2 Number of direct substitution iterations before the first acceleration iteration

X Tolerance 0.0001 Alternative tolerance on the manipulated variables

The iteration stops when the change in the scaled manipulated variable is
less than X Tolerance

Reduction Factor 0.2 Reduction factor which determines the number of Newton iterations used
before calculating a new Jacobian (derivative) matrix

With this option, the Jacobian is reused as long as it continues to decrease
the error each iteration by the Reduction Factor

Iterations to Reuse
Jacobian

Number of iterations to reuse the Jacobian (derivative) matrix

With this option, the Jacobian is reused a set number of times

The default is to base the reuse of the Jacobian on the Reduction Factor

Tear Tolerance (on
Advanced Parameters
dialog box)

Tear tolerance. Used if initializing tears by converging tears (to specified
tolerance) before design specifications are included

Continued
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Field Default To specify

Tear Tolerance Ratio (on
Advanced Parameters
dialog box)

Tear tolerance ratio. Used if initializing tears by converging tears (to a
tolerance relative to the tear tolerance) before design specifications are
included

Maximum Iterations (on
Advanced Parameters
dialog box)

Maximum number of flowsheet iterations to solve tears before design
specifications are included

Lower Bound (on Advanced
Parameters dialog box)

-5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound (on Advanced
Parameters dialog box)

0 Maximum value for the Wegstein acceleration parameter (q)

COMPLEX Method
You can use the Complex method to converge optimization problems with bounds
on the manipulated variables and inequality constraints. COMPLEX is a direct
search method; it does not require numerical derivatives. It may be useful for
simple problems without recycle loops or equality constraints (design
specifications).

SQP Method
You can use the state-of-the-art sequential quadratic programming (SQP)
method for flowsheet optimization for simultaneous convergence of optimization
problems with constraints (equality or inequality) and/or tear streams. The
algorithm generally follows an infeasible path (constraints and tear streams are
converged simultaneously with the optimization problem). But you can adjust it
to follow a feasible path (converging the tear streams at each iteration of the
optimization). SQP is used for system-generated optimization convergence blocks.
SQP is recommended for user-generated convergence blocks.

SQP-Biegler is an SQP implementation developed by Professor L. Biegler of
Carnegie-Mellon University and his students.
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You can control the SQP method by specifying:

Field Default To specify

Maximum Optimization Iterations 30 Maximum number of SQP optimization iterations

Maximum Flowsheet Evaluations 9999 Maximum number of flowsheet evaluations

Each perturbation step for numerical derivatives is counted as
one evaluation.

Additional Iterations when Constraints
are not Satisfied

2 Number of additional iterations when constraints are not
satisfied after the convergence test is satisfied.

Iterations to Converge Tears for Each
Optimization Iteration

3 Number of iterations to take toward converging tears at each
iteration of the optimization

Iterations to Enforce Maximum Step
Size

3 Number of iterations to enforce maximum step size on the
manipulated variables

Tolerance 0.001 Optimization convergence tolerance

Wait 1 Number of direct substitution iterations before the first
acceleration iteration

Lower Bound -5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound 0 Maximum value for the Wegstein acceleration parameter (q)

SQP Wegstein Acceleration Parameters

When the SQP method is used to converge tears and optimization problems
simultaneously, the algorithm is a hybrid of an infeasible path method (where
the tears are not converged at each iteration but are converged at the optimum)
and a feasible path method (where the tears are converged at each iteration of
the optimization). You may control the degree to which the tears are converged
by specifying the number of iterations to take toward converging the tears
(Iterations To Converge Tears Each Optimization Iteration) and upper and lower
limits for the Wegstein acceleration parameter for the Wegstein iterations
(Upper Bound, Lower Bound).

 Specifying Convergence Order

You can specify the calculation order of convergence blocks you define if you use
more than one user-defined convergence block. Specify the convergence order on
the ConvOrder Specification or Sequence Specifications sheet.
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To define a convergence order:
1. From the Data menu, point to Convergence, then Conv Order.

2. Select a block from the Available Blocks list. Use the arrow to move the block
that you want converged first to the top of the Convergence Order list.

3. Select any other blocks that you want in the order and move them to the
Convergence Order list. You can use the up and down arrows to rearrange the
order within the list. The first convergence block is converged first and nested
most deeply.

Specifying the Calculation Sequence

You can define the calculation order for all or part of the flowsheet. You supply an
ID for each sequence.

To define a sequence:
1. From the Data menu, point to Convergence, then Sequence.

2. In the Object Manager click the New button.

3. In the Create New ID dialog box, enter an ID or accept the default ID and
click OK.

4. Specify the calculation sequence on the Specifications sheet. On each row of
the sheet, you can enter one of the following:

• The beginning of a loop
• The end of a loop
• A block ID
• A sequence ID for part of a flowsheet

For the beginning and end of a loop, specify Begin or Return To in the
Loop-Return field. Specify the block type in the Block Type field. The following
blocks begin loops:
• Convergence
• Sensitivity
• Data Fit

Fortran blocks can introduce loops only for the special case of loop control
Fortran blocks.

Specify the block type and block ID for the following block types:
• Unit operation
• Equipment
• Utility
• Transfer
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• Fortran
• Balance
• Pres-Relief

For economic calculations, specify Economic for block type. There is no block ID
for economic calculations.

Within a sequence you can insert a subset of the flowsheet that already has an
ID and a defined sequence. For large flowsheets it is useful to build up the
sequence specification in this manner. Specify Sequence in the Block Type field.
Specify the sequence ID for the subset in the Block ID field.

Aspen Plus executes the sequences exactly as you enter them, with these
exceptions:

If you Aspen Plus

Check the Check Sequence field on the
ConvOptions Defaults Sequencing sheet

Checks whether all loops in a sequence are torn. If a loop is not torn,
Aspen Plus displays an error message

Specify Execute Before or Execute After in a
Fortran block

Inserts the Fortran block into your sequence

Specify a Design-Spec Automatically generates convergence blocks for design specifications and
inserts them into your sequence

Using Initial Guesses
For many simulations with recycle streams, initial guesses for the tear streams
will help convergence. This is especially true for recycle systems with closed loops
or recirculating solvent loops. You can often provide a reasonable initial guess
from your knowledge of the process or through a simple mass-balance
calculation.

The sequence is displayed in the left pane of the Control Panel. If the left pane of
the Control Panel is empty, select Step from the Run menu.

Enter initial compositions and flow rates for the tear streams on Streams
Specification sheets, and run the simulation. Or select your own tear streams
using the Tear sheet, and provide initial estimates for them.
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Flowsheet Sequencing

The tearing and sequencing of a flowsheet is complex and can require user input.
The following information on interacting with the Aspen Plus sequencing algorithm
is intended for advanced users. It is recommended that other users accept the
default sequencing.

Aspen Plus initially tears and sequences flowsheets in this sequence:
1. The information flow (incidence matrix) of unit operation blocks, Fortran

blocks, design specifications, constraints, optimizations, and cost blocks is
collected.

2. Sequences you specify are checked for possible missing tears and are used to
generate a reduced incidence matrix. In the reduced incidence matrix,
subsequences you specify are collapsed and treated as a single block.

3. The reduced incidence matrix is partitioned into independent subsystems
that can be solved sequentially.

4. Tear streams or Fortran block tear variables are determined for each
subsystem, taking user-specified Tear, Tear Variable, and Convergence
specifications into consideration. The automatic sequencing algorithm in
Aspen Plus selects tear streams by minimizing a weighted combination of the
number of:

• Tear variables
• Times loops are torn

5. An initial sequence is determined as part of the tearing. For each subsystem,
Convergence blocks are created for design specifications, tear streams, and
tear variables that are not converged by user-specified convergence blocks.
Specifying Design Spec Nesting  as Inside on the Convergence ConvOptions
Defaults Sequencing sheet generates one tear convergence block for all tear
streams and tear variables, and generates an individual design specification
convergence block for each design specification. See Specifying Sequencing
Parameters, this chapter, for more information.

You can affect the automatic sequencing algorithm by:
• Adjusting the Variable Weight and Loop Weight parameters on the

Convergence ConvOptions Defaults Sequencing sheet.
• Specifying initial estimates for possible tear streams on the Streams forms.

The specifications for non-feed streams are used as initial guesses if possible.
Streams with data are weighted in the sequencing algorithm, so they are
more likely to be selected as tear streams.

• Specifying tear streams directly, using the Tear Specification sheet. You
should be careful not to specify more tear streams than required for
convergence. You can underspecify the number of tear streams, and
Aspen Plus will determine the additional tear streams needed.
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Obtaining Final Convergence Sequence
To obtain the final convergence sequence:
1. All convergence blocks are ordered as they appear on the ConvOrder

Specification form and the current setting of User nesting on the
ConvOptions Defaults Sequencing sheet. Blocks not mentioned on the
ConvOrder Specification form are ordered according to the setting of Design
Spec Nesting on the ConvOptions Defaults Sequencing sheet and the span of
convergence blocks in the initial sequence.

2. Aspen Plus obtains the final convergence sequence by repeatedly removing
tears and/or design specifications from the outermost convergence block and
partitioning the reduced flowsheet.

3. For Design specification nesting as Inside or Inside simultaneous on the
Convergence ConvOptions Defaults Sequencing sheet, you can define user-
specified convergence blocks for design specifications, and they will be
inserted automatically into the sequence.

Adding Special Options to the Sequence
At the end of the final convergence sequence, special options are added:
1. Blocks with Execute options are inserted into the sequence.

2. Sensitivity, Balance, and Data Fit blocks not already in the sequence are
inserted.

Because a design specification loop usually has a small span, the sequencing
algorithm does not nest them (for example, a tear loop outside and many
independent design specification loops inside). Since the algorithm does not take
numerical values into account, it sometimes places design specification loops
inside tear loops when they would perform better outside. Specifying Design Spec
Nesting as Outside on the Convergence ConvOptions Defaults Sequencing sheet
would alter the sequence but this often leads to deeply nested iteration loops for
large flowsheets.

Viewing the Sequence
To view the sequence along with the tear streams and the convergence blocks
determined by Aspen Plus:
➤ From the View menu, click Control Panel.

The sequence is displayed in the left pane of the Control Panel. If the left
pane of the Control Panel is empty, select Step from the Run menu.
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Sequencing Example

This example describes steps to converge a simple flowsheet that does not
converge properly when automatic sequencing is used. It illustrates:
• Supplying initial estimates for recycle streams
• Altering the calculation sequence with Design spec nesting
• Altering the calculation sequence with Conv Order
• Adjusting tolerances to account for nested loops

The flowsheet consists of:

Blocks Type

TOPCOL, BOTCOL Interconnected columns

HEATER Pre-heater

COOLER Product cooler

The mass flow of stream REFLUX, the inter-reflux stream from BOTCOL to
TOPCOL, is manipulated to meet a purity specification of component THF in
stream PROD. PROD is a product stream from BOTCOL/COOLER, in design
specification THF. PSPEC is the convergence block defined to converge THF.
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When distillation columns appear in a recycle loop, it is often necessary to give
initial estimates for the tear stream. Aspen Plus makes this easy. Simply supply
data for a column feed or other stream in the loop on Streams forms, just as you
would for a feed stream, and Aspen Plus will preferentially select the stream as a
tear stream (your stream may not be selected if another stream is a better choice
by the tearing criteria).

From initial estimates for the tear stream, the Aspen Plus sequencing algorithm
determines the following computation sequence:

HEATER
$OLVER01 TOPCOL
| PSPEC BOTCOL COOLER
| (RETURN PSPEC)
(RETURN $OLVER01)

$OLVER01 is defined to converge stream REFLUX, the inter-connecting stream,
with initial data provided. However, with this sequence the PSPEC and
$OLVER01 convergence blocks fail to converge, because the design specification
is nested inside the column recycle loop. The design specification THF does not
converge, because the purity specification is determined primarily by the inter-
reflux between the two columns (not the top product rate of the BOTCOL alone).

The inter-reflux between the columns should be converged before evaluation of the
design specification. The design specification should be nested outside the column
recycle loop. You can alter the nesting order of the convergence loops by either:
• Specifying Design Spec Nesting as Outside on the Convergence ConvOptions

Defaults Sequencing sheet, or
• Specifying PSPEC on the Convergence ConvOrder Specifications sheet.

Either specification would cause the sequencing algorithm to determine the
following computation sequence, which converges:

HEATER
PSPEC
| $OLVER01 TOPCOL BOTCOL
| (RETURN $OLVER01
| COOLER
(RETURN PSPEC)

Both methods of specifying the nesting order are equivalent for this simple
problem. But using the ConvOptions Defaults Sequencing form allows you to
change the computation sequence selectively when dealing with large flowsheets.

In this flowsheet there is no need for special tolerance adjustments to account for
the nesting of iteration loops. For some flowsheets it is necessary to adjust
tolerances so the inner loops are calculated more accurately than outer loops;
otherwise the outer loops would be overwhelmed with errors from inner loops.
For the sequence above, use the following levels of calculation accuracy:
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For these blocks Use this level of accuracy

HEATER, PSPEC Final

$OLVER01, COOLER Intermediate (higher)

TOPCOL, BOTCOL Highest

If the Error/Tolerance for PSPEC seems to go down to 10 quickly and stay there,
you should tighten tolerances for all the blocks inside the PSPEC loop or loosen
the tolerance for PSPEC. If you observe a similar problem in $OLVER01, you
could tighten the tolerances of TOPCOL and BOTCOL.

It is particularly important to ensure that any nested design specifications have
sufficiently tight tolerances, since these tolerances are specified by the user. If
problems occur, or if the design specification is nested deeply, a tighter tolerance
may be necessary.

Checking Convergence Results

After your simulation has completed or while it is paused, you can view
convergence block results to check the status or diagnose convergence problems.
1. If your simulation is paused, from the Run menu, click Load Results.

2. On the Data menu, point to Convergence, then Convergence.

3. In the Convergence Object Manager, select the convergence block and click Edit.
For system-generated convergence blocks, (names beginning with $OLVER), the
results sheets are displayed. For user-defined convergence blocks, select Results
on the left pane of the Data Browser window to display the results sheets.

4. Choose the appropriate sheet:

This sheet Contains the information

Summary Final convergence status, variable value, and Err/Tol for each variable converged by the
block

Tear History Table of maximum Err/Tol versus iteration number. Variable with maximum error at each
iteration. Plots of Err/Tol versus iteration number can be generated.

Spec History Table of manipulated variable values and design specification error versus iteration
number. You can generate plots of design specification error versus iteration number, or
design specification error versus manipulated variable value.
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Use the Tear History and Spec History sheets and the Diagnosing Tear Stream
Convergence and Diagnosing Design-Spec Convergence tables, to help you
diagnose and correct tear stream and design specification convergence problems.
It is helpful to generate a plot of Err/Tol versus iteration number.

Increasing diagnostics can also help with diagnosing problems. See Convergence
Diagnostics, this chapter, for more information.

Control Panel Messages

The Control Panel displays convergence diagnostics for each convergence block.
Each time the convergence block is executed in a recycle convergence loop,
messages appear with the following format:

> Loop CV          Method: WEGSTEIN Iteration 9
Converging tear streams: 3
4 vars not converged, Max Err/Tol    0.18603E+02

Each time a convergence block for a design specification is executed in a
convergence loop, messages appear with the following format:

>> Loop CV         Method:  SECANT Iteration 2
Converging specs:  H2RATE
1 vars not converged, Max Err/Tol    0.36525E+03

Where:

CV = Convergence block ID

Max Err/Tol = Maximum error/tolerance for the unconverged variables

> = Symbol indicating nesting level of the convergence loop
> Outside loop
>> Loop nested one deep
>>> Loop nested two deep

and so on

Convergence is achieved when the value of Max Err/Tol becomes less than 1.0.

Convergence Diagnostics

You can modify the diagnostic level for convergence globally on the Setup
Specifications Diagnostics sheet. For more details about how to change the
diagnostics level, see Chapter 5.
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Use the Convergence sliders to modify the diagnostic level for convergence block
information in either the control panel and in the history file. You can also
specify the diagnostic level for a single convergence block using the Diagnostics
button on the Input Parameters sheet for any convergence block.

The default diagnostic level within Aspen Plus is 4. At a Convergence Diagnostics
Level of 4, a message is created in the Control Panel every time the convergence
block executes. This message contains the following information:
• Convergence block
• Convergence method
• Iteration number
• What the convergence is trying to converge
• Number of unconverged variables
• Maximum error/tolerance for that iteration of the convergence block

Messages in the history file are similar, but not identical.

At a Convergence Diagnostics Level of 5, Aspen Plus creates a table of
convergence information in the Control Panel for all unconverged variables.

For example:

 > Loop C-1      Method: BROYDEN      Iteration    1

  Converging tear streams: 4
  Converging specs: H2RATE
                            NEW X        G(X)         X           ERR/TOL
      TOTAL MOLEFLOW  (1) 0.135448E-01 0.135448E-01 0.000000E+00  10000.0
      N2 MOLEFLOW     (2) 0.188997E-03 0.188997E-03 0.000000E+00  10000.0
      C1 MOLEFLOW     (2) 0.755987E-03 0.755987E-03 0.000000E+00  10000.0
      BZ MOLEFLOW     (2) 0.314995E-03 0.314995E-03 0.000000E+00  10000.0
      CH MOLEFLOW     (2) 0.122848E-01 0.122848E-01 0.000000E+00  10000.0
      PRESSURE        (2) 0.217185E-01 0.217185E-01 0.100000E+36 0.100000E+07
      MASS ENTHALPY   (2)-0.137111E-01-0.137111E-01 0.100000E+36 0.100000E+07
      TOTAL MOLEFL    (3) 0.377994E-01 0.000000E+00 0.377994E-01 -375.000
  8 vars not converged, Max Err/Tol   0.17679E+05

The value in parentheses indicates the type of variable:

Variable Type Description

1 Tear stream variable which is not updated by the convergence algorithm

2 Tear stream variable which is updated by the convergence method

3 Design specification manipulated variable. Updated by the algorithm

4 Fortran Tear Variable. Updated by the algorithm

New X is the value for the variable for the next iteration. X is the value of the
variable for the previous iteration. G(X) is the calculated value for the variable at
the end of the previous iteration. When a variable is converged, X and G(X)
should differ by less than the tolerance. All values are in SI units.
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Setting the Convergence Diagnostics level to 6 or higher does not change the
amount of information reported in the Control Panel. However, it will affect the
amount of information reported in the history file, depending on the convergence
method in use.

Strategies for Flowsheet Convergence

Often a flowsheet can be converged without changing any convergence parameters.

Some general guidelines are:
• Start small. Make sure that individual blocks and elements of a flowsheet

behave as expected, before slowly combining them into a larger simulation. A
sensitivity block is useful for determining the results of other blocks under a
range of conditions.

• Start with the simplest blocks possible. For example, converge the flowsheet
with a simple HeatX before switching it to a rigorous HeatX.

• Give good initial guesses. Make sure the flowsheet starts converging from a
reasonable point. Aspen Plus gives tear streams a default value of zero, which
can cause problems. If possible, select a tear stream that remains relatively
constant.

• Check physical properties. Make sure they are calculated correctly in the
entire operating range of the simulation.

• Know how your flowsheet responds. Check the behavior of blocks and design
specifications using sensitivity analysis. Look for discontinuities and flat
regions that could cause convergence difficulties.

• Check for correctness, variable accessing, spelling, and unit specifications.
When accessing real variables, make sure your variable names do not begin
with I-N.

Tear Convergence Suggestions
This table shows the possible causes and solutions of tear stream convergence
problems.
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Diagnosing Tear Stream Convergence

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Steady convergence — Increase Maxit above 30 on the Conv Options or
Convergence block Parameters sheet.

Steady but slow convergence Component build-up

—

Check outlet streams from recycle loop to confirm that all
components have a way to leave the system. If there is not,
the problem may not be feasible from an engineering point
of view. (That is, there may not be a steady state solution.)

Allow for larger acceleration steps. For Wegstein, set Lower
bound of the Wegstein acceleration parameter = -20 on the
ConvOptions Wegstein sheet, or on the Convergence block
Wegstein Input Parameters sheet. If this change speeds
convergence, try lower bound = -50.

Oscillating convergence — For Wegstein, set upper bound to .5 to dampen the
oscillations.

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Err/Tol down to a threshold
level, but no further

Nested loops, and the
convergence tolerance of the
inner loops is too loose 

Do one of the following:

• Set a tighter tolerance for the blocks and convergence
blocks in the inner loop, using the Tolerance field for
these blocks. Block tolerance can be changed globally
on the Setup SimulationOptions Flash Convergence
sheet or locally on the block’s Flash Options sheet.
Convergence block tolerances can be changed
globally on the Conv Options sheet for that method or
locally on the convergence block’s Parameter sheet.

• Relax the tolerance for the outside loop.

• Converge the inside and outside loops simultaneously,
using the Broyden or Newton method. Use the Design
Spec Nesting field on the ConvOptions Defaults
Sequencing sheet.

Broyden or Newton failing to
converge

— Increase the value of Wait to 4 (on the Convergence
ConvOptions sheet or Convergence block Parameters
sheet).

If both tear streams and design-specs are specified in the
convergence block, solve only tear streams first by
specifying Tear Tolerance or Tear Tolerance Ratio. Click
the Advanced Parameters button on the Parameters sheet
of the convergence block.

Switch to the Wegstein method.
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Some other general strategies for tear stream convergence are:
• Provide a good initial guess for the Tear stream on the Stream form. For more

information on specifying streams, see Chapter 9.
• Select a Tear stream that will not vary a great deal. For example, the outlet

stream of a Heater block is generally a better choice for a tear stream than
the outlet stream from a Reactor block.

• Disconnect the recycle stream to get a good initial estimate and to examine
the sensitivity.

• Try to simplify the problem. It may be possible to do one or more of the
following to reduce the complexity of the problem:
• Add a Mixer block to reduce the number of tear streams
• Replace a HeatX block with an MHeatX to reduce the number of tear

streams
• Define and use a Component Group to reduce the number of variables
• Choose a Tear stream that has fewer components present
• Choose a Tear stream from a block that sets an outlet temperature

• Reinitialize the simulation. Try to converge the simulation using a Wegstein
acceleration parameter equal to 0 (set the upper bound and lower bound to 0).
This is equivalent to direct substitution. Look for a continuing buildup of one
or more components as the iterations proceed.

• Try using a different convergence method such as Broyden or Newton rather
than the default Wegstein method.

• Confirm that the sequence for the simulation (either Aspen Plus defined or
user defined) is reasonable. See Specifying the Calculation Sequence, this
chapter.

Design Specification Convergence Suggestions
This table shows the possible causes and solutions of Design Specification
convergence problems.

Diagnosing Design Specification Convergence

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Steady convergence — Increase Maxit above 30 on the appropriate Conv Options or
Convergence block Parameters sheet.

Err/Tol not changing Spec function insensitive to
manipulated variable

Spec function flat over some
range of the manipulated
variable

1. Check if the formulation of the spec function is correct.
2. Check if the correct manipulated variable is being used.
3. Use Sensitivity study to determine the effect of the
manipulated variable on the spec function.

For the Secant method, select Bracket=Yes on the Conv
Options or Convergence block Parameters sheet, to use
interval-halving method.

Continued



Aspen Plus User Guide 17-29
Version 10.1-0

Chapter 17

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Err/Tol down to a
threshold level, but no
further

Nested loops, and the
convergence tolerance of the
inner loops is too loose

Do one of the following:

• Set a tighter tolerance for the blocks and convergence
blocks in the inner loop, using the Tolerance field for
these blocks.

• Relax the tolerance for the outside loop.

• Converge the inside and outside loops  simultaneously,
using the Broyden or Newton method. Use the Design
Spec Nesting  field on the ConvOptions Defaults
Sequencing sheet.

Converged to variable
bound

Non-monotonic Spec
function

1. For the Secant method, select Bracket=Check bounds on
the Conv Options or Convergence block Parameters sheet, to
use interval-halving method.
2. Use Sensitivity study to determine the effect of the
manipulated variable on the spec function. Adjust the bounds
on the manipulated variable, or choose a better initial guess.

Some other general strategies for Design Specification convergence are:
• Formulate specifications to avoid discontinuities.
• Formulate specifications to reduce non-linearity with respect to design

variables. For example, set a specification on the log of a concentration when
it is near zero.

• Make sure the limits are reasonable. Try to avoid limits spanning more than
one order of magnitude.

• Confirm the existence of a solution by replacing a Design specification with a
Sensitivity block.

• Make sure the tolerance is reasonable, especially when compared with the
tolerance of blocks inside the Design specification convergence block.

For more information on design specifications, see Chapter 21.

Fortran Block Convergence Suggestions
Some other general strategies for Fortran Blocks convergence are:
• Avoid iterative loops causing hidden mass balance problems. The sequencing

algorithm can detect and converge Fortran tear variables, if the Fortran block
is sequenced with Read and Write variables and if Tear Fortran Write
Variables is checked on the ConvOptions Defaults Sequencing sheet. The
Fortran tear variables are then solved along with the tear streams.

• Check the correctness of the Fortran statements in the Fortran block.
• Variables beginning with the letters I through N should be integer variables,

if they have not been declared otherwise.
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• Increase the diagnostics to check the value of variables used in the
calculations. Click the Diagnostics button on the Fortran Sequencing sheet.
On the Diagnostics dialog box, raise the level for Fortran Defined Variables to
5 or 6. This will print out the value of the accessed variables.

• Add write statements to your Fortran block to print out the value of
intermediate variables.

• If using Read and Write variables to determine the sequence, make sure that
all the variables are listed.

For more information on Fortran Blocks, see Chapter 19.

Resolving Sequence and Convergence Problems
Use the following strategy to resolve sequence or convergence problems:
1. Run the simulation using the default sequence generated by Aspen Plus.

2. Examine simulation results, looking for skipped and unconverged unit
operation blocks. Check the Control Panel and results sheets for blocks that
did not complete normally, had errors, or had unexpected results that might
affect recycle convergence. See Checking Convergence Results, this chapter,
for more information.

Some common reasons for these problems are:

Problem Action

Incorrect block specifications Correct them.

Feed conditions too far off Provide better estimates for tear streams and/or design variables.

Convergence specifications Try different specifications, different algorithm options, or increase the number of
iterations.

Algorithm options Change options.

Not enough iterations Increase number of iterations.

If you make any corrections, go to step 9.

3. Check whether tolerance needs adjustment. If the maximum error/tol for
convergence blocks reduces to around 10 quickly, but fluctuates after that,
tolerance adjustments may be necessary. For more information, see the
Sequencing Example.

Another way to correct tolerance problems is to converge multiple design
specifications with a Broyden or Newton convergence block.

4. If Wegstein convergence blocks converge slowly, try some Wegstein
parameters, such as Wait=4, Consecutive Direct Substitution Steps=4, Lower
Bound=-50. Providing better estimates for tear streams would also help.
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5. If tear stream convergence blocks oscillate, try using the Direct method for
convergence. If the problem persists, examine the flowsheet to determine if
every component has an outlet. The oscillation of a tear stream loop could also
be caused by the non-convergence of design specification loops inside the tear
stream loop; check for this next, if oscillation persists. If oscillation stops, try
the acceleration technique described in step 4.

6. Examine the Spec Summary and check for non-converged design
specifications. Some common reasons for a design specification that does not
converge are:

Design Specification Problem Action

Not reachable within bounds on variable Accept the solution or relax the bounds.

Not sensitive to manipulated variable Select a different manipulated variable to meet the design
specification or delete the design specification.

Insensitive to manipulated variable in a certain range Provide a better initial guess, refine the bounds, and/or
enable the Bracket option of the Secant convergence
method.

Not sensitive to the manipulated variable, because the
design specification loop is not nested properly

See Sequencing Example, this chapter. If it is necessary to
alter the calculation sequence, see step 7.

7. Alter the calculation sequence, if necessary, using one of the following
options. (This step requires a good understanding of the process you are
simulating and is intended for advanced users only):

If you want to Specify

Make one or more design specification loops the
outermost loops

These loops on the ConvOrder Specifications sheet (See
Specifying Convergence Order, this chapter)

Alter the nesting of a small section of the flowsheet A partial sequence on the Sequence Specifications sheet
(see Specifying the Calculation Sequence, this chapter)

Use specific tear streams These streams on the Tear Specifications sheet (see
Specifying Tear Streams, this chapter)

There are other options on the ConvOptions Defaults Sequencing sheet that
also affect the calculation sequence (see Convergence Options, this chapter).

8. If all convergence blocks are converged but the overall mass balance is not in
balance, check Fortran blocks for possible errors. It is recommended that you
use Read and Write Variables to sequence regular Fortran blocks, and use
Execute to sequence initialization Fortran blocks.

9. If the flowsheet is modified, rerun the simulation and go back to step 2.
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Example of Err/Tol Going Down to a Threshold Value

After about 8 recycle convergence iterations, the Err/Tol value goes down to a
threshold value, but not lower. This recycle is nested outside of an inner design
specification loop. Set a tighter tolerance for the inner loop.
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Example of Manipulated Variable Moving to a Bound

This design specification function is non-monotonic. Depending on the initial
value of the manipulated variable, the convergence algorithm may move the
manipulated variable to the upper bound, even though a solution exists within
the bounds. Specify Check Bounds in the Bracket field on the Convergence
ConvOptions Methods Secant sheet or Secant Input Parameters sheet. Ensure
that the secant algorithm checks both bounds, to try to bracket the solution.
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Example of Err/Tol Value Not Changing

The Err/Tol value does not change for a design specification, where the
temperature of a reactor is being manipulated to control the conversion in the
reactor. A sensitivity analysis shows that the specification function (conversion)
is flat over some range of the manipulated variable. Specify Yes in the Bracket
field on the Convergence ConvOptions Methods Secant sheet or Secant Input
Parameters sheet for this design specification problem.
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18 Accessing Flowsheet
Variables

You access or manipulate flowsheet variables when using the following
capabilities:

• Design specifications
• Fortran blocks
• Optimization problems
• Data-Fit problems
• Sensitivity blocks
• Case study

This chapter describes:

• Accessing flowsheet variables
• Types of accessible flowsheet variables
• Choosing input and parameter variables
• The layout (or structure) of the vector variable types
• Examples of how the accessed variables are used in Fortran statements

Accessing Flowsheet Variables

When you run a simulation in Aspen Plus, you often need to record or modify the
value of quantities in the simulation, such as the temperature of a flash block or
the mass flow of a stream. References to flowsheet quantities are made by
“accessing” these variables.
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For example, to study the effect of a column reflux ratio on the mole fraction of a
component in the distillate, two flowsheet quantities (variables) would need to be
accessed: the reflux ratio of the column and the mole fraction of the component in
the distillate. Several features in Aspen Plus require you to access variables,
such as design specifications, Fortran blocks, optimization problems, data-fit
problems, and sensitivity blocks.

Most accessed variables have a user-specified name associated. For example, you
could associate the name “PRES” with a variable that points to the pressure in a
Flash2 block. However, variables that are to be varied by a design-spec, a
sensitivity block, or optimization do not have a name associated.

There are two kinds of variables in a simulation:

Type of Variable Information

Those which you enter You can manipulate directly any variables that you enter.
These variables may be either read or written.

Those calculated by Aspen Plus These variables should not be overwritten or varied directly,
as this would lead to inconsistent results.
These variables should only be read.

Accessed variables can be either scalar or vector. An example of a scalar variable
is the pressure for a specific stage in a RadFrac block. The pressure profile for a
column is an example of a vector variable. For more information, see Types of
Accessed Flowsheet Variables, this chapter.

It is important to make sure the correct variable is accessed. Look at the prompt
at the bottom of the form when you select a variable from a drop-down list.

For example, when you select the block variable for a Flash2 or a Heater called
PDROP, the prompt tells you that this is the pressure drop for the heating or
cooling curve (not the pressure drop for the block). When you select the variable
PRES, the prompt tells you that this variable is the pressure specification for the
block; the value will be negative if pressure drop was input.

Types of Accessed Flowsheet Variables
Values for accessed scalar variables are in the units specified in the Units field
(on the Data Browser toolbar). For example, you might define a variable as a
stream temperature on the Design Spec Define sheet. If the Units field for the
sheet says ENG, the accessed temperature value is in degrees Fahrenheit. Vector
variables are in SI units, regardless of the Units specified.

There is only one set of units for an object. All accessed variables (both defined
and varied) for an object are in the same set of units.
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You can access flowsheet variables for these variable types:

• Block variables
• Stream variables
• Other variables
• Property parameters

Block Variables

Variable type Description

Block-Var Unit operation block variable

Block-Vec Unit operation block vector

Stream Variables

Variable type Description

Stream-Var† Non-component-dependent stream variable

Stream-Vec Stream vector. See Accessing Stream and Substream Vectors

Substream-Vec Substream variable. See Accessing Stream and Substream Vectors

Mole-Flow Component mole flow in a stream

Mole-Frac†† Component mole fraction in a stream

Mass-Flow Component mass flow in a stream

Mass-Frac†† Component mass fraction in a stream

Stdvol-Flow Component standard liquid volume flow in a stream

Stdvol-Frac†† Component standard liquid volume fraction in a stream

Heat-Duty Heat stream duty

Work-Power Work stream power

Stream-Prop†† Stream property defined by a property set

Compattr-Var Component attribute element

Compattr-Vec Component attribute vector

PSD-VAR Substream Particle Size Distribution (PSD) element

PSD-Vec Substream Particle Size Distribution (PSD)  vector

†
These stream variables can be accessed only as results.You cannot change or set them.:
MOLE-ENTHALPY, MASS-ENTHALPY, MOLE-ENTROPY,  MASS-ENTROPY,
MOLE-DENSITY, MASS-DENSITY, LFRAC

††
Variables of this type can be accessed only as results. You cannot change or set them.
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Other Variables

Variable type Description

Balance-Var Balance block variable

Chem-Var Chemistry variable

Presr-Var Pressure relief variable

React-Var Reactions variable

Parameter User-defined parameter. See Using Parameter Variables

Property Parameters

Accessed property parameters are always in SI units.

Variable type Description

Unary-Param Scalar unary property parameter

Unary-Cor-El Temperature-dependent unary property parameter coefficient element

Un-Cpr-Vec Temperature-dependent unary property parameter coefficient vector. For more information,
see Accessing Property Parameter Vectors

Bi-Param Scalar binary property parameter

Bi-Cor-El Temperature-dependent binary property parameter coefficient element

Bi-Cor-Vec Temperature-dependent binary property parameter coefficient vector.

NC-Param Nonconventional component parameter

Variable Definition Dialog Box
When completing a Define sheet, such as on a Fortran, Design specification or
Sensitivity form, specify the variables on the Variable Definition dialog box. The
Define sheet shows a concise summary of all the accessed variables, but you
cannot modify the variables on the Define sheet.

When on any Define Sheet:
1. To create a new variable, click the New button.

– or –

To edit an existing variable, select a variable and click the Edit button.
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2. Type the name of the variable in the Variable Name field.

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

Example for Calculating Make-up Flow Rate

The mass flow rate of a make-up stream (MAKEUP) is determined by the
difference between the mass flow rate of the recycle stream (RECYCLE) and 120
lb/hr, using a Fortran block. Aspen Plus writes the make-up flow rate to the
Control Panel.

On the Fortran Define sheet, Fortran variables FMAKE and FRECYC are
defined for the two stream mass flow rates. The Variable Definition dialog box is
used to define the variables.
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On the Fortran Fortran sheet, these Fortran statements are included:

F     FMAKE=120.0-FRECYC
C     If no makeup is required, set
C     the makeup to a small value
C     to avoid losing the makeup
C     stream composition
      IF(FMAKE.LE.0.0) FMAKE=0.0001
      WRITE(NTERM,10) FMAKE
  10  FORMAT(1X,'MAKEUP FLOW RATE=', F10.2)
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Choosing Input or Results Variables

It is sometimes important to distinguish between input and results when
accessing:

• Block variables
• Pressure relief variables

For example, suppose you are sampling the calculated duty of a Heater block that
has temperature and vapor fraction specified. You must access the results
variable QCALC, not the input variable DUTY. DUTY will not have a value.

To determine whether a variable is an input or results variable:
1. In the Variable Definition dialog box where you are accessing the variable,

click the arrow in the Variable field, and select the variable from the list.

2. Check the prompt. If the prompt begins with Calculated, the variable is a
results variable. Otherwise it is an input variable.

Guidelines for Choosing Input or Results Variables
Follow these guidelines for choosing input or results variables:

• Choose input variables when setting or manipulating input specifications.
• Choose results variables for use in design specification expressions,

optimization objective functions, constraint expressions, and sensitivity
tabulations.

• See Chapter 19 for special considerations when accessing variables in a
Data-Fit block.

• If a result is available in an outlet stream of a block, access the stream
variable. For example, to access the temperature calculated by a Heater
block, access the temperature of the outlet stream.

• If a result is not available in an outlet stream of a block, choose a block
variable with a prompt that begins with Calculated. For example, the prompt
for the variable QCALC (the duty calculated by a Heater block) is Calculated
heat duty.

• MASS-FRAC, MOLE-FRAC and STDVOL-FRAC are results variables and
cannot be changed.
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Using Parameter Variables

A parameter variable is a user-defined global variable you can use for temporary
storage of quantities not defined in Aspen Plus. For example, the temperature
difference between two blocks can be a parameter variable. You identify parameter
variables by variable number. There can be any number of parameter variables in
a simulation.

Example of Using a Parameter Variable for Temperature Difference

A design specification manipulates a user-defined variable (Parameter 1), which
represents the temperature difference between two heaters. A Fortran block
retrieves the parameter (DELT) and the temperature of the first heater (T1), and
uses these variables to set the temperature of the second heater (T2). The
Variable Definition dialog box is used to define the variables on the Fortran
Define sheet.

On the Design Spec form:
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On the Fortran form:
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Accessing Vectors

You can use the vector variable types to access an entire block profile, stream or
substream at once. Aspen Plus interprets the Fortran variable you assign to the
vector as an array variable. You do not need to dimension it.

Vector Variables

Variable type  Description

Block-Vec Unit operation block vector (see Accessing Block Vectors, this chapter)

Stream-Vec Stream vector (see Accessing Stream and Substream Vectors, this
chapter)

Substream-Vec Substream variable (see Accessing Stream and Substream Vectors,
this chapter)

Compattr-Vec Component attribute vector (see Component Attributes and PSD, this
chapter)

PSD-Vec Substream Particle Size Distribution (PSD) vector (see Component
Attributes and PSD, this chapter)

Un-Cor-Vec Temperature-dependent unary property parameter vector (see
Accessing Property Parameter Vectors, this chapter)

Bi-Cor-Vec Temperature-dependent binary property parameter vector (see
Accessing Property Parameter Vectors, this chapter)
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Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assign to the vector. The value of this variable
is the length of the vector. You can use the variable in Fortran statements, but
you cannot change its value.

Accessing Stream and Substream Vectors
You can use the Stream-Vec and Substrm-Vec variable types to access an entire
stream or substream at once. Aspen Plus interprets the Fortran variable you
assign to the stream as an array variable. You do not need to dimension it.

A stream vector contains all the substream vectors for that stream class. The
order of the substreams is defined on the Define Stream Class dialog box (click
the Define Stream Class button on the Setup StreamClass Flowsheet sheet).

The variables in a stream or substream vector are always in SI units.

Substream MIXED and Stream Class CONVEN
This is the layout of the substream vector for substream MIXED and for
Stream-Vec, when accessing the default stream class CONVEN:

Array Index Description

1, . . . , NCC Component mole flows (kg-moles/sec)

NCC + 1 Total mole flow (kg-moles/sec)

NCC + 2 Temperature (K)

NCC + 3 Pressure (N/m2)

NCC + 4 Mass enthalpy (J/kg)

NCC + 5 Molar vapor fraction

NCC + 6 Molar liquid fraction

NCC + 7 Mass entropy (J/kg-K)

NCC + 8 Mass density (kg/m3)

NCC + 9 Molecular weight (kg/kg-mole)
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NCC is the number of conventional components specified on the Components
Specifications Selection sheet. The order of the component mole flows is the same
as the order of components on that sheet. All values are in SI units, regardless of
the Units specification on the Define sheet.

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name, which you assign to the substream or stream vector. The
value of this variable is the length of the vector (NCC + 9). You can use the
variable in Fortran statements, but you cannot change its value.

Example for Accessing a Stream Vector

A Fortran block is used to write the mole fractions of stream HX1-OUT to the
terminal. On the Define sheet of the Fortran block, Fortran variable SOUT, of
the type Stram-Vec, is defined.
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On the Fortran Fortran sheet, these Fortran statements are included:

    NCOMP=LSOUT-9
    WRITE(NTERM,30)
    DO 10 I=1, NCOMP
    X(I)=SOUT(I)/SOUT(NCOMP+1)
    WRITE(NTERM, 20) I, X(I)
10  CONTINUE
20  FORMAT (10X, I3, 2X, F10.4)

30  FORMAT (‘STREAM HX1-OUT MOLE FRACTIONS’)

On the Fortran Declarations sheet, the following statement allows for up to 20
components:

    DIMENSION X(29)

Substream CISOLID
The layout of a substream vector for a CISOLID substream is the same as for a
MIXED substream, with one exception. If the CISOLID substream has a PSD, an
array of values for the PSD is appended to the vector. NCC is the number of
conventional components. Space for all conventional components is reserved in
both the MIXED and CISOLID substreams. The component order is the same as
on the Components Specifications Selection sheet. All values are in SI units,
regardless of the Units specification.
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In the following table, n represents the number of intervals in the particle size
distribution. For CISOLID substreams, vapor and liquid fractions have the value
0.0. This is the layout of a substream vector for a CISOLID substream:

Array Index Description

1, . . . , NCC Conventional component mole flows (kg-moles/sec)

NCC + 1 Total mole flow (kg-moles/sec)

NCC + 2 Temperature (K)

NCC + 3 Pressure (N/m2)

NCC + 4 Mass enthalpy (J/kg)

NCC + 5 Molar vapor fraction  (0.0)

NCC + 6 Molar liquid fraction (0.0)

NCC + 7 Mass entropy (J/kg-K)

NCC + 8 Mass density (kg/m3)

NCC + 9 Molecular weight (kg/kg-mole)

NCC + 10
     .   .
     .   .
     .   .
NCC + 9 + n

frac

     .    

     .    

     .    

 frac

PSD  values (if a PSD attribute is defined for the substream)

n














Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assigned to the substream or stream vector.
The value of this variable is the length of the vector (NCC + 9 + n). You can use
the variable in Fortran statements, but you cannot change its value.

Substream NC
A substream vector for an NC substream contains:

• Component flows
• Stream conditions
• Component attributes
• An array of values for the PSD (if the substream has a PSD)

NNCC is the number of nonconventional components.
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The component order for Is the same as on

Component flows Components Specifications Selection sheet

Component attributes Properties Advanced NC-Props Property Methods sheet  

Attributes for each component appear in the order specified on the Properties
Advanced NC-Props Property Methods sheet for that component. All values are
in SI units, regardless of the units specification.

This is the layout of a substream vector for an NC substream:

Array Index Description

1, . . . , NNCC Component mass flows (kg/sec)

NNCC + 1 Total mass flow (kg/sec)

NNCC + 2 Temperature (K)

NNCC + 3 Pressure (N/m2)

NNCC + 4 Mass enthalpy (J/kg)

NNCC + 5 Vapor fraction (0.0)

NNCC + 6 Liquid fraction (0.0)

NNCC + 7 Mass entropy (J/kg-K)

NNCC + 8 Mass density (kg/m3)

NNCC + 9 1.0

NINCC + 10
     .   .
     .   .
     .   .

value

     .    

     .    

     .    

value

Values for component attribute 1 of component 1 

1

k














value

     .   

     .   

     .   

value

Values for component attribute 2 of component 1 

1

l














value

     .   

     .   

     .   

value

Values for component attribute 1 of component 2 

1

m














frac

     .    

     .    

     .    

frac

PSD values (if a PSD attribute is defined for the substream) 

1

n













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Component Attributes and PSD
You can use the Compattr-Vec and PSD-Vec variable types to access component
attribute vectors and PSD vectors of streams. The layout of the vector is the list
of elements for the attribute. See Substream CISOLID and Substream NC for the
layout for substream PSD, in this chapter. See Chapter 6 for a description of the
elements for each component attribute. You can also obtain information for the
attribute from the Components Attr-Comps Selection sheet and Properties
Advanced NC-Props Property Methods sheet.

Accessing Block Vectors

You can use the Block-Vec variable type to access column profiles for the following
multi-stage separation models:

In this model Variables depend on

RadFrac Stage and composition

MultiFrac Stage, section, and composition

Extract Stage

PetroFrac Stage, composition, and stripper number

RateFracTM Segment, composition, and accumulator number

BatchFracTM Stage, composition, and operation step

SCFrac Section and composition

You can also use Block-Vec to access the following block result profiles:

• MHeatX zone analysis
• RBatch time profiles
• RPlug length profiles

Aspen Plus automatically:

• Interprets the Fortran variable you assign to the profile as an array variable
• Dimensions the variable

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assigned to the block vector. The value of this
variable is the length of the array. You can use the variable in FORTRAN
statements, but you cannot change its value.
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The order of values in the Fortran array depends on which variable you select.
Subsequent sections of this chapter describe the order for variables. All values
are in SI units, regardless of the Units specifications on the Define sheet.

Variables Dependent on Stage Number or Segment
Number

The layout for vector variables is dependent on stage, section or segment number
follows.

Array Index Value for

1 Stage or segment 1

2 Stage or segment 2

.

.

N Last stage or segment

N denotes the number of stages or segments in the column.

Examples of variables dependent on stage number are temperature and flow
profiles in RadFrac, MultiFrac Extract, PetroFrac, or BatchFrac. Examples of
vector variables dependent on segment number are temperature and flow profiles
for RateFrac.

Example for Accessing a Temperature Profile

The temperature profile of a RadFrac block is written to the Control Panel, using
a Fortran block.

On the Define sheet of the Fortran block, Fortran variable TPROF of the type
Block-Vec is defined using the Variable Definition dialog box.
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On the Fortran Fortran sheet, these Fortran statements are included:

   WRITE(NTERM,20)
C* LTPROF IS AUTOMATICALLY GENERATED BY Aspen Plus *
      DO 10 I = 1, LTPROF
      WRITE(NTERM,30) I, TPROF(I)
   10 CONTINUE
   20 FORMAT ('  *** TEMPERATURE PROFILE ***')
   30 FORMAT (10X, I3, 2X, F10.2)
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Variables Dependent on Section Number
Examples of vector variables dependent on section number are fractionation
index and duty results for SCfrac, and the sizing/rating results for trays and
packings. The layout, where Nsec denotes the number of sections in the column,
is:

Array Index Value for

1 Section 1

2 Section 2

.

.

Nsec Last section

Variables Dependent on Operation Step Number
Examples of vector variables dependent on operation step number are distillate
and reflux ratio results for BatchFrac. The layout, where Nopstep denotes the
number of operation steps, is:

Array Index Value for

1 Operation step 1

2 Operation step 2

.

.

Nopstep Last operation step

Variables Dependent on Component Number
Examples of vector variables dependent on component number are RadFrac
thermosyphon reboiler compositions. The layout follows, where NCC denotes the
number of components entered on the Components Specifications Selection sheet.
The component order is the same as on that sheet.
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Array Index Value for

1 Component 1

2 Component 2

.

.

.

NCC Last component

Variables Dependent on Component Number and Stage
or Segment Number

Examples of vector variables dependent on component number and stage number
are liquid and vapor composition profiles in RadFrac, MultiFrac, Extract,
PetroFrac, or BatchFrac. Examples of vector variables dependent on component
number and segment number are liquid and vapor composition profiles for
RateFrac. The values are stored as one-dimensional arrays. All component values
for stage or segment 1 are at the beginning, followed by all of the component
values for stage or segment 2, and so on. The number of components and the
component order are the same as on the Components Specifications Selection
sheet.

For a column with three components and five stages, the liquid composition
profile is stored as follows:

Array Index Value for

1 Component 1, stage or segment 1

2 Component 2, stage or segment 1

3 Component 3, stage or segment 1

4 Component 1, stage or segment 2

.

.

.

15 Component 3, stage or segment 5
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Example for Accessing a Mole Fraction Profile

The entire liquid mole fraction profile of a RadFrac column with three
components is accessed. The value for the second component on the fifth stage is
written to the Control Panel, using a Fortran block.

On the Define sheet of the Fortran block, Fortran variable XPROF of the type
Block-Vec is defined using the Variable Definition dialog box.
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On the Fortran Fortran sheet, include these Fortran statements:

   WRITE(NTERM,10)
C* TOTAL NUMBER OF COMPONENTS IS 3 *
      NCOMP = 3
C* COMPONENT TO BE ACCESSED IS 2 *
      ICOMP = 2
C* STAGE TO BE ACCESSED IS 5 *
      ISTAGE = 5
C* CALCULATE INDEX INTO XPROF *
      II = NCOMP*(ISTAGE-1) + ICOMP
      WRITE(NTERM,20) XPROF(II)
   10 FORMAT(' * MOLE FRACTION OF 2ND COMPONENT ON 5TH STAGE
*')
   20 FORMAT(10X,F10.2)

Variables Dependent on Stage Number and Section
Number

Examples of vector variables dependent on stage number and section number are
the profile results of tray rating calculations. The values are stored as 
one-dimensional arrays. All stage values for section 1 are at the beginning,
followed by all stage values for section 2, and so on. The number of components
and the component order are the same as on the Components Specifications
Selection sheet.

For a column with five stages and three sections, the flooding approach profile is
stored as follows:

Array Index Value for

1 Stage 1, section 1

2 Stage 2, section 1

3 Stage 3, section 1

4 Stage 4, section 1

5 Stage 5, section 1

6 Stage 1, section 2

.

.

.

15 Stage 5, section 3
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Variables Dependent on Stage Number and Operation
Step Number

Examples of vector variables dependent on stage number and operation step
number are temperature and flow profiles for BatchFrac. The values are stored
as one-dimensional arrays. All stage values for operation step 1 are at the
beginning, followed by all stage values for operation step 2, and so on.

For a BatchFrac block with four stages and three operation steps, the
temperature profile is stored as follows:

Array Index Value for

1 Stage 1, operation step 1

2 Stage 2, operation step 1

3 Stage 3, operation step 1

4 Stage 4, operation step 1

5 Stage 1, operation step 2

.

.

.

12 Stage 4, operation step 3

Variables Dependent on Component Number, Stage
Number, and Stripper Number

Examples of vector variables dependent on component number, stage number,
and stripper number are the stripper composition profiles for PetroFrac. The
values are stored as one-dimensional arrays. All component values for stage 1 of
stripper 1 are at the beginning, followed by all component values for stage 2 of
stripper 1, and so on. When Nstot is reached for stripper 1, the component and
stage values for stripper 2 begin, and so on. Nstot denotes the total number of
stages for that stripper.
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For a PetroFrac block with three components, six stripper stages, and three
strippers, the liquid composition profile is stored as follows:

Array Index Value For

1 Component 1, stage 1, stripper 1

2 Component 2, stage 1, stripper 1

3 Component 3, stage 1, stripper 1

4 Component 1, stage 2, stripper 1

.

.

18 Component 3, Nstot, stripper 1

19 Component 1, stage 1, stripper 2

.

.

54 Component 3, Nstot, stripper 3

Variables Dependent on Component Number, Stage
Number, and Operation Step Number

Examples of vector variables dependent on component number, stage number,
and operation step number (opstep) are the composition profiles for BatchFrac.
The values are stored as one-dimensional arrays. All component values for stage
1 of opstep 1 are at the beginning, followed by all component values for stage 2 of
opstep 1, and so on. When Nstage is reached for opstep 1, the component and
stage values for opstep 2 begin, and so on. Nstage denotes the number of stages
in the column.

For a BatchFrac block with two components, three stages, and four opsteps, the
liquid composition profile is stored as follows:

Array Index Value for

1 Component 1, stage 1, opstep 1

2 Component 2, stage 1, opstep 1

3 Component 1, stage 2, opstep 1

.

Continued
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Array index Value for

.

6 Component 2, Nstage , opstep 1

7 Component 1, stage 1, opstep 2

.

.

24 Component 2, Nstage, opstep 3

Variables Dependent on Component Number,
Accumulator Number, and Operation Step Number

The accumulator composition profile in BatchFrac is the only vector variable
dependent on component number, accumulator number, and operation step
number (opstep). The values are stored as a one-dimensional array. All
component values for accumulator 1 of opstep 1 are at the beginning, followed by
all the component values for accumulator 2 of opstep 1, and so on. Naccum
denotes the total number of accumulators in the column. When Naccum is
reached for opstep 1, the component and accumulator values for opstep 2 begin,
and so on.

For a BatchFrac block with two components, three accumulators, and four
opsteps, the accumulator composition profile is stored as follows:

Array Index Value for

1 Component 1, accumulator 1, opstep 1

2 Component 2, accumulator 1, opstep 1

3 Component 1, accumulator 2, opstep 1

.

.

6 Component 2, Naccum, opstep 1

7 Component 1, accumulator 1, opstep 2

.

.

24 Component 2, Naccum, opstep 4
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MHeatX Profiles
You can use the Block-Vec variable type to access the temperature difference
between the hot side and cold side of an MHeatX block:

Variable Description

DT Temperature approach profile,
including points added for phase change points
and points for streams entering and leaving the exchanger.

DTBASE Temperature approach profile for base points only. 
The length of the vector is the Number of Zones + 1. 
The Number of Zones is specified on the MHeatX Input ZoneAnalysis sheet.

Reactor Profiles
You can use the Block-Vec variable type to access RBatch time profiles and
RPlug length profiles for variables such as calculated temperature and pressure.
Values are stored at each output point. The length of the vector is the number of
output points +1.

For example, the temperature profile for an RBatch reactor that runs for 10
hours with output points each hour would be stored as follows:

Array Index Temperature at

1 Initial conditions

2 1 hour

3 2 hours

.

.

.

11 10 hours

The output intervals are determined as follows:

Model Output Interval

Rplug Number of Profile Points along the reactor length, specified on the RPlug Report Profiles sheet

Rbatch Time Interval Between Profile Points, specified on the RBatch Setup Operation Times sheet.
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Accessing Property Parameter Vectors
You can access the vector of coefficients of temperature-dependent property
parameters.

Variable type Description

Un-Cor-Vec Temperature-dependent pure component property parameter vector

Bi-Cor-Vec Temperature-dependent binary property parameter vector

Aspen Plus automatically:

• Interprets the Fortran variable you assign to the profile as an array variable
• Dimensions the variable

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name you assigned to the vector. The value of this variable is
the length of the vector.

Accessed property parameter vectors are always in SI units.

See Aspen Plus Physical Property Methods and Models, Chapter 3, for the length
and contents of each temperature-dependent property parameter. You can also
obtain this information by using Help from the Properties Parameters
PureComponent and Properties Parameters Binary sheets.

Example for Accessing Property Parameters

On the following Define sheet all references are to dataset 1.

This variable Accesses the

TC Critical temperature of component TOLUENE

HVAP Heat of vaporization of component TOLUENE. Heat of vaporization is the first element of the
temperature-dependent Watson parameter DHVLWT.

ANTOIN Antoine vapor pressure coefficients parameter PLXANT as a vector.

REN12 NRTL parameter vector for the TOLUENE-PHENOL binary

REN21 NRTL parameter vector for the PHENOL-TOLUENE binary
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19 Fortran Blocks and
In-Line Fortran

Aspen Plus lets you insert your own Fortran statements into flowsheet
computations. This chapter describes:
• Using Fortran in Aspen Plus
• Fortran Blocks
• Creating a Fortran block
• Entering Fortran statements
• Specifying when to execute a Fortran block
• Rules for writing Fortran statements

Using Fortran in Aspen Plus

You can use Fortran in Aspen Plus to perform any task that can be written as valid
Fortran expressions.

You can input Fortran expressions in a number of ways in Aspen Plus:
• In Fortran blocks
• On the Fortran sheets of other blocks, such as design specifications,

sensitivity or optimization problems
• In external Fortran subroutines

Fortran blocks:
• Contain Fortran expressions used to perform user-defined tasks
• Can read and/or write flowsheet variables
• Are executed at a specific point in the simulation

Aspen Plus checks your Fortran code interactively as you enter it so most syntax
errors are detected before a run. If the status indicator on a Fortran sheet  is ,
use Next to find out what is incomplete.
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You can write external User Fortran subroutines when the models provided by
Aspen Plus do not meet your needs. After you compile these subroutines, they are
dynamically linked when the simulation is run. Aspen Plus allows extensive
customization of the models through the use of these external user subroutines. 
For more information on external user subroutines, see Aspen Plus User Models.

Aspen Plus can interpret most in-line Fortran. Fortran that cannot be
interpreted is compiled and dynamically linked to the Aspen Plus module.
Because dynamic linking is used, the overhead for in-line Fortran requiring
compilation is small.

Note  If the Fortran cannot be interpreted, a FORTRAN compiler is needed. For
the recommended compiler for a given platform, see the relevant Aspen Plus
installation guide.

About Fortran Blocks

Fortran blocks let you insert Fortran statements into flowsheet computations to
perform user-defined tasks, such as:
• Calculating and setting input variables before they are used (feedforward

control)
• Writing information to the Control Panel
• Reading input from a file
• Writing results to the Aspen Plus report or to any external file
• Calling external subroutines
• Writing your own user models

Since Aspen Plus is a sequential modular simulator that executes one unit
operation at a time, you must specify where in the sequence of unit operations
each Fortran block is to be executed. You can do this by specifying one of these:
• Which flowsheet variables are read from and written to in the Fortran block
• The position of the Fortran block in the list of unit operation blocks

This lets Aspen Plus determine when the Fortran block should be executed. It is
recommended that you allow Aspen Plus to determine the execution sequence of
a Fortran block.

Define a Fortran block by:
1. Creating the Fortran block.

2. Identifying the flowsheet variables that the block samples or manipulates.

3. Entering the Fortran statements.

4. Specifying when the Fortran block is executed.
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Creating a Fortran Block
To create a Fortran block:
1. From the Data menu, point to Flowsheeting Options, then Fortran.

2. In the Fortran Object Manager, click New.

3. In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

The following sections describe how to complete the required sheets.

Identifying Flowsheet Variables
You must identify the flowsheet variables used in a Fortran block and assign
them variable names. A variable name identifies a flowsheet variable on other
Fortran block sheets.

Using the Define Sheet to Identify Flowsheet Variables

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:
1. To create a new variable, click the New button.

– or –

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field.

A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.
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For more information on accessing variables, see Chapter 18.

Tips   Use the Delete button to quickly delete a variable and all of the fields
used to define it. Use the Edit button to modify the definition of a variable in
the Variable Definition dialog box.

Entering Fortran Statements and Declarations
You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet

Enter Fortran declarations in the same way as executable Fortran statements,
using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declarations in a Fortran block, such as:
• Include statements
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a Fortran block to another.

Fortran variables that you defined on the Define sheet should not be declared on
the Declarations sheet.

Using the Fortran Sheet

To enter executable Fortran statements on the Fortran sheet:
1. Click the Fortran tab on the Fortran form.

To review rules and restrictions for in-line Fortran, see Rules for In-Line
Fortran Statements, this chapter.

2. Enter your Fortran statements.

3. To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. 

The Defined Variable List window appears.  You can drag and drop the
variables from the Defined Variable List to the Fortran sheet.
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Specifying When Fortran Statements Are Executed
You must specify when a Fortran block will be executed during calculations. To
do this:
1. On the Fortran form, click the Sequence sheet.

2. In the Read Variables field, specify which variables are used but not changed.
In the Write Variables field, specify which variables are changed.

– or –

In the Execute field on the Sequence sheet, specify when to execute the block.

Option When Executed

First At the beginning of a simulation

Before Before a block. Specify the block type and name.

After After a block. Specify the block type and name.

Last At the end of a simulation

Report While the report is being generated

Based on order in sequence As specified on the Convergence Sequence Specification sheet

Use Read/Write Variables Aspen Plus uses read and write variables to automatically sequence the Fortran block.

Read Variables and Write Variables are used to establish which of the variables
appearing on the Define sheet are only sampled variables, and which are
changed by the Fortran block.

Read Variables establish information flow from the block or stream containing a
sampled (read-only) variable to the Fortran block.

Write Variables establish information flow from the Fortran block to changed
(read-write or write-only) variables.

If the automatic sequencing logic using Read Variables and Write Variables does
not appear to work properly, use the Execute statement to specify explicitly when
the block is executed.

Converging Loops Introduced by Fortran
Blocks

A Fortran block can introduce loops that must be solved iteratively.
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For example, a Fortran block can change an upstream variable based on the
value of a downstream variable. This could occur if the Fortran block was being
used to set a makeup stream based on the product flowrates.

If you are using Fortran blocks that create loops, you must specify Read
Variables and Write Variables for Aspen Plus to detect the loops and produce
correct simulation results.

Aspen Plus automatically solves any loops introduced by the Fortran block, if
you:
• Check the Tear Fortran Write Variables on the Convergence Conv-Options

Defaults Sequencing sheet
• Specify Read Variables and Write Variables on the Fortran block Sequence

sheet.

When a Fortran block creates a loop, variables entered as Write Variables can be
torn for convergence in the same way as recycle streams. Aspen Plus can do this
automatically, or you can specify tear variables.

To specify a Fortran Write Variable as a tear variable:
1. On the Fortran form, click the Tears tab.

2. In the Tear Variable Name field, select a variable you entered in the Write
Variable field on the Sequence sheet.

3. Enter lower and upper bounds for the tear variable in the Lower Bound and
Upper Bound fields.

The tear variable will be solved along with recycle tears to converge the
flowsheet. See Chapter 17, Convergence, for more information on flowsheet
convergence.
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Example of Calculating Make-Up Flow Rate

The mass flow rate of make-up stream MAKEUP is determined by the amount of
benzene in the outlet streams from the flowsheet. The variables are selected
using the Variable Definition dialog box. In order for the simulation to converge
correctly, the Tear Fortran Write Variables needs to be selected on the
Convergence Conv-Options Defaults Sequencing sheet.
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On the Convergence Conv-Options Defaults Sequencing sheet, Tear Fortran
Write Variables is selected:
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Example of Feedforward Control of Stream Feedrate

A Fortran block is used to set the feedrate of stream HX2 to equal 75% of the
stream HX1.
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Rules for In-Line Fortran Statements

To achieve successful compilation of your Fortran statements, follow these rules:
• By default, variables beginning with A through H, or O through Z, are double

precision real. Variables beginning with I through N are integer. Use double
precision functions (for example, DSQRT) and double precision constants (for
example, 1D0).
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• Do not use variable names beginning with IZ or ZZ.
• Because Fortran is column-sensitive, this table shows how to do certain

things:
To do this Use

Indicate comments Column one for C and leave column two blank

Enter statement labels Only columns three, four, and five

Begin executable statements Column seven or beyond

• You can call your own subroutines or functions.  You can use labeled or blank
(unlabeled) COMMON blocks.

• Fortran variables you define on the Specification sheet cannot be placed in a
COMMON.

• Do not use IMPLICIT, SUBROUTINE, ENTRY, RETURN, END statements,
nor arithmetic statement functions.

Disabling Syntax Checking
By default, Aspen Plus interactively checks your Fortran statements. You can
turn off interactive syntax checking. You might need to do this, for example, if
you are using a compiler that accepts nonstandard Fortran extensions, or if the
syntax checker incorrectly flags correct Fortran as incomplete.

To turn off Fortran syntax checking:
1. From the Tools menu, click Options.

2. Ensure the Check Inline Fortran for Syntax Errors checkbox is clear.
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Writing to the Screen and Aspen Plus
Files

In Fortran WRITE statements, you can use the following predefined variables for
the unit number:

Unit Destination

NTERM Control Panel (if running from the user interface)

Terminal (if running interactively outside of the user interface), or

Log file (if running batch)

NRPT Aspen Plus report

NHSTRY Simulation history

Examples:

For writing to the Control Panel, enter:

WRITE(NTERM, *) A,B, C, X

For writing to the report file, enter:

WRITE(NRPT, *) A, B, C, X

If writing to the Aspen Plus report from a Fortran block, select Report in the
Execute field on the Sequence Sheet. Output written to the report file will appear
in the Flowsheet section of the Fortran block report.

When writing to a user-defined file, use a Fortran unit number between 50 and 100.
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Interactive Read Statements

In Fortran READ statements you can use the predefined variable NTERM for the
unit number for interactive input.

This table shows what the predefined variable does:

If you are running interactively Then READ (NTERM 
†
)

From the user interface Displays a dialog box accepting up to one line of input

Outside the user interface Pauses for input from the terminal

† Do not read from NTERM when running batch.

Example of Interactive READ from a Fortran block

A Fortran block pauses for user input of the temperature for block HX1 before
executing the block.

The following form defines the variable HX1TEM as the temperature input
specification for block HX1:
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The Fortran statements read HX1TEM from interactive screen input, and echo
the value to the control panel:

The Sequence sheet specifies that HX1TEM is a write variable, so that
Aspen Plus can sequence the Fortran block.
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Retaining Variables Between Iterations
and Blocks

Place a Fortran variable in a COMMON (on the Declarations sheet) if you want
to do one of the following:
• Retain the value of the variable from one calculation pass to another
• Use the same variable in more than one block

The COMMON statement must appear in each block where the variable is used.

About the Interpreter

By default, Aspen Plus will interpret in-line Fortran if it is possible. Fortran that
cannot be interpreted is compiled and linked into a shared library or dynamic link
library (DLL). A Fortran compiler is needed for compiling the code. (See the
appropriate installation guide for the recommended compiler for a given platform.)  It is
possible to compile all of the Fortran, by selecting Write Inline Fortran to a
Subroutine to be Compiled and Dynamically Linked on the Setup
SimulationOptions System sheet.
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The following Fortran can be interpreted:
• Arithmetic expressions and assignment statements
• IF statements
• GOTO statements, except assigned GOTO
• WRITE statements that use the built-in unit number variables NTERM,

NRPT, or NHSTRY
• FORMAT statements
• CONTINUE statements
• DO loops
• Calls to these built-in Fortran functions:

DABS DERF DMIN1 IDINT

DACOS DEXP DMOD MAX0

DASIN DFLOAT DSIN MIN0

DATAN DGAMMA DSINH MOD

DATAN2 DLGAMA DSQRT

DCOS DLOG DTAN

DCOSH DLOG10 DTANH

DCOTAN DMAX1 IABS

You can also use the equivalent single precision or generic function names. But,
Aspen Plus always performs double precision calculations.

If you use the following statements, you must enter them on the Declaration
sheet:
• REAL or INTEGER statements
• DOUBLE PRECISION statements
• DIMENSION statements
• COMMON statements
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The following statements require compilation:

CALL LOGICAL

CHARACTER PARAMETER

COMPLEX PRINT

DATA RETURN

ENTRY READ

EQUIVALENCE STOP

IMPLICIT SUBROUTINE

About External Fortran Subroutines

External user Fortran is an open and extensive customization capability in
Aspen Plus. An Aspen Plus user model consists of one or more Fortran subroutines
that you write yourself when the models provided by Aspen Plus do not meet your
needs. A proper argument list is needed in the subroutine to interface your user
model to Aspen Plus.

You can write six kinds of user models for use in Aspen Plus:

External Fortran Application Types Use

User Unit Operation Models Units not represented by Aspen Plus unit operation models

Kinetic Models Reactors, Reactive Distillation, Pressure Relief

Physical Property Models Pure and mixture, activity models, KLL, user equations-of-state

Stream Properties Special properties to be calculated for a stream

Unit Operation Customization Reactor heat transfer, column hydraulics, LMTD correction, pressure drop,
liquid-liquid distribution coefficients

Customized Reports User-defined stream report, user block reports, applications based on the
Summary File Toolkit

Sizing and Costing User cost blocks
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Templates that include the argument list and other useful code for starting a
user model are provided in the Templates directories where Aspen Plus is
installed. For more information on how to write a user model, see Aspen Plus
User Models.

❖     ❖     ❖     ❖ 
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20 Sensitivity

This chapter explains how to use sensitivity analysis to examine the sensitivity of
a process to key variables including:
• What is sensitivity analysis?
• Defining a sensitivity block
• Specifying sampled and manipulated variables
• Defining tabulated variables
• Optional Fortran statements
• Examples

About Sensitivity Analysis
Sensitivity analysis is a tool for determining how a process reacts to varying key
operating and design variables.  You can use it to vary one or more flowsheet
variables and study the effect of that variation on other flowsheet variables. It is
a valuable tool for performing “what if” studies. The flowsheet variables that are
varied must be inputs to the flowsheet. They can not be variables that are
calculated during the simulation.

You can use sensitivity analysis to verify if the solution to a design specification
lies within the range of the manipulated variable. You can also use it to perform
simple process optimization.

You can use sensitivity blocks to generate tables and/or plots of simulation
results as functions of feed stream, block input, or other input variables.
Sensitivity analysis results are reported in a table on the Sensitivity Results
Summary sheet. The first n columns of the table list the values of the variables
that are varied, where n is the number of varied flowsheet variables entered on
the Sensitivity Input Vary sheet. The remaining columns in the table contain the
values of variables that you tabulated on the Tabulate sheet. The tabulated
results can be any flowsheet variable or any valid Fortran expression that may
depend on flowsheet variables that are either input or calculated.
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The results can be plotted using the Plot Wizard from the Plot menu to easily
visualize the relationships between different variables. See Chapter 13 for more
information about the Plot Wizard.

Sensitivity blocks provide additional information to base-case results, but have
no effect on the base-case simulation. The simulation runs independently of the
sensitivity study.

Sensitivity blocks with more than one varied variable generate a row in the
sensitivity table for each combination of values. If you are interested in the
sensitivity to more than one variable with each varied independently, use a
separate sensitivity block for each varied variable.

Sensitivity blocks create loops that must be evaluated once for each row of the
sensitivity table. Aspen Plus sequences sensitivity blocks automatically. Or, you
can sequence a sensitivity block using the Convergence Sequence Specifications
sheet.

Accessed scalar flowsheet variables are in the units set selected for the
sensitivity block. You cannot modify the units individually for different variables
in the sensitivity. You can either change the unit set for the sensitivity block (on
the toolbar of the Data Browser), or enter an expression on the tabulate sheet to
convert the variable.  Accessed vector variables are always in SI units.

Defining a Sensitivity Block
Define a sensitivity block by:
1. Creating the sensitivity block

2. Identifying the sampled flowsheet variables

3. Identifying the input variables to manipulate to generate the table

4. Defining what you want Aspen Plus to tabulate

5. Entering optional Fortran statements

Creating a Sensitivity Block
To create a sensitivity block:
1. From the Data menu, click Model Analysis Tools, then Sensitivity.

2. On the Sensitivity Object Manager, click Create.

3. In the Create New ID dialog box, enter an ID or accept the default, and click
OK. In the Create dialog box, enter an ID and click OK.
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Identifying the Sampled Flowsheet Variables
For each sensitivity block you must identify the flowsheet variables and assign
them variable names. You can either tabulate these variables or use them in
Fortran expressions to compute tabulated results. The variable name identifies
the flowsheet variable on other sensitivity sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:
1. To create a new variable, click the New button.

– or –

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. 

If you are editing an existing variable and want to change the variable name,
click the right mouse button on the Variable Name field.  On the popup menu,
click Rename.  A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

For more information on accessing variables, see Chapter 18.

Tips   Use the Delete button to quickly delete a variable and all of the fields
used to define it. Use the Edit button to modify the definition of a variable in
the Variable Definition dialog box.

For more information about accessing flowsheet variables, see Chapter 18. For
more information about using the Define sheet to identify flowsheet variables,
see Chapter 19.
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Identifying Manipulated Flowsheet Variables
Use the Vary sheet to identify the flowsheet variables to vary in generating a
table. You can only vary block input variables, process feed stream variables, and
other input variables. You must specify values, or a range of values, for the
varied variables.

You can manipulate integer variables, such as the feed location of a distillation
column. You can specify up to five manipulated variables.

To identify manipulated variables and specify values:
1. On the Sensitivity Input form, click the Vary sheet.

2. In the Variable Type field, select a variable type.

Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable.

3. Specify a list or range of values for the manipulated variable. You can enter
one of the following:

• List of values
• Lower limit, Upper limit, and number of equally spaced points (# Points)
• Lower limit, Upper limit, and increment between points (Incr)
You can enter either a constant or a Fortran expression.

4. You have the option of labeling the varied variables for the report and the
Results Summary sheet. Use the Line1 through Line4 fields to define these
labels.

5. To identify additional variables, select New from the list in the Variable
Number field. Repeat Steps 2 through 5.

Aspen Plus generates one row of the table for each combination of varied variable
values. The number of possible combinations can be large, resulting in excessive
computer time and storage requirements. For example, 10 points for each of the
maximum of five variables would result in 100,000 evaluations of the sensitivity
block loop.

Each manipulated variable must already have been entered as an input
specification, or it must have a default value.

Defining Tabulated Variables
Use the Tabulate sheet for defining the results you want Aspen Plus to tabulate,
and supplying column headings.

To define tabulated variables:
1. On the Sensitivity Input form, click the Tabulate sheet.
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2. In the Column Number field, enter a column number.

3. In the Tabulated Variable or Expression field, enter a variable name or
Fortran expression.

Aspen Plus tabulates the variable, or the result of the expression, for each
combination of manipulated variables.

To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

4. To enter optional labels, click the Table Format button. In the first four rows,
supply column labels for any or all of the columns of tabulated results.

5. Use the two Unit Labels rows to enter units labels for the tabulated results.

6. If the tabulated results expression is entered as a single variable name on the
Specification sheet, Aspen Plus generates unit labels automatically.

7. Click Close to close the Table Format dialog box.

8. Repeat Steps 2 through 6 until you define all the results you want to tabulate.
There is no limit.

Reinitializing Blocks and Streams
By default, Aspen Plus begins the calculations for a new row using the results of
the previous row. If blocks or recycle loops fail to converge for some rows, you can
specify that the calculations are to be reinitialized for each row.

Reinitializing Blocks

To reinitialize blocks:
1. On the Sensitivity Input form, select the Optional tab.

2. In the Blocks to be Reinitialized field, select either Include Specified Blocks or
Reinitialize All Blocks.

3. If you choose Include Specified Blocks, select the unit operation blocks and/or
the convergence blocks to be reinitialized.

Reinitializing Streams

To reinitialize streams:
1. On the Sensitivity Input form, select the Optional tab.
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2. On the Streams To Be Reinitialized field select either Include Specified
Streams or Reinitialize All Streams.

3. If you choose Include Specified Streams, select the streams to be reinitialized.

Entering Optional Fortran Statements

You have the option of entering Fortran statements to compute tabulated results
and the varied variable range. Any variable computed by a Fortran statement can
be used in expressions on the Tabulate and Vary sheets. Fortran statements are
needed only if functions are too complex to enter on these sheets.

You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet

Using the Sensitivity Input Fortran Sheet

To enter executable Fortran statements on the Fortran sheet:
1. On the Sensitivity Input form, click the Fortran sheet.

2. Review the rules and restrictions for in-line Fortran. For more information,
see Chapter 19.

3. Enter your Fortran statements.

To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

Fortran Declarations
Enter Fortran declarations in the same way as executable Fortran statements,
using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declaration in a Sensitivity block, including:
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)
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If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a sensitivity block to another.

Fortran variables that you defined on the Define sheet should not be declared on
the Declarations sheet.

Example for Tabulating Reaction Selectivity versus Reactor Temperature

Tabulate the effect of temperature in RGibbs block REACT on the selectivity of
component ESTER versus ETOH in the reactor outlet. Assume that an initial
specification for the temperature of block REACT has been entered on the
RGibbs Setup Specifications sheet.
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The selectivity which is the ratio of FESTER to FALC can be entered as a
Fortran expression FESTER/FALC on the Tabulate sheet.

❖     ❖     ❖     ❖ 
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21 Design Specifications:
Feedback Control

Use design specifications as feedback controllers in your simulation. This chapter
describes:
• What are design specifications?
• Creating design specifications
• Specifying targeted variables
• Specifying manipulated variables
• Optional Fortran statements

About Design Specifications
A design specification sets the value of a variable that Aspen Plus would
otherwise calculate. For example, you may want to specify a product stream
purity or the permissible amount of an impurity in a recycle stream. For each
design specification, you identify a block input variable, process feed stream
variable, or other simulation input to be manipulated (adjusted) to meet the
specification. For example, you might manipulate a purge rate to control the level
of impurities in a recycle stream. Design specifications can be used to simulate
the steady state effect of a feedback controller.

When you use a design specification, you specify a desired value for a flowsheet
variable or some function of flowsheet variables. The flowsheet variables used in
a design specification are called sampled variables. For each design specification,
you must also select a block input variable or process feed stream variable to be
adjusted to satisfy the design specification. This variable is called the
manipulated variable.
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The design specification achieves its objective by manipulating an input variable
specified by the user. Quantities that are calculated during the simulation should
not be varied directly. For example, the stream flow rate of a recycle stream
cannot be varied; however, the split fraction of an FSplit block where the recycle
stream is an outlet can be varied. A design specification can only manipulate the
value of one input variable.

Design specifications create loops that must be solved iteratively. By default
Aspen Plus generates and sequences a convergence block for each design
specification. You can override the default by entering your own convergence
specifications. For a complete discussion of design specification convergence, see
Chapter 17.

The value of the manipulated variable that is provided in the Stream or Block
input is used as the initial estimate. Providing a good estimate for the
manipulated variable will help the design specification converge in fewer
iterations. This is especially important for large flowsheets with several
interrelated design specifications.

The objective of the specification is that it equals the calculated value (Specified
Value - Calculated Value = 0). The specification can be any valid Fortran
expression involving one or more flowsheet quantities. Specifications must also
have a tolerance within which the objective function relation must be satisfied.
Therefore, the actual equation that must be satisfied is

| Specified Value - Calculated Value | < Tolerance

There are no results associated directly with a specification other than whether
the objective function equation was satisfied or not. The final value of the
manipulated an/or sampled variables can be viewed directly on the appropriate
Stream or Block results sheets. The summary and iteration history of the
Convergence block can be found by selecting the Results sheet of the appropriate
Convergence block.

Defining a Design Specification

There are five steps involved in defining a design specification:
1. Creating the design specification

2. Identifying the sampled flowsheet variables used in the specification.

3. Specifying the target value for a sampled variable or some function of
sampled variables and a tolerance.

4. Identifying a simulation input variable to be adjusted to achieve the target
value, and specifying the limits within which it can be adjusted.
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5. Entering optional Fortran statements.

Subsequent sections of this chapter describe each of these steps.

Creating a Design Specification
To create a design specification:
1. From the Data menu, point to Flowsheeting Options, then Design Specs.

In the Design Specification Object Manager, click New.

2. In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

The following sections describe how to complete the required sheets.

Identifying Sampled Flowsheet Variables
Use the Flowsheeting Options Design Spec Define sheet to identify the flowsheet
variables used in the design specification and assign them variable names. The
variable name identifies the flowsheet variable on other design specification
sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:
1. To create a new variable, click the New button.

or

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.
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4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip  Use the Delete button to quickly delete a variable and all of the fields used
to define it.

Tip  Use the Edit button to modify the definition of a variable in the Variable
Definition dialog box.

Entering the Design Specification
To enter the design specification:
1. On the Design Spec form, click the Spec sheet.

2. In the Spec field, enter the target variable or Fortran expression.

3. In the Target field, specify the target value as a constant or Fortran
expression.

4. In the Tolerance field, enter the specification tolerance as a constant or
Fortran expression.

The design specification is:

Spec expression = Target expression

The design specification is converged when:

– Tolerance < Spec expression – Target expression < Tolerance

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements. See Entering Optional
Fortran Statements, this chapter.

Tip  To ensure that you enter accurate variable names, click the right mouse
button on the Spec, Target, or Tolerance field. In the popup menu, click Variable
List. The Defined Variable List window appears. You can drag and drop the
variables from the Defined Variable List to the Spec sheet.
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Identifying the Manipulated Variable
Use the Vary sheet to identify the manipulated variable and specify its limits.
The limits for manipulated variables can be constants or functions of flowsheet
variables.

To identify the manipulated variable and specify limits:
1. On the Design Spec form, click the Vary sheet

2. In the Type field, select a variable type.

Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable.

3. In the Lower field, enter a constant or Fortran expression as the lower limit
for the manipulated variable.

4. In the Upper field, enter a constant or Fortran expression as the upper limit
for the manipulated variable.

You must have already entered the manipulated variable as an input
specification, or it must have a default value. The initial guess used for the
manipulated variable is this specification or the default. You cannot manipulate
integer block input variables, such as the feed location of a distillation column.

If the design specification cannot be met because the solution is outside the limit
range, Aspen Plus chooses the limit that most closely meets the specification.

Entering Optional Fortran Statements
You have the option of entering any Fortran statements needed to compute the
design specification terms or manipulated variable limits. Any variable that is
computed by the Fortran statements can be used in the expressions on the Spec
and Vary sheets. Fortran statements are needed only if the functions involved
are too complex to enter on the Spec and Vary sheets.

You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet

Enter Fortran declarations in the same way as executable Fortran statements,
using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declarations in a Fortran block, such as:
• Include statements
• COMMON definitions
• DIMENSION definitions
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• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a Fortran block to another.

Fortran variables that you defined on the Specification sheet should not be
declared on the Declarations sheet.

Using the Fortran Sheet
To enter executable Fortran statements on the Fortran sheet:
1. On the Design Spec form, click the Fortran sheet.

2. Use Help to review rules and restrictions for in-line Fortran.

3. Enter your Fortran statements.

To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

Troubleshooting Design Specifications
If the objective function was not satisfied, there are a number of options to
consider:
• Check to see that the manipulated variable is not at its lower or upper bound.
• Verify that a solution exists within the bounds specified for the manipulated

variable, perhaps by performing a sensitivity analysis.
• Check to ensure that the manipulated variable does indeed affect the value of

the sampled variable.
• Try providing a better starting estimate for the value of the manipulated

variable.
• Narrowing the bounds of the manipulated variable or loosening the tolerance

on the objective function might help convergence.
• Try changing the characteristics of the Convergence block associated with the

design specification (step size, number of iterations, etc.)
• Make sure that the objective function does not have a flat region within the

range of the manipulated variable.
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Example for Feedback Control of Reactor Selectivity

Manipulate the temperature of RGibbs block REACT to control the selectivity of
component ESTER versus ETOH at a value of 2.50 +/- 0.01. This example
assumes that temperature was specified for block REACT on the RGibbs Setup
Specification sheet. The RGibbs specification becomes the initial estimate for the
design specification.
• The molar flow rate of ESTER and of ETOH in stream PROD are the sample

variables. These variables are called FESTER and FALC, respectively.
• The design specification is FESTER/FALC = 2.50.
• The design specification is satisfied when |FESTER/FALC -2.50| < 0.01.
• Fortran expressions such as FESTER/FALC can be used in any part of the

specification expression: the spec, the target or the tolerance.
• The reactor temperature is the manipulated variable. The design specification

convergence block will find the reactor temperature that makes
FESTER/FALC=2.5.

• The temperature is specified in the reactor block just as if there were no
design specification. The specified value is the initial estimate used by the
design specification convergence block.

• The design specification convergence block will not try a temperature less
than 50F or greater than 150F, even if the solution to the objective function
lies outside this range. The limits become alternative specifications if the
design specification cannot be achieved. The initial estimate entered in the
reactor block lies within these limits.

• You do not have to specify convergence of the design specification. Aspen Plus
will automatically generate a convergence block to converge the specification.
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Example for Design Specification with Variable Tolerance and Limits

A design specification designates that the inlet and outlet entropies of a Heater
block HX1 are equal. The temperature of HX1 is chosen as the manipulated
variable. Temperature limits cannot be set a priori, but it is known that the
isentropic temperature will be within 75oF of the inlet temperature. The
tolerance for the specification is a function of the entropy.
• The inlet and outlet entropy and the inlet temperature of the block HX1 are

the sample variables. The entropy of the inlet stream HX1-IN is called SIN.
The outlet entropy of the outlet stream HX1-OUT is called SOUT. The
temperature of stream HX1-IN is called TIN.



21-10 Aspen Plus User Guide
Version 10.1-0

Design
Specification
Feedback
Control

• The design specification sets the inlet entropy SOUT equal to the inlet
entropy SIN.

• The tolerance is specified as the variable TOL. TOL is specified as 0.0001
times the absolute value of the entropy of the inlet stream SIN on the Design
Spec Fortran sheet.

• The design specification is satisfied when |SOUT - SIN| < TOL.
• The temperature is specified in the Heater block just as if there were no

design specification. The specified value is the initial estimate used by the
design specification convergence block.

• The design specification convergence block will not try a temperature less
than the inlet temperature TIN - 75F or greater than TIN + 75F, even if the
solution to the objective function lies outside this range. The limits become
alternative specifications if the design specification cannot be achieved. The
initial estimate entered in the reactor block lies within these limits.

• You do not have to specify convergence of the design specification. Aspen Plus
will automatically generate a convergence block to converge the specification.
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Example for Adjusting the Standard Enthalpy of Formation to Achieve a
Desired Heat of Reaction

The heat of reaction for the hydrogenation of ethylene is known to be -32700
cal/mol at 298 K. Aspen Plus predicts a value of -32570. Since it is possible to
access physical property parameters (see Chapter 19, Accessing Variables), a
design specification is used to adjust the Standard Enthalpy of Formation to
achieve the desired heat of reaction.

In Aspen Plus, the heat of reaction is calculated as the difference in enthalpy of
the pure components. Since the Standard Enthalpy of Formation (pure
component parameter DHFORM) is used to calculate vapor and liquid
enthalpies, adjusting DHFORM will similarly adjust the heat of reaction.
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22 Optimization

This chapter includes information on:

• About Optimization
• Recommended Procedure for Optimization
• Defining an Optimization Problem
• About Constraints
• Entering Optional Fortran Statements
• Fortran Declarations
• Convergence of Optimization Problems
• Troubleshooting Optimization Problems

About Optimization
Use optimization to maximize or minimize a user-specified objective function by
manipulating decision variables (feed stream, block input, or other input
variables).

The objective function can be any valid Fortran expression involving one or more
flowsheet quantities. The tolerance of the objective function is the tolerance of
the convergence block associated with the optimization problem.

You have the option of imposing equality or inequality constraints on the
optimization. Equality constraints within an optimization are similar to design
specifications. The constraints can be any function of flowsheet variables
computed using Fortran expressions or in-line Fortran statements. You must
specify the tolerance of the constraint.

Tear streams and the optimization problem can be converged simultaneously or
separately. If they are converged simultaneously, the tear stream is treated as an
additional constraint.
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Convergence of Optimization Problems
Aspen Plus solves optimization problems iteratively. By default Aspen Plus
generates and sequences a convergence block for the optimization problem. You
can override the convergence defaults, by entering convergence specifications on
Convergence forms. Use the SQP and Complex methods to converge optimization
problems. See Chapter 17 for a complete discussion of optimization convergence.

The value of the manipulated variable that is provided in the Stream or Block
input is used as the initial estimate. Providing a good estimate for the
manipulated variable helps the optimization problem converge in fewer
iterations. This is especially important for optimization problems with a large
number of varied variables and constraints.

There are no results associated directly with an optimization problem, except the
objective function and the convergence status of the constraints. You can view
the final value of the manipulated and/or sampled variables either directly on the
appropriate Stream or Block results sheets or summarized on the Results
Manipulated Variables sheet of the convergence block. To find the summary and
iteration history of the convergence block, select the Results form of the
appropriate Convergence block.

Recommended Procedure for
Optimization

Optimization problems can be difficult to formulate and converge. It is important
to have a good understanding of the simulation problem before adding the
complexity of optimization.

The recommended procedure for creating an optimization problem is:
1. Start with a simulation (instead of starting with optimization). There are a

number of reasons for this approach:

• It is easier to detect flowsheet errors in a simulation.
• You can determine reasonable specifications.
• You can determine a reasonable range of decision variables.
• You can get a good estimate for the tear streams.

2. Perform sensitivity analysis before optimization, to find appropriate decision
variables and their ranges.

3. Evaluate the solution using sensitivity analysis, to find out if the optimum is
broad or narrow.
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Defining an Optimization Problem

Define an optimization problem by:
1. Creating the optimization problem.

2. Identifying the sampled flowsheet variables used in the objective function.

3. Specifying the objective function for a sampled variable, or some function of
sampled variables, and identify the constraints associated with the problem.

4. Identifying the simulation input variables to be adjusted to maximize or
minimize the objective function, and specify the limits within which they can
be adjusted.

5. Entering optional Fortran statements.

6. Defining the constraints for the optimization problem.

Creating an Optimization Problem
To create an optimization problem:
1. From the Data menu, point to Model Analysis Tools, then Optimization.

2. In the Optimization Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (or accept the default ID) and
click OK.

Identifying Sampled Flowsheet Variables
Use the Model Analysis Optimization Define sheet to identify the flowsheet
variables used in setting up the optimization problem, and assign them variable
names. The variable name identifies the flowsheet variable that you can use
when defining the objective function, specifying bounds for the manipulated
vairables, or writing Fortran statements.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name.  When completing a Define sheet, specify the variables on the Variable
Definition dialog box.  The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.
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On the Define sheet:
1. To create a new variable, click the New button.

or

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip   Use the Delete button to quickly delete a variable and all of the fields used
to define it.

Tip   Use the Edit button to modify the definition of a variable in the Variable
Definition dialog box.

Entering the Objective Function
If any constraints are associated with the optimization, define them before you
specify the Objective function. For more information, see Defining Constraints,
this chapter.

To enter the objective function for the optimization problem and identify the
constraints:
1. On the Optimization form, click the Objective & Constraints tab.

2. Select either Maximize or Minimize.
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3. In the Objective Function field, enter the targeted variable or Fortran
expression.

To ensure that you enter accurate variable names, click the right mouse
button.  In the popup menu, click Variable List.  The Defined Variable List
window appears.  You can drag and drop the variables from the Defined
Variable List to the Objective Function field.

4. Select the constraints to be associated with the optimization, using the arrow
buttons to move them from the Available Constraints list to the Selected
Constraints list.

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements. For more information,
see Entering Optional Fortran Statements, this chapter.

Identifying the Manipulated Variable
Use the Vary sheet to identify the manipulated variables and specify their limits.
The limits for manipulated variables can be constants or functions of flowsheet
variables.

To identify the manipulated variable and specify limits:
1. On the Optimization form, click the Vary tab.

2. In the Variable Number field, click on the down arrow and select <new>.

3. In the Type field, select a variable type.

Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable. For more information on accessing variables, see
Chapter 18.

4. In the Lower field, enter a constant or Fortran expression as the lower limit
for the manipulated variable.

5. In the Upper field, enter a constant or Fortran expression as the upper limit
for the manipulated variable.

6. You can label the decision variables for the report and the Results form. Use
the Line 1 to Line 4 fields to define these labels.

7. Repeat steps 2 though 6 until you identify all manipulated variables.

You must have already entered the manipulated variable as an input
specification, or it must have a default value. The initial guess used for the
manipulated variable is either this specification or the default. You cannot
manipulate integer block input variables, such as the feed location of a
distillation column.
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About Constraints

You can choose to specify equality and inequality constraints for optimization
problems. Equality constraints are the same as design specifications in non-
optimization problems. Supply an ID for each constraint you define. Constraint IDs
identify constraints on the Optimization sheets.

Defining Constraints
Define a constraint by:
1. Creating the constraint.

2. Identifying the sampled flowsheet variables used in the constraint.

3. Specifying the constraint expression.

4. Ensuring the constraint has been selected on the Optimization Objective &
Constraints sheet.

Creating Constraints
To create a constraint problem:
1. From the Data menu, point to Model Analysis Tools, then Constraint.

2. In the Constraint Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (or accept the default ID) and
click OK.

Identifying Sampled Flowsheet Variables for
Constraints

Use the ModelAnalysis Constraint Define sheet to identify the flowsheet
variables used in the optimization problem and assign them variable names. The
variable name identifies the flowsheet variable that you can use on the Spec and
Fortran sheets.
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Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box.  The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:
1. To create a new variable, click the New button.

or

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip   Use the Delete button to quickly delete a variable and all of the fields used
to define it.

Tip   Use the Edit button to modify the definition of a variable in the Variable
Definition dialog box.

Specifying the Constraint Expression
You need to specify the constraint as a function of the sampled variable and
supply a tolerance on the constraint.
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Constraint functions are defined as follows:

• For equality constraints:
• -tolerance < expression1 - expression2 < tolerance
• For less than or equal to inequality constraints:
• expression1 - expression2 < tolerance
• For greater than or equal to inequality constraints:
• expression1 - expression2 >   tolerance

To specify a constraint:
1. On the Constraint form, click the Spec tab.

2. In the two Constraint expression specification fields, enter expression1 and
expression2, as constants or Fortran expressions.

To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the fields on the Spec form.

3. Select Equal to, Less than or equal to, or Greater than or equal to, for the
specification.

4. In the Tolerance field, enter the constraint tolerance as a constant or as a
Fortran expression.

5. If the constraint is a vector, check the This is a Vector Constraint box, and
specify the elements of the vector that should be used.

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements on the Constraint
Fortran sheet. (See Optional Fortran Statements, this chapter.)

Entering Optional Fortran Statements

You have the option of entering any Fortran statements needed to compute the
optimization objective function terms or manipulated variable limits. Any variable
computed by the Fortran statements can be used in the expressions on the
following sheets:

• Optimization Objective & Constraint
• Optimization Vary
• Constraint Spec

Fortran statements are needed only if the functions involved are too complex to
enter on these sheets.
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You can enter Fortran statements:

• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet.

Using the Fortran Sheet
To enter executable Fortran statements on the Fortran sheet:
1. On the Optimization or Constraint form, click the Fortran tab.

2. Review the rules and restrictions for in-line Fortran. For more information,
see Chapter 19.

3. Enter your Fortran statements.

To ensure that you enter accurate variable names, click the right mouse
button.  In the popup menu, click Variable List.  The Defined Variable List
window appears.  You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

Fortran Declarations
You enter Fortran declarations in the same way as executable Fortran
statements, using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declarations in an optimization problem, including:

• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:

• It is also used by another block.
• Its value must be retained from one iteration of an optimization problem to

another.

Fortran variables that you defined on the Define sheet should not be declared on
the Declarations sheet.
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Convergence of Optimization Problems
Algorithms for solving process optimization problems can be divided into two
categories:

Path Method Information

Feasible Requires that tear streams and equality constraints (design specifications), if any, be
converged at each iteration of the optimization.

Infeasible Can converge tear streams, equality constraints, and inequality constraints simultaneously with
the optimization problem.

Two optimization algorithms are available in Aspen Plus:

• The COMPLEX method
• The SQP method

For more information, see Chapter 17.

COMPLEX Method
The COMPLEX method uses the well-known Complex algorithm, a feasible path
“black-box” pattern search. The method can handle inequality constraints and
bounds on decision variables. Equality constraints must be handled as design
specifications. You must use separate convergence blocks to converge any tear
streams or design specifications.

The COMPLEX method frequently takes many iterations to converge, but does
not require numerical derivatives. It has been widely used for all kinds of
optimization applications for many years, and offers a well-established and
reliable option for optimization convergence.

Sequential Quadratic Programming (SQP) Method
The SQP method is a state-of-the-art, quasi-Newton nonlinear programming
algorithm. It can converge tear streams, equality constraints, and inequality
constraints simultaneously with the optimization problem. The SQP method
usually converges in only a few iterations but requires numerical derivatives for
all decision and tear variables at each iteration.
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The SQP method as implemented in Aspen Plus includes a novel feature:  the
tear streams can be partially converged using Wegstein, each optimization
iteration and during line searches. This usually stabilizes convergence, and can
reduce the overall number of iterations.

You can specify the number of Wegstein passes. Choosing a large value
effectively makes SQP a feasible path (but not a black-box) method. The
Aspen Plus default is to perform three Wegstein passes.

You can also use the SQP method as a black-box or partial black-box method, by
converging tear streams and design specifications as an inside loop to the
optimization problem (using separate Convergence blocks). This reduces the
number of decision variables. The trade-off is the number of derivative
evaluations, versus the time required per derivative evaluation. Whether SQP is
the method of choice depends on your optimization problem.

The default optimization convergence procedure in Aspen Plus is to converge tear
streams and the optimization problem simultaneously, using the SQP method.

Troubleshooting Optimization Problems
The convergence of an optimization problem can be sensitive to the initial values
of the manipulated variables. The optimization algorithm only finds local
maxima and minima in the objective function. Although it occurs rarely it is
possible to obtain a different maximum or minimum in the objective function by
starting at a different point in the solution space.

When an objective function is not satisfied, there are a number of options to
consider:
1. Make sure the objective function does not have a flat region within the range

of a manipulated variable. Avoid the use of objective functions and
constraints that contain discontinuities.

2. Linearize the constraints to the extent possible.

3. If the error improves initially, but then levels off, the derivatives calculated
are sensitive to step size. Some things to try are:

• Tighten tolerances of unit operation and convergence blocks within the
optimization convergence loop. The optimization tolerance should be equal
to the square root of the block tolerances. For example, if the optimization
tolerance is 10-3, then the block tolerances should be 10-6.

• Adjust the step size for better accuracy. The step size should be equal to
the square root of the inner tolerances.

• Check to see that the manipulated variable is not at its lower or upper
bound.
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• Disable the Use Results from Previous Convergence Pass option on the
BlockOptions SimulationOptions sheet for blocks within the optimization
convergence loop.  You can also specify this globally on the Setup
SimulationOptions Calculations sheet.

4. Check to ensure that the manipulated variables affect the value of the
objective function and/or the constraints, perhaps by performing a sensitivity
analysis.

5. Provide a better starting estimate for the values of the manipulated
variables.

6. Narrowing the bounds of the manipulated variables or loosening the tolerance
on the objective function might help convergence.

7. Modify the parameters of the convergence block associated with the
optimization (step size, number of iterations, etc.)

Example for Maximizing Product Value

The value of a reactor product stream is a function of the flow rate of the desired
product, P, and the undesired byproduct, G.

Value = P - 30 * G

Optimization is used to find the reaction temperature that maximizes the
product value.

• The molar flow rate of components P and G in stream PROD are the sampled
variables for the optimization. These variables are called P and G,
respectively.

• The optimization objective function is ( P - 30*G ).
• You can use Fortran expressions, such as ( P - 30*G ) in any part of the

optimization problem.
• The reactor temperature is the manipulated variable. The optimization

convergence block finds the reactor temperature that makes ( P - 30*G ) a
maximum.

• The manipulated variable is specified in the reactor block, just as if there
were no optimization. The specified value is the initial estimate used by the
optimization convergence block.

• The optimization convergence block will not try a temperature less than 300F
or greater than 400F, even if the maximum of the objective function lies
outside this range.

• You do not have to specify convergence of the optimization. Aspen Plus
automatically generates a convergence block to converge the optimization.

• This optimization problem does not have any constraints associated with it.
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Example for Maximizing Operating Margin

The value of a process is calculated as the value of the product and the
byproduct, minus the cost of the raw material, and minus the cost of steam for
the reactor. The Fortran sheet is used to calculate the cost function:
C
C CPROD = PRICE OF PRODUCT, $/LB
         CPROD = 1.30
C
C CBYPR = PRICE OF BYPRODUCT, $/LB
         CBYPR = 0.11
C
C CFEED = PRICE OF FEED, $/LB
         CFEED = .20
C
C CSTEAM = COST OF STEAM, $/MMBTU
         CSTEAM = 4.00
C
C COST FUNCTION
         CFUNC = CPROD * P + CBYPR * G - CFEED * A - CSTEAM * Q /1D6

There are two constraints:

• Maximum duty for the reactor
• Minimum product purity.

Optimization is used to find the reaction temperature and the feed flow rate that
maximizes the cost function.

• The molar flow rate of P and of G in stream PROD, the molar flow rate of A in
stream FEED and the reactor duty are the sampled variables for the
optimization. These variables are called P, G, A, and Q, respectively.

• The optimization problem is converged when CFUNC is at a maximum.
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• There are two manipulated variables:  the reactor temperature and the flow
rate for the reactant A in the feed. The optimization convergence block finds
the combination of values that makes CFUNC a maximum subject to the
constraints.

• The Fortran sheet is used to calculate the cost function CFUNC.
• The manipulated variables are specified in the blocks just as if there were no

optimization. The specified value is the initial estimate used by the
optimization convergence block.

• You do not have to specify convergence of the optimization. Aspen Plus
automatically generates a convergence block to converge the optimization
problem.

• There are two constraints associated with the optimization problem.  They
are called DUTY and PURITY.

• The constraint DUTY is satisfied when the reactor duty is less than or equal
to 3 MMbtu/hr.

• The constraint PURITY is satisfied when mole fraction of P in the stream
PROD is greater or equal to than 0.9.

On the Optimization sheets:
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On the DUTY constraint sheets:
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On the PURITY constraint form:
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23 Fitting a Simulation Model
to Data

You can fit Aspen Plus simulation models to plant or laboratory data using Data-
Fit. You provide one or more sets of measured data for input and results
variables of a simulation model. Data-Fit adjusts (or estimates) input parameters
to find the best fit of the model to the data. If you want Data-Fit to reconcile
measured data for input variables to match the fitted model, it can do this
simultaneously.

Data-Fit minimizes the weighted sum of squares of the differences between the
measured data and the model prediction. In statistical terms, Data-Fit performs
either ordinary least squares or maximum likelihood (errors-in-variables)
estimation.

This chapter discusses:
• Types of Data-Fit applications
• Defining a Data-Fit problem
• Creating Point-Data sets
• Creating Profile-Data data sets
• Defining Data-Fit regression cases
• Ensuring well-formulated Data-Fit problems
• Analyzing convergence problems
• Examining results

Two comprehensive examples are given.

Types of Data-Fit Applications
Data-Fit applications fall into two main categories.
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In the first type of application, Data-Fit determines coefficients for Aspen Plus
user or built-in kinetics models from laboratory kinetics data. For example, given
data for concentration versus time at one or more temperature, Data-Fit
determines coefficients of the power law kinetics model.

In the second type of application, Data-Fit matches an Aspen Plus simulation to
plant data as the first step in a simulation study. For example, given one or more
sets of distillation column feed and product measurements, Data-Fit finds the
column efficiency that best fits the measurements. At the same time, Data-Fit
can:
• Adjust the measurements to match the fitted model
• Estimate missing feed or product measurements
• Help identify poor measurements

Data-Fit is designed for off-line use in developing an Aspen Plus simulation
model that matches available data. Data-Fit is not designed for online plant data
reconciliation applications.

Defining a Data-Fit Problem

Fitting a simulation model to data involves three major steps:
1. Creating base-case Aspen Plus model.

For example, to fit concentration versus time kinetics data, create an RBatch
model. The kinetics model coefficients you enter for RBatch using the
Reactions forms become initial estimates for the Data-Fit problem.

2. Creating one or more Data-Fit data sets.

Use this Data Set type To fit

POINT-DATA • One or more steady-state experiments or operating points

• Initial charge and final products of a batch reactor, but not intermediate time points

• Feeds and products of a plug flow reactor, but not points along the length of the reactor

PROFILE-DATA • Time series data for a batch reactor

• Measurements along the length of a plug flow reactor

3. Defining regression cases. Specify Data-Fit cases and input parameters to be
estimated. See Defining Data-Fit Regression Cases, this chapter.

Subsequent sections of this chapter describe each of these steps.
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Creating Point-Data Data Sets

To create a Point-Data data set:
1. From the Data menu, point to Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Data-Set.

3. In the Data-Set Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.

5. In the Select Type list, select Point-Data and click on OK.

6. On the Define sheet, identify the flowsheet variables for which you have
measurements (see Identifying Flowsheet Variables, this chapter).

7. On the Data sheet, enter the measured data (see Entering the Measured
Point-Data, this chapter).

Identifying Flowsheet Variables
You must identify the flowsheet variables for which you have measurements. Use
the Data-Fit Data-Set Define sheet to identify the flowsheet variables used in the
data set and assign them variable names. The variable name identifies the
flowsheet variable on other data set sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:
1. To create a new variable, click the New button.

or

To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:

• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ
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3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip  Use the Delete button to quickly delete a variable and all of the fields used
to define it.

Tip   Use the Edit button to modify the definition of a variable in the Variable
Definition dialog box.

Types of Flowsheet Variables

You must identify the flowsheet variables for which you have measurements. You
can also identify results variables for which you have no measurements.
Aspen Plus will estimate the results variables and tabulate them for each data
point.

In Data-Fit, you cannot access vectors. You must access each stream variable or
each component in a composition vector as a different scalar variable.

Always access feed stream compositions as mole, mass, or standard volume
component flows. Do not access them as fractions. This avoids any problems with
normalizing fractions.

You can access both input values and results values for certain flowsheet
variables. For example, the condenser duty of a RadFrac block can be accessed
either as the input variable Q1 or the results variable COND-DUTY. The reboiler
duty can be accessed as the input variable QN or as the results variable REB-
DUTY. Select either the input or results variable as follows:

Is the measured variable specified as an input
in the base case simulation?

Then select

Yes The input variable

No The results variable

For example, suppose:
• Your base-case model consists of a RadFrac block with Reflux Ratio and

Condenser Duty specified.
• The data you want to fit includes reboiler and condenser duty.
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You must select the results variable REB-DUTY for the reboiler duty, since it is
not specified as an input in the base-case model. You must select the input
variable Q1 for the condenser duty, since it is specified as an input in the base-
case model.

If you want to reconcile the measurement for Q1, provide a non-zero standard
deviation. If you do not want to reconcile it, provide a zero standard deviation.

Entering the Measured Point-Data
Use the Data-Fit Data-Set Data sheet to enter measured data.

For each measured variable:
1. On the Data-Fit Data-Set form, click the Data tab.

2. Specify whether the variable is a simulation Input or Result for the Data-Fit
problem.

Specify these variables As

Measured feed stream Input

Measured product stream Result

Measured variables that were accessed as input variables
on the Define sheet

Input

All  other measured variables Result

Note   Intermediate stream variables are usually results. However, when a
Data-Fit problem spans only a subset of the flowsheet, you must specify
intermediate streams that are inlets to the Data-Fit subproblem as inputs.

3. Specify a standard deviation for the measurement in the first row of the data
table.

4. Enter one or more data points (rows in the table). If a measurement is not
available for a Result variable, leave its Data field blank. Data-Fit will
estimate it. You must always enter a value for an Input variable.

You can introduce a new standard deviation row at any time. It will apply to
subsequent data points.
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Standard Deviation

The standard deviation is the level of uncertainty in the measurement. You can
enter it as an absolute or percent error (append a percent sign (%) to the value).
Statistically determined standard deviations are seldom available. It is enough to
supply an approximate “expected error,” estimated from experiences or
instrument specifications. Each residual (measurement — model prediction)
term in the sum of squares function is weighted by 1/(standard deviation2).

You must specify a standard deviation greater than zero for each results variable
to be fit. If a zero value is entered for standard deviation, that results variable is
not included in the regression.

For inputs, a standard deviation greater than zero invokes maximum likelihood
(errors-in-variables) estimation:

If the standard deviation for an input
variable is

Then Aspen Plus

Zero Treats the measurement as exact and Data-Fit does not adjust it

Greater than zero Adjusts (reconciles) the measurement, along with results measurements, to match the
fitted model

Note  Reconciling inputs can increase solution time significantly, since each reconciled
input is treated as a decision variable by the least squares algorithm

Creating Profile-Data Sets

To create a Profile-Data data set:
1. On the Data menu, select Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Data-Set

3. In the Data-Set Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.

5. In the Select Type list, select Profile-Data and click on OK.

6. On the Define sheet, identify the flowsheet variables for which you have
measurements (see Identifying Profile Variables, this chapter).

7. On the Data sheet, enter the measured data (see Entering the Measured
Profile-Data, this chapter).

8. You can specify the charge (Rbatch) or feed (Rplug) on the Initial Conditions
sheet.
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Identifying Profile Variables
Profile variables are available for the RBatch and RPlug unit operation models.
1. On the Data-Set form, click the Define tab.

2. In the Model and Block Name area, select either RBatch or the RPlug.

3. In the Block field, identify the block where the profiles have been measured.

4. In the Variable Name field, enter a variable name. A variable name must:

• Be six characters or less for a scalar variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

5. In the Variable list, select a variable. See the prompt for a description of each
variable.

6. For concentration or fraction profile variables, identify the component being
measured in the Component field. You must identify each component
concentration or fraction as a separate measured variable.

7. Repeat steps 4 through 6 for each measured variable.

You can identify profile variables for which you have no measurements. Data-Fit
will calculate and tabulate them.

Entering the Measured Profile-Data
Use the Data-Fit Data-Set Data sheet to enter measured data.

For each measured variable:
1. On the Data-Fit Data-Set form, click the Data tab.

2. In the first row of the data table, specify a standard deviation greater than
zero for each measured variable to be fit. If a zero value is entered for the
standard deviation, that results variable is not included in the regression.

3. Enter the time or length and the measurements for each data point. Leave
missing measurements blank. Aspen Plus will estimate them.

You can introduce a new standard deviation row at any time. It will apply to
subsequent data points.

4. If you want to specify temperature and pressure values to replace those in the
base-case, enter the value(s) on the Initial Conditions sheet. Data-Fit does not
reconcile (adjust) these values. It assumes they are exact.
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5. If the experiment was carried out with a feed or charge different than that in
the base-case model, specify the component flows on the Profile-Data Initial
Conditions sheet. Select the basis (Mole/Mass/StdVol) and the units. Enter
the component flows. Aspen Plus assumes the values you enter are exact and
does not adjust them. You can only specify flows for conventional components.
If the feed/charge specified in the base-case model contains nonconventional
components, Data-Fit will use:

• Base-case specifications for nonconventional components
• Conventional component flows entered on this form as feed/charge to

reactor

The standard deviation is the level of uncertainty in the measurement. See
Standard Deviation, this chapter, for more information.

Defining Data-Fit Regression Cases

You can fit both Point-Data and Profile-Data data sets in the same regression case.
For example, you might have time series data for a reaction at one temperature
(Profile-Data), and overall conversion data at several temperatures (Point-Data).

A Data-Fit regression case must involve at least one of the following:
• An estimated parameter
• A reconciled input (with a standard deviation greater than zero)

Aspen Plus adjusts (reconciles) measured input variables when you specify non-
zero standard deviations for the input measurements on the Data-Set Data
sheet. There will be one estimate for a reconciled measured input for each data
point.

For an estimated parameter, you must have already entered a value for it as an
input specification for the base simulation, or it must have a default value. Data-
Fit uses this specification as the initial guess for the variable.

If the base-case value lies outside the bounds you enter for the parameter on the
Regression Vary sheet or for a reconciled input, Data-Fit uses the nearest bound
as the initial guess.

There is no limit to the number of estimated parameters.

Data-Fit leaves a variable at its lower or upper limit if violating the limit would
further decrease the sum-of squares function.
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Creating Data-Fit Regression Cases
To define a Data-Fit regression case:
1. On the Data menu, select Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Regression.

3. In the Regression Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.

5. On the Specifications sheet, identify the data sets to be fit in the case (see
Creating Point-Data Data Sets and Creating Profile-Data Sets, this chapter).
You can also supply Weights to adjust the relative weighting of the data sets,
but this is usually not necessary. For more information on Weights see Data-
Fit Numerical Formulation.

6. On the Vary sheet, identify any simulation input parameters you want to
estimate. Data-Fit will adjust the variables to find the best fit to the Data-
Sets listed on the Specifications sheet.

7. On the Convergence sheet, you can select the Initialization Method when
reconciling input measurements.

To initialize the reconciled inputs to Use the initialization method

Base-case values Base Ccase Values (default)

Measured values Measurements

The default base-case initialization method is robust, but it can take a few
more iterations if the measurements are far off from the base case.

Normally you do not need to change any other defaults on the Regression
Convergence sheet. See Convergence Parameters, this chapter, for more
information.

Convergence Parameters
The Regression Convergence sheet is used to specify optional Data-Fit
convergence parameters. In most cases, it is unnecessary to change these
parameters from their default values.
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The following parameters are available on the Convergence sheet:

Field Default Used To

Maximum Algorithm Iterations 50 Specify the maximum number of optimizer iterations.

Maximum Passes Through
Flowsheet

1000 Set the maximum number of flowsheet passes allowed in a Data-Fit run.
Included in the count of flowsheet passes are the initial base case,
passes required to compute the residuals, and passes required to
compute the Jacobian matrix through perturbation.

Bound Factor 10 Lower and Upper bounds for reconciled input variables are computed
using Bound Factor times Standard Deviation for that variable.

See Bound Factor, this chapter, for more information about setting the Bound
Factor.

Absolute Function Tolerance 0.01 Specify the absolute sum-of-squares objective function tolerance.

If the optimizer finds a point where the objective function value is less
than the Absolute Function Tolerance, the problem is converged.

Relative Function Tolerance 0.002 Specify the relative function convergence tolerance.

If the current model predicts a maximum possible function reduction of
at most the relative function tolerance times the absolute value of the
function value at the start of the current iteration, and if the last step
attempted achieved no more than twice the predicted function decrease,
then the problem is considered converged.

X Convergence Tolerance 0.002 Specify the X convergence tolerance.

If a step is tried that has a relative change in X less than or equal to the
X Convergence Tolerance and if this step decreases the objective
function by no more than twice the predicted objective function
decrease, the problem is considered converged.

Minimum Step Tolerance 1e-10 Data-Fit returns with suboptimal solution if a step of scaled length of at
most Minimum Step Tolerance is tried but not accepted.

Calculate Covariance Matrix checked Calculate covariance and correlation matrices and write correlation
matrix to report file.

Advanced Parameters
The Regression Advanced sheet is used to specify additional Data-Fit
convergence parameters. In most cases, it is unnecessary to change these
parameters from their default values.

The algorithm maintains an estimate of the diameter of a region about the
current estimate of the vector of varied values in which it can predict the
behavior of the least-squares objective function, that is, a trust region.
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The following parameters are available on the Convergence sheet:

Trust region tuning parameters
field

Default Used To

Switching Parameter 1.5 Data-Fit algorithm uses a trust-region strategy. Switching Parameter is used in a
test to decide when to switch the model for the trust region.

Adjustment Factor 0.75 If the decrease in the value of the objective function is at least Adjustment
Factor*inner product of the step and the gradient, then the trust region radius is
increased.

Reduction Factor 0.5 The factor by which the trust region radius is shrunk if current X leads to errors in
function or Jacobian evaluation.

Minimum Reduction Factor 0.1 The minimum factor by which the trust region radius may be shrunk.

Minimum Expansion Factor 2 The minimum factor by which the trust region radius is increased if it is increased
at all.

Maximum Expansion Factor 4 The maximum factor by which the trust region radius may be increased at one
time.

Step and tuning parameters
field

Default To

Initial Step Size 1 Factor determining the initial step size of the trust region.

The choice of Initial Step Size can profoundly affect the performance of the
algorithm - different values sometimes lead to finding different local minima. Too
small or too large a value of Initial Step Size causes the algorithm to spend
several function evaluations in the first iteration increasing or decreasing the size
of the trust region.

Size Control Parameter 0.0001 For the step to be accepted the actual function reduction must be more than Size
Control Parameter times its predicted value.

Adaptive Scaling Strategy 0.6 Tuning factor associated with adaptive scaling strategy in the algorithm

Relative Perturbation Size 0.005 Default perturbation size during Jacobian evaluation for variable X is Relative
Perturbation Size times the absolute value of X.

False Convergence Check
Parameter

0.1 Helps decide when to check for false convergence and to consider switching the
algorithm model for the current trust region.
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Data-Fit Numerical Formulation

Data-Fit solves a problem with the following formulation:
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subject to Xplb < Xp < Xpub

Xrilb < Xri < Xriub

Where:

Nsets = Number of data sets specified on the Regression Specifications
sheet

Nexpi = Number of experiments in data set i

Nri = Number of reconciled input variables

Nrr = Number of measure results variables

Wi = Weight for data set I specified on the Regression Specifications
sheet

Xp = Vector or varied parameters

Xmri = Measured values of the reconciled input variables

Xri = Calculated values of the reconciled input variables

Xmrr = Measured values of the results variables

Xrr = Calculated values of the results variables

Sigma = Standard deviation specified for the measured variables

Reconciled input variables are adjusted to minimize the sum of square of errors
for each experiment independently.
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Ensuring Well-Formulated Data-Fit
Problems

This section applies primarily to Point-Data data sets.

Although Data-Fit is extremely flexible, you must ensure that a Data-Fit problem
is well posed. Data-Fit does not check this for you. There are two basic rules you
must follow:
• When Data-Fit evaluates a data point, it merges the current values of the

measured inputs and the estimated parameters with the base-case
specifications. To avoid erroneous results, the set of measured inputs for a
data set must form a complete input specification for uniquely calculating the
measured results for that data set.

• The base-case simulation model must be formulated to have a solution, even
when the measurements are not in mass or energy balance.

The following example illustrates the application of both rules.

Example of a Well-Formulated Data-Fit Problem

Suppose you want to fit column efficiency to operating data for a distillation
column with one feed and two products. Data are available for several operating
points. Each operating point has:
• A different feed composition, flow rate, and temperature
• Different distillate and bottoms flow rates and temperatures
• The same reflux ratio and feed and column pressures

The feed data consists of component mole flow rates and temperatures. Product
stream data consists only of total flow rates and temperatures.

The following table describes a well-posed Data-Fit formulation for this problem:

This Consists of

The base-case simulation model • A feed stream with temperature, pressure, and component mole flows specified

• A RadFrac block with Mole Reflux Ratio, Mole Distillate to Feed Ratio, and
pressure specified

The data set for the operating
points

Inputs:

• Mole flow rate for each component with a non-zero flow in the base-case feed
stream

• Feed stream temperature

• Distillate-to-feed ratio, accessed as the RadFrac Mole-D:F input variable and
entered as an unmeasured input in the data set

Results:

• Distillate and bottoms temperature

• Distillate and bottoms flow rate
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The pressure and Mole Reflux Ratio are fixed specifications for this problem.
Data-Fit overrides the base-case feed component flow rates, temperature, and
column distillate-to-feed ratio specification for the evaluation of each data point.
If any inputs were omitted from the data set, base-case values would be used for
the data point evaluations, causing incorrect results.

The distillate-to-feed ratio specification must be used so that RadFrac can solve
with most any feed. If the distillate flow specification were used instead, a
measure distillate rate that was not in good mass balance with the measured
feeds could result in an infeasible column specification that RadFrac could not
solve.

Bound Factor
When you specify non-zero standard deviations for measured inputs, Data-Fit
uses the following limits for the variable estimates:

Lower Bound = Measured value - (Bound Factor) * (Standard Deviation)

Upper Bound = Measured value + (Bound Factor) * (Standard Deviation)

Bound Factor has a default value of 10. You can enter a different value on the
Regression Convergence sheet.

Aspen Plus checks to see whether the lower bound for flows is negative. If so, a
warning is given and the lower bound is set to zero. Care should be taken in
setting the Bound Factor to avoid zero flow rates.

Remember that setting bounds that are too tight or too loose could cause Data-
Fit to move into an infeasible region. For example, if you are reconciling the
reflux rate for a tower and using the reflux rate as a reconciled input variable,
and you allow the lower bound on the reflux rate to be zero, Data-Fit may drive
the reflux rate to zero during the solution process and cause severe errors in
RadFrac.

Instead of setting very tight bounds on the reconciled input variables, you should
treat them as fixed instead.

Estimating Unmeasured Variables
Data-Fit can estimate and tabulate any unmeasured result. Access the calculated
variable as a Result in a data set, enter a nonzero standard deviation, and leave
the data field blank.
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Data-Fit can also estimate unmeasured input variables. Access the variable as
an Input in a data set. Enter a reasonable initial guess and a large standard
deviation (for example, 50%) for the variable. Make sure the standard deviation
gives reasonable lower and upper limits for the estimated variable.

Sequencing Data-Fit

For Data-Fit problems, Aspen Plus will:
1. Run the base-case simulation.

2. Execute the Data-Fit loop until it converges or fails to converge.

3. Replace the base-case values of fitted parameters with the regressed values,
and rerun the base-case simulation.

If any Case-Study or Sensitivity blocks are present, Aspen Plus uses the fitted
parameters to generate the Case-Study and/or Sensitivity tables. The Data-Fit
problem is not re-executed each time.

The Aspen Plus automatic sequencing algorithm places Data-Fit loops outside
any flowsheet convergence loops.

In most cases, Data-Fit should be run standalone. For example, you may want to
estimate kinetic coefficients in the power-law expression, using a RCSTR block.
Run Data-Fit with RCSTR. Then use the regressed values as input in a larger
flowsheet with that RCSTR block.

You can sequence the execution manually to suit your needs on the Convergence
Sequence form.

Using Data-Fit Results
The key Data-Fit results are:

Results On Data-Fit sheet

Chi-Square statistic for the fit Regression Results Summary

Final estimates and standard deviations for the estimated
parameters

Regression Results Manipulated Variables

Table of measured values, estimated values, and
normalized residuals for the data sets

Regression Results Fitted-Data

Table of iteration history of the function results or of the
vary results and reconciled input

Regression Results Iteration History
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A Chi-Square value greater than the threshold value indicates the model does
not fit the data. This can occur due to errors in the measured data, or because the
model does not represent the data. You can use the Chi-Square statistic for
selecting between models. If you fit two or more models to the same data set(s),
the model with the lowest Chi-Square value fits the data best.

It is not uncommon for the standard deviations of estimated parameters to be
relatively large. This does not necessarily indicate a poor fit.

Review the Regression Results Fitted-Data sheet for large normalized residuals
(outliers). A residual value much larger than the others might indicate a bad
data point.

For measured inputs with standard deviations equal to zero, there are no
estimated values or residuals. Data-Fit does not adjust these measurements.

The Regression Results Fitted-Data sheet allows the plotting of results. These
plots can help you:
• Visualize how well your model fits the data
• Spot poor data points

For information about how to generate plots, see Chapter 13 .

Troubleshooting

If Data-Fit fails to converge, look for:
• Large errors in the values entered for the measurements, such as data entry

errors or incorrect units
• Gross errors in source data

Errors may occur in the problem formulation. Check:
• Does the base-case simulation converge?
• Do measured inputs completely determine the measured results? See

Ensuring Well-Formulated Data-Fit Problems, this chapter.
• Is the base-case simulation formulated to handle measured data that are not

in good mass balance? See Ensuring Well-Formulated Data-Fit Problems, this
chapter.

• Do the values specified in the base-case simulation provide good estimates for
the estimated parameters?

• Do the estimated parameters affect the measured variables over the range
specified? You can check the sensitivity of the measured variables to the
estimated parameters with a sensitivity run. A different base-case parameter
value or a smaller parameter range may be needed.
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• Do specified bounds allow the decision variables to take the model into
infeasible regions (leading to convergence failures for unit operation model
algorithms or internal convergence loops)? The recommended action is to
tighten the bounds.

• Do the fitted parameters have large differences in order of magnitude? If so,
it may be helpful to scale those values using a Fortran block.

• Does the model represent the data? If not, either choose another model or
enter new base-case specifications.

Example of Fitting Reaction Kinetics Data

Determine the coefficients of the Aspen Plus power law kinetics model for the
liquid phase reaction ALLYL + ACET Æ PROD. A backup file for this problem is
included in the Examples library as datafit1.bkp.

The following data is available:

Initial charge: 0.05 lb ALLYL

0.07 lb ACET

Reaction temperature: 30oC

Mole fractions:

Time ALLYL PROD

600 seconds 0.30149 0.19745

900 seconds 0.25613 Unmeasured

1900 seconds 0.14938 0.45820

A base-case simulation is defined with the following specifications:

Feed Flow Rate

ALLYL 0.05 lb/hr

ACET 0.07 lb/hr

Rbatch Specification Value

Reactor Type Constant Temperature

Temperature 30.0
o
C

Cycle time 1900.0 seconds

Valid phases Liquid-Only
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Power Law Kinetics Specifications Value

ALLYL exponent 1.0

ACET exponent 0.5

Pre-exponential factor 1.5E7

Activation energy 6.5E7

Time series data is entered in a Profile-Data data set.
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Because data is available at only one temperature, the pre-exponential factor is
fit with the activation energy fixed. The Regression case is entered as follows:
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After running the Data-Fit problem, the resulting estimate of the pre-exponential
factor appears on the Regression Results Manipulated Variable sheet:

The Regression Results Fitted-Data sheet displays the original measured values,
along with the final estimated values for these variables.
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These original measured values and the final estimated values can be plotted
against each other to see the fit of the data and identify any outliers.

Example for Matching a Column Model to Plant Data

This example reconciles measurements and fits column Murphree stage
efficiency to operating data for a binary distillation column with one feed and two
product streams. A backup file for this problem is in the Examples library as
datafit2.bkp.
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The following data is available:

Run 1 Run 2 Run 3

Feed

Water flow rate, lbmol/hr

Ethanol flow rate, lbmol/hr

Temperature, 
o
F

55

45

77

45

55

75

50

50

80

Distillate

Total flow rate, lbmol/hr

Temperature, 
o
F

45

175

55

170

50

174

Bottoms

Total flow rate, lbmol/hr

Temperature, 
o
F

45

180

55

185

50

183

A base-case simulation is defined with the following specifications:

Feed Stream Specification Value

Water flow rate, lbmol/hr 50

Ethanol flow rate, lbmol/hr 50

Temperature, 
o
F 77

Pressure, psia 15

RadFrac Specification Value

Number of stages 20

Feed stage 10

Pressure, psia 15

Distillate vapor fraction 0.0

Reflux ratio 3.0

Distillate-to-feed ratio 0.5

Murphree stage efficiencies 0.1

The column specifications (reflux ratio and distillate-to-feed ratio) ensure that
the column can be solved even if the measured feed and distillate flow rates are
not in mass balance.
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A Fortran block is defined to set the stage efficiency of the column and is
executed just before the RadFrac block. This Fortran block reads a parameter
being varied by Data-Fit and transfers this to the efficiency of the first and last
stages of the column. RadFrac automatically uses this efficiency for all
intermediate stages.

The Point-Data data set is:
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The distillate-to-feed ratio (COLDF) measurement is given an arbitrary value
(0.5) and a large standard deviation (100.0). This specification tells Data-Fit to
vary the distillate-to-feed ratio as needed for each data point to find the best fit
to the measured data. The initial guess is 0.5. The distillate-to-feed ratio is an
unmeasured input, to be estimated. Distillate and bottoms flow rate are treated
as measured results. This ensures a feasible solution for the column for each
Data-Fit data point.

The measured distillate or bottoms flow rate could have been used directly as an
input (the RadFrac specification). But, RadFrac would be unable to find a
solution if the flow rate measurements contained significant error and were not
in mass balance.

The Data-Fit Regression case is defined as follows:
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❖     ❖     ❖     ❖ 
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24 Transferring Information
Between Streams or
Blocks

Use a transfer block to copy the values of flowsheet variables from one part of the
flowsheet to another. You can copy to any number of destinations:
• Whole streams
• Stream composition and flow rate
• Any flowsheet variable (for example, block variables)

The most common application is to copy one stream into another.

This chapter describes:
• Defining transfer blocks
• Creating transfer blocks
• Copying streams
• Copying flowsheet variables
• Specifying when to execute a transfer block
• Entering flash specifications for destination streams

Defining a Transfer Block

To define a transfer block:
1. Create the transfer block.

2. Copy either a stream, a stream flow, a substream or a block or stream
variable.

3. Optionally enter flash specifications for destination streams.
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By default, Aspen Plus will flash modified streams automatically, using the
values present in the stream and the flash options established either on the
Streams form for process feeds, or by the source block for other streams.

4. Optionally specify when the transfer block is executed.

By default, Aspen Plus will sequence the block automatically.

Subsequent sections of this chapter describe each of these steps.

Creating a Transfer Block
To create a transfer block:
1. From the Data menu, point to Flowsheeting Options, then click Transfer.

2. In the Transfer Object Manager, click New.

3. In the Create New ID dialog box, enter an ID, or accept the default, and click
OK.

Copying Flowsheet Variables

The From and To sheets are used to specify what flowsheet variables are copied
from one place to another.

The following information can be copied:

If you select on the From
sheet

Aspen Plus copies

Entire stream An entire stream

Stream flow Only the component flows and total flow of a stream

Substream An entire substream

Block or stream variable A scalar stream variable or block variable
When scalar variables are copied, the variable type does not have to be the same on each sheet,
but each variable type must have the same physical dimensions (for example temperature).
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Copying Streams
To copy a stream:
1. On the Transfer form, click the From tab.

2. Click the Entire Stream option and specify the stream in the Stream Name
field. The information for an entire stream including all substreams will be
copied.

3. Click the To tab.

4. Specify any number of destination streams in the Stream field.

Copying Stream Flow
To copy component flows of a stream:
1. On the Transfer form, click the From tab.

2. Click the Stream Flow option and specify the stream in the Stream Name
field. The component and total flow rates of a stream will be copied, but not
the conditions (temperature, pressure, vapor fraction, and other intensive
variables).

3. Click the To tab.

4. Specify any number of destination streams in the Stream fields.

Copying Substreams
To copy a substream:
1. On the Transfer form, click the From tab.

2. Click the Substream option and specify the stream and substream in the
Stream Name and Substream fields. The information for one substream of a
stream will be copied.

3. Click the To tab.

4. Specify any number of destination streams in the Stream and Substream
fields.
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Copying Block or Stream Variables
To copy a block, stream, or other flowsheet variable:
1. On the Transfer form, click the From tab.

2. Select the Block or Stream Variable option.

3. In the Type field, select the type of variable you want to copy.

4. Aspen Plus takes you to the remaining fields necessary to completely identify
the variable. See Chapter 18 for more information on accessing variables.

5. Click the To tab.

6. On the Variable Number field, click the down arrow and select <new>.

7. In the Type field, select the type of variable for the destination of the copy.

8. Aspen Plus takes you to the remaining fields necessary to completely identify
the variable.

Repeat steps 6 to 8 for all the variables to which the From variable is to be
copied.

Specifying Transfer Block Execution

Use the Transfer Sequence sheet to specify when the transfer block is executed.

You can do either of the following:
• Use the default, Automatically Sequenced, to let Aspen Plus sequence the

block automatically.
• Specify when the Transfer block is to be executed (Before or After a block, or

at the beginning (First) or end (Last) of a simulation).

To specify transfer block execution:
1. On the Transfer form, click the Sequence tab.

2. This table shows how to specify when the transfer block is to be executed:
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Specify this in the Execute field To

Automatically sequenced Have the Transfer block sequenced automatically

First Have the Transfer block executed at the beginning of the simulation

Before Have the Transfer block executed before a specified Block, Convergence, Fortran,
Transfer, Balance, or Pressure Relief
The Block Type and Block Name must be specified.

After Have the Transfer block executed after a specified Block, Convergence, Fortran,
Transfer, Balance, or Pressure Relief
The Block Type and Block Name must be specified.

Last Have the Transfer block executed at the end of the simulation

3. If you entered Before or After, select the unit operation block, convergence
block, Fortran block, transfer block, balance block or pressure relief black
before or after which you want the transfer block to be executed.

4. Use the Diagnostics button on this sheet to set the levels of diagnostic output.

Entering Flash Specifications for
Destination Streams

When you copy into a stream, Aspen Plus flashes the destination stream(s) to
calculate a new set of stream properties using the values present  in the stream
and the flash options established either on the Streams form for process feeds, or
by the source block for other streams.

You can use the optional Stream Flash sheet to specify the thermodynamic
condition and flash options for modified streams. For example, use it when you
copy stream flows and need to specify the temperature and pressure of the
destination stream.

The flash type must be specified. The possible flash types are:
• Temperature & Pressure
• Temperature & Vapor Fraction
• Temperature & Enthalpy
• Pressure & Vapor Fraction
• Pressure & Enthalpy
• Do not Flash Stream

Temperature or pressure estimates can be entered if desired.
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Also specify the phases the flash calculation should consider and optionally the
maximum iterations and error tolerance for the flash calculation.

To enter flash specifications for a stream:
1. On the Transfer form, click the Stream Flash tab.

2. Specify the stream name in the Stream field.

3. Specify the Flash Type.

4. Specify the flash specifications, estimates and/or convergence parameters.

Example of a Stream Copied to Two Other Streams

A transfer block is used to copy stream F-STOIC into streams F-CSTR, F-PLUG,
and F-GIBBS.
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Example of Stream Conditions Copied to a Block

The transfer block TEMP sets the temperature of block TRANSFER equal to the
temperature in stream LIQUID2.

The stream LIQUID2 is an outlet from a Flash3 where the properties are being
calculated using the UNIF-LL physical property methods. Downstream from the
Flash3, the properties are being calculated using the NRTL physical property
methods.

When two different physical property methods are being used in a flowsheet,
there may be inconsistencies where they meet. Often it is good practice to add in
a Heater block with a temperature and pressure specification between the two
sections with the different physical property methods. The Heater should use the
temperature and pressure of the inlet stream and the physical property method
of the new section or block to which the outlet from the Heater is connected. A
Transfer block can be used to transfer the temperature and pressure of the inlet
stream to the Heater block.

In this flowsheet, only the temperature is transferred since the pressures are all
ambient. A similar transfer block could be used to transfer the pressure from the
LIQUID2 stream to the TRANSFER Heater block.



24-8 Aspen Plus User Guide
Version 10.1-0

Transferring
Information
Between
Streams or
Blocks

❖     ❖     ❖     ❖ 



Aspen Plus User Guide 25-1
Version 10.1-0

Chapter 25

25 Balance Blocks

You can use a Balance block to calculate heat and material balances around an
envelope of one or more unit operation blocks. The Balance block updates stream
variables entering or leaving the envelope with the calculated results. For example,
the Balance block can calculate:
• Flow rate of make-up streams in recycle calculations. (This eliminates

Fortran blocks.)
• Feed stream flow rate and conditions, based on other stream and block

information. (This eliminates design specifications and convergence loops.)

This chapter includes the following topics about Balance blocks:
• Defining a Balance block
• Specifying blocks and streams for balance calculations
• Specifying and updating stream variables
• Sequencing Balance blocks
• Flash specifications
• Material and energy balance equations

Defining a Balance Block

Define a Balance block by:
1. Creating the Balance block.

2. Specifying blocks and streams for balance calculations.

3. Specifying and updating stream variables.

4. Sequencing balance blocks.

5. Optionally, specifying flash conditions.
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Creating a Balance Block

To create a Balance block:
1. From the Data menu, select Flowsheeting Options, then Balance.

2. On the Balance Object Manager, click the New button.

3. In the Create New ID dialog box, enter an ID or accept the Default ID and
click OK.

4. Select the Balance form you want to enter data on from left pane of the Data
Browser. See subsequent sections of this chapter for more information.

Form Sheet What is Specified

Setup Mass Balance Blocks or streams to include in each material
balance envelope

Energy Balance Blocks or streams to include in each energy balance
envelope

Equations Material and energy balance relationships in addition
to what is specified on the Mass Balance and Energy
Balance sheets

Calculate Stream variables to calculate and update after the
mass and energy balance calculations

Scale Stream scale factors

Advanced Parameters Optional convergence parameters, including relative
tolerance of balance equation residuals

Sequence Optional execution sequence for the balance block

Stream Flash Optional flash specifications for specified streams.
This sheet can also be used to suppress automatic
flash calculations for streams updated by the
Balance block.

Diagnostics Levels of diagnostic output from the balance block
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Specifying Blocks and Streams for
Balance Calculations

Use the Mass Balance and Energy Balance sheets to specify blocks or streams for a
mass and energy balance envelope. The energy balance equations are overall
energy balances.

The mass balance equations can be any one of these:
• Overall. Do not specify Components, Component Groups, or Substreams.
• Substream. Do not specify Components or Component Groups.
• Component balances

To specify blocks or streams for mass balance calculations:
1. Select the Mass Balance sheet.

2. On the Mass Balance Number field, click the down arrow and select <new>.

3. In the New Item dialog box, specify an ID or accept the default ID.  The ID
must be an integer.

4. Specify blocks or streams (inlets and outlets) to include in the material
balance envelope.

5. Specify components, component groups, or substreams, depending on the
material balance type.

6. If you want to enter more than one material balance, repeat steps 2 through
5.

To specify blocks or streams for energy balance calculations:
1. Select the Energy Balance sheet.

2. On the Energy Balance Number field, click the down arrow and select <new>.

3. In the New Item dialog box, specify an ID or accept the default ID.  The ID
must be an integer.

4. Specify the blocks or streams (inlets and outlets) for the energy balance
envelope.

5. If you want to enter more than one energy balance, repeat steps 2 through 4.

Tip If you want to delete an mass balance or energy balance, click the right
mouse button on the Mass Balance Number or the Energy Balance Number field.
 From the popup menu, select Delete.

Use the Equations sheet to set up general molar/mass relationships among the
total or component flows of one or more streams. You can also specify the mole
and mass right hand side of a relation. See Material and Energy Balance
Equations, this chapter, for more information about the form of the equations.
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Specifying and Updating Stream
Variables

Use the Calculate sheet to specify which stream variables to calculate by solving
the mass and energy balance relationships. You can specify to update these
variables after they are calculated. To solve the balance equations, the total
number of variables specified on this form must equal the total number of
equations specified on the Mass Balance and Energy Balance sheets.

Aspen Plus can calculate these types of flow variables:
• Total flow rate. The stream composition remains the same.
• Substream flow rates. The stream composition remains the same.
• Component flow rates of all applicable substream/component combinations

If you do not specify substreams when you specify component flows, Aspen Plus
calculates the component flow rate of the default substream. The default
substream for a specified component is the first substream containing that
component.

Convergence Parameters

Use the Advanced Parameters sheet to:
• Specify Balance block convergence parameters
• Check additional implicit mass balance equations
• Adjust the maximum number of iterations, the relative tolerance of the

balance equation residuals, and the relative tolerance of calculated variables

The implicit mass balance equations are any mass balance or mass/mole
relationships which do not involve any variables to be calculated or material
balance equations for the energy balance. The additional mass balance equations
are checked by default, and if they are out of balance, the calculated variables are
not updated. It is possible to update calculated variables even if the equations
are out of balance. You can choose not to check the additional mass balance
equations.
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Sequencing Balance Blocks
Use the Advanced Sequence sheet to specify when to execute a Balance block:

A Balance block can be sequenced automatically or manually. In automatic
sequencing the Balance block executes before any unit operation block with a
feed stream updated by this Balance block.

In some cases, Aspen Plus places the Balance block within a convergence loop.
You can control whether the block executes only once (for example, for
initializing a tear stream) or always (for example, for makeup calculations).
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Flash Specifications

Use the Stream Flash sheet to specify thermodynamic conditions or suppress
automatic flash calculations for streams updated by a balance block. Aspen Plus
automatically flashes an updated stream unless the only updated variable is the
total flow.

Material and Energy Balance Equations

When the number of variables exceeds the number of equations, you must enter
the unknown variables to be calculated on the Calculate form. Since the system of
equations is linear, Aspen Plus solves the unknown variables directly. You can
specify that the corresponding stream variables are updated.

Aspen Plus uses the following material and energy balance equations:

Overall mass balance:

S Fi i i
i

NM

σ =
=
∑ 0

1

Substream mass balance for j=1 to NSS:
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Si Fi fiji

NM
=

=
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Component mass balance for k=1 to NC, j=1 to NSS:

S F f Zi i ij ijk
i

NM

=
=
∑ 0

1

Overall energy balance:

S F h S H S W RHSi i i i j j j k k k
k

NW

j
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i
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σ σ σ+ + =
===

∑∑∑
111

Where:

Si = +1 for inlet streams, -1 for outlet streams

σi = Stream scale factor

Fi = Mass flow of stream i

fij = Mass fraction of substream j in stream i

Zijk = Mass fraction of component k in substream j of stream i

NM = Number of combined inlet and outlet material streams

NH = Number of combined inlet and outlet heat streams

NW = Number of combined inlet and outlet work streams

NSS = Number of substreams within material streams

NC = Number of components specified on the Components
Specifications or  Components Comp-Group forms

hi = Mass enthalpy of stream i

Hj = Heat flow of heat stream j

Wk = Work of work stream k

RHS = Right-hand side of the energy balance equation

On the Equations sheet, you can specify additional material relationships, which
span components in various streams. This is useful for reactive systems. When
you specify additional relationships, Aspen Plus uses the following mole/mass
balance equations for the component mole/mass balance equation:
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Where:

Cij = Coefficient of Term j in equation i

Fij = Mole/mass flow Term j in equation i as determined by
Stream, Substream, and Component of the term

RHSi = Right-hand side of mole/mass equation i

NTi = Number of terms in mole/mass equation i

Example of Backward Calculations Using a Balance Block

This example shows how to do a mass-only calculation around a HeatX block.
The objective is to demonstrate the capability of a balance block to do backward
calculations.

Flow rates of the two outlet streams from HeatX are given. Flow rates of the two
inlet streams into HeatX need to be calculated. Both the inlet and the outlet
streams are specified, but the flow rates specified for the two inlets are just
dummy numbers.
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On the results form, the final values for the calculated variables and for the
balance equations are tabulated.

The final values for the calculated variables are found on the Calculated
Variables sheet. In this example, the mass flow of the two inlet streams, H2OIN
and MECHIN are calculated.
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The final values for the balance equations are found on the Equations sheet. The
number of equation in the problems is shown; here there are two mass balance
equations.

Example of Calculating a Coolant Flow Rate

Use a balance block to calculate the required flow rate of cooling water in order to
cool a stream of methanol from 150 F to 100 F.  A Balance block will eliminate
the need for a Design specification and a convergence loop.



Aspen Plus User Guide 25-11
Version 10.1-0

Chapter 25

MEOHIN

H2OOUT

MEOHOUT

H2OIN
Spec = 80 F

150 F, 14.7 PSI

50 F, 14.7 PSI

100 F, 14.7 PSI

Cold-Side

Hot-Side
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26 Case Study

This chapter includes information about:
• Using Case Study
• Creating a Case Study
• Identifying Case Study variables
• Specifying values for Case Study variables
• Specifying report options for Case Study

Using Case Study

After you run a base-case simulation, you may want to run several parametric
cases for the same flowsheet. You can use the Case Study tool to run multiple
simulation cases for the same flowsheet when you make batch runs. Case Study
will perform a flowsheet simulation for each case in a series. The Case Study block
does not affect the base-case simulation or the base-case report.

Aspen Plus generates a report for each case. You can tailor the case reports to
contain only those report sections of interest.

Aspen Plus ignores a Case Study block when you make interactive runs from the
user interface. See Chapter 11, Running Your Simulation for more information
on batch runs.

Creating a Case Study

To create a Case Study:
1. From the Data menu, point to Model Analysis Tools, then Case Study.



26-2 Aspen Plus User Guide
Version 10.1-0

Case Study

2. On the Case Study Setup Vary sheet, identify the variables you want to
change from case to case. See Identifying Case Study Variables, this chapter.

3. On the Case Study Setup Specifications sheet, specify values for the case
study variables for each case. See Specifying Values for Case Study Variables,
this chapter.

4. If you want to specify report options, use the Case Study ReportOptions form.
See Specifying Report Options for Case Studies, this chapter.

Identifying Case Study Variables

Use the Case Study Setup Vary sheet to identify flowsheet variables you want to
change from case to case. You can only change block input, process feed stream,
and other input variables. Result variables cannot be modified directly.

To identify the variables you want to change from case to case:
1. On the Case Study Setup form, select the Vary tab.

2. On the Variable Number field, click the down arrow and select <new> from
the list.

3. In the Manipulated Variable Type field, select a variable type.

4. Aspen Plus automatically shows the fields necessary to uniquely identify the
flowsheet variables. Complete the fields to define the variable. See Chapter
18, Accessing Flowsheet Variables, for more information on accessing
variables.

5. You have the option of labeling the variables for the report. Use the Report
Labels Line 1 to Line 4 fields to define these labels.

6. Repeat steps 2-5 until you have identified all case study variables.

Specifying Values for Case Study
Variables

Use the Case Study Setup Specifications sheet to specify values for the case study
variables.

To specify values for case study variables:
1. On the Case Study Setup form, select the Specifications tab.
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2. On the Case Number field, click the down arrow and select <new> from the
list.

3. In the New Item dialog box, enter an ID or accept the default ID. The ID must
be an integer.

4. In the Values for Manipulated Variable field, enter a value for each variable.
Enter multiple variable values in the same order as you identified them on
the Vary sheet.

5. To enter another case, repeat steps 2 and 3 until you have defined all the
cases you want to run.

On the Case Study Setup Specifications sheet, you can also:
• Reset convergence and unit operation restart flags for blocks
• Restore initial values for tear streams and feed streams
• Enter the case report description

Resetting Initial Values
Use the Case Study Setup Specifications sheet to reset convergence and unit
operation reinitialization options for blocks. You can also restore initial values for
tear streams, feed streams manipulated by design specifications, optimization
blocks, and Fortran blocks. By default, blocks or streams are not reinitialized. It
is usually most efficient to begin the calculation for a new case with the results of
the previous case.

To reinitialize blocks:
1. On the Case Study Setup form, select the Specifications tab.

2. In the Blocks to be Reinitialized field, select either Include Specified Blocks or
Reinitialize All Blocks.

3. If you choose Include Specified Blocks, select the unit operation blocks and/or
the convergence blocks to be reinitialized.

To reinitialize streams:
1. On the Case Study Setup form, select the Specifications tab.

2. In the Streams to be Reinitialized field, select either Include Specified
Streams or Reinitialize All Streams.

3. If you choose Include Specified Streams, select the streams to be reinitialized.
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Entering a Description
Use the Case Study Setup Specifications sheet to enter the case report
description, which will appear as a title in the case report.

To enter a case report description:
1. On the Case Study Setup form, select the Specifications tab.

2. Click the Description button.

3. Enter the description.

4. Click Close.

Specifying Report Options for Case
Studies

Use the Case Study ReportOptions form to specify which sections of the report to
include or suppress in the case reports. A separate report is generated for each case
and appended to the report file. If you specified report options for the base case on
the Setup ReportOptions form, and would like the same options for the case
reports, you must re-specify the report options on the Case Study ReportOptions
sheet.

Any options for Block reports which you specified for the base case on the Setup
ReportOptions Block sheet  or on the BlockOptions ReportOptions sheet for the
block also applies to the case reports.

The following table shows what you can specify and where:

To specify ReportOptions Sheet

Whether to generate a report file and which sections of the report to
include

General

Which flowsheet option reports to include in the report file Flowsheet

Which block reports to include in the report file Block

Which streams to include in the report file and the format for the
streams

Stream

Whether to generate additional stream reports, and if so the streams
to include in the report file and the format for the streams

Supplementary Stream

❖     ❖     ❖     ❖ 
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27 Specifying Reactions and
Chemistry

This chapter describes how to define reaction systems in Aspen Plus including:

• About Reactions and Chemistry
• About Electrolytes Chemistry
• Specifying Electrolytes Chemistry
• Specifying Power Law Reactions for Reactors and Pressure Relief Systems
• Reactions With Solids
• Specifying LHHW Reactions for Reactors and Pressure Relief Systems
• Specifying Reactions for Reactive Distillation
• Using a User Kinetic Subroutine

About Reactions and Chemistry

There are two types of reaction systems and Aspen Plus uses different methods for
simulating them:

Type of reaction system Description Use this Data Browser Form

Electrolytes solution chemistry Reactions involving the formation of
ionic species

Chemistry

Non-electrolyte reactions Rate-controlled or equilibrium limited.
For reactors and reactive distillation
modeling.

Reactions
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Reactions
Rate-controlled and non-electrolyte equilibrium reactions are specified as
Reaction IDs that can be referenced in kinetic reactors, columns, and pressure
relief calculations. These reactions can be used by:

• RadFrac, RateFrac, and BatchFrac for reactive distillation
• RBatch, RCSTR, and RPlug, the kinetics-based reactor models
• Pressure Relief model for pressure relief calculations in reactive systems

The reaction kinetics of rate-based reactions can be represented using any of the
following expressions:

• Power Law kinetic model
• Langmuir-Hinshelwood-Hougen-Watson (LHHW) kinetic model (not

applicable to reactive distillation systems)
• User-defined kinetic model

Chemistry
Electrolyte solution chemistry is specified as a Chemistry ID that can be
referenced on the Properties Specification Global sheet and on the BlockOptions
Properties sheets for individual unit operation blocks. Unlike non-electrolyte
reactions which are specified and executed only within certain unit operation
blocks and pressure relief calculations, electrolyte chemistry definitions become
part of the physical property specifications for a simulation or flowsheet section.
They are used for all calculations (in any stream or unit operation block ) which
use that property specification.

About Electrolytes Chemistry

In electrolyte systems, molecular species dissociate partially or completely in
solution and/or precipitate as salts. Examples include the following systems:

• Sour water (H2S-NH3-CO2-Water)
• Amines
• Acids (HCl-Water)
• Brine (NaCl-Water)
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Electrolyte systems are characterized by their base molecular components (the
apparent components), and by:

• Species resulting from dissociation and/or precipitation, such as ions and
salts

• Compounds formed through chemical reactions among the species

There are three types of electrolyte reactions:

Type Example

Partial dissociation equilibria † HCl + H2O ÍÎ H3O
+  +  Cl-

Salt precipitation equilibria † NaCl (Salt) ÍÎ Na+   + Cl-

Complete dissociation NaCl (liquid phase) Î Na+ + Cl-

†
Equilibrium constants are required to model these reactions. They can be calculated from correlations
(as a function of temperature) or from Gibbs free energy.

Collectively the species and reactions are referred to as the electrolytes
chemistry. Electrolytes chemistry must be modeled correctly for accurate
simulation results. Normally this requires expert knowledge of the solution
chemistry. In most cases, however, the Aspen Plus Electrolytes Wizard can
generate the species and reactions for you, using a built-in knowledge base of
reactions, equilibrium constant data, and possible ionic species. For more
information on the Electrolytes Wizard, see Chapter 6.

Specifying Electrolytes Chemistry

To specify the electrolytes chemistry for a simulation, you must:
1. Define the complete set of components present (including ions, salts, and

other species generated by reaction) on the Components Specification
Selection sheet.

2. Define the stoichiometry and reaction type, using the Reactions Chemistry
Stoichiometry sheet.

3. Specify the concentration basis, the temperature approach to equilibrium,
and coefficients for the equilibrium constant expression, using the Reactions
Chemistry EquilibriumConstants sheet.
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It is recommended that you use the Electrolytes Wizard to define both the
components and reactions. The Electrolytes Wizard:

• Uses a built-in knowledge base to generate the electrolyte components and
reactions

• Accesses the Aspen Plus electrolytes reaction database for equilibrium
constant data

For information on the Electrolytes Wizard, see Chapter 6.

You can define your own electrolyte chemistry, or you can view or modify the
chemistry generated by the Electrolytes Wizard.

To define, view, or modify electrolyte chemistry:
1. From the Data menu, point to Reactions then Chemistry.

2. To create a new Chemistry ID, click New on the Reactions Chemistry Object
Manager. Enter an ID in the Create new ID dialog box or accept the default
ID, and click OK.

3. To modify an existing Chemistry ID, select its name in the Object Manager
and choose Edit.

4. Follow the instructions in subsequent sections of this chapter for details on
defining each type of reaction within a Chemistry ID.

The following sections explain how to create new reactions within an existing
Chemistry ID, by specifying stoichiometry and calculations options for the
equilibrium constant. You can specify any number of reactions within a
Chemistry ID.

You also can have any number of Chemistry IDs in your simulation. Because the
Chemistry ID becomes part of the total Property Method definition, you can
specify different Chemistry IDs anywhere you use different Property Methods,
such as flowsheet sections or individual unit operation blocks. For more
information on specifying multiple Property Methods within a flowsheet, see
Chapter 7.

Defining Stoichiometry for Electrolytes Chemistry

Equilibrium Ionic Reactions

Equilibrium ionic reactions describe the partial dissociation of weak electrolytes
and other liquid phase equilibria. Each equilibrium ionic reaction within a
Chemistry ID is referenced with a reaction number (for example, 1, 2, 3, etc.)
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To define a new reaction number and specify the stoichiometry for an ionic
equilibrium reaction:
1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click

New.

2. On the Select Reaction Type dialog box, Equilibrium is the default reaction
type.  Enter an ID or accept the default ID and click OK.  The ID must be an
integer.

3. On the Equilibrium Reaction Stoichiometry dialog box, enter the components
and stoichiometric coefficients that make up your reaction. Coefficients
should be negative for reactants and positive for products.

4. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

5. Repeat steps 1-4 for each additional ionic equilibrium reaction.

Salt Precipitation Reactions

Salt precipitation reactions describe the formation or dissolution of salts in
equilibrium with the liquid phase. Each salt precipitation reaction within a
Chemistry ID is referenced by the component name of the salt.

To define the stoichiometry for a new salt precipitation reaction:
1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click

New.

2. On the Select Reaction Type dialog box, select Salt in the Choose Reaction
Type frame.

3. In the Enter Salt Component ID field, select the name of the salt for which
you are defining the reaction, and click OK.

4. On the Salt Dissolution Stoichiometry dialog box, enter the components and
stoichiometric coefficients for the products (ions) formed by the dissolution of
the salt.

5. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

6. Repeat steps 1-5 for each additional salt precipitation reaction.

Complete Dissociation Reactions

Complete dissociation reactions describe the complete dissociation of strong
electrolytes in the liquid phase. These reactions do not have equilibrium
constants. Each complete dissociation reaction within a Chemistry ID is
referenced by the name of the dissociating component.
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To define the stoichiometry for a new complete dissociation reaction:
1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click

New.

2. On the Select Reaction Type dialog box, select Dissociation in the Choose
Reaction Type frame.

3. In the Enter Dissociating Electrolyte field, select the name of the component
for which you are defining the reaction, and click OK.

4. On the Electrolyte Dissociation Stoichiometry dialog box, enter the
components and stoichiometric coefficients for the dissociation products.

5. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

6. Repeat steps 1-5 for each additional complete dissociation reaction.

Defining Equilibrium Constants for Electrolytes
Chemistry

Equilibrium constants are required to model equilibrium ionic reactions and salt
precipitation reactions. Aspen Plus can calculate these equilibrium constants from
correlations (as a function of temperature) or from reference state Gibbs free
energy (available in the Aspen Plus databanks).

To define how the equilibrium constants will be calculated for the equilibrium
ionic reactions and salt precipitation reactions within your Chemistry ID:
1. On the Reactions Chemistry form for your Chemistry ID, select the

Equilibrium Constants sheet.

2. Choose the concentration basis for equilibrium constants in the Concentration
Basis For Keq list. The concentration basis determines how the equilibrium
constant is calculated:

Concentration Basis Equilibrium Constant Definition †

Mole-Frac (default) K = Π(xi γi)
ν

I

Molal K = Π(mi γi)
ν

i

†   Where:
K = Equilibrium constant
x = Component mole fraction
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
ν = Stoichiometric coefficient
i = Component index
Π  is the product operator.

All properties refer to the liquid phase.
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3. You can specify a Temperature Approach to Equilibrium that applies to all
ionic equilibrium and salt precipitation reactions defined in the Chemistry
ID.  The temperature approach you specify is added to the stream or block
temperature to compute the equilibrium constants.  If you do not specify a
temperature approach, Aspen Plus uses a default value of 0.

4. Use the Hydrate-Check field to select the method that Aspen Plus uses to
determine which hydrate to precipitate when you have specified multiple
hydrates as precipitation reactions for a salt.

Hydrate-check Method Information

Rigorous (default) Uses Gibbs free energy minimization to select the hydrate.  Allows
Aspen Plus to predict the formation of the correct hydrate for salts with
multiple hydrates.

Approximate Uses the lowest solubility product value at the system temperature to select
the hydrate.  Requires less computation time than the rigorous method.

5. Select the appropriate reaction type (Equilibrium Reaction or Salt), and
choose the appropriate reaction from the list.

6. Leave the equilibrium coefficients blank.

– or –

Enter coefficients for the built-in equilibrium constant expression:
ln (Keq) = A + B / T + C*ln (T) + D*T

Where:

Keq = Equilibrium constant

T = Temperature in Kelvin

A, B, C, D = User supplied coefficients

The definition of K depends on the concentration basis selected.

If coefficients are not entered, Aspen Plus computes the equilibrium constant
from the reference state Gibbs free energies of formation.

Repeat steps 5 and 6 for all ionic equilibrium reactions and salt precipitation
reactions included in the Chemistry ID. Because complete dissociation reactions
do not have equilibrium constants, nothing on the Equilibrium Constants sheet
applies to reactions of this type.
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Specifying Power Law Reactions for
Reactors and Pressure Relief Systems

Powerlaw Reaction IDs can represent equilibrium reactions, or rate-controlled
reactions represented by the power law. To use a Powerlaw Reaction ID in the
Aspen Plus reactor models RCSTR, RPlug, and RBatch, or for the pressure relief
calculations in Pres-Relief, you need to:

• Define the type and stoichiometry of the reactions
• Enter equilibrium or kinetic parameters

RPlug, RBatch, and Pres-Relief can handle rate-controlled reactions. RCSTR can
handle both rate-controlled and equilibrium reactions.

To create a new Powerlaw Reaction ID:
1. From the Data menu, point to Reactions then Reactions.

2. To create a new Reaction ID, click New in the Reactions Object Manager.

3. In the Create New ID dialog box, enter a reaction ID in the Enter ID field, or
accept the default ID.

4. Select Powerlaw in the Select Type list, and click OK.

Once the Reaction ID is created, Aspen Plus brings you to the Stoichiometry
sheet where you can begin defining reactions within the Reaction ID. There
are two types of reactions allowed in a Powerlaw type Reaction ID.

Type For

Equilibrium Equilibrium reactions

Kinetic Rate-controlled reactions

 

5. To specify the individual reactions within your reaction ID, follow the
instructions in subsequent sections of this chapter for the type of reaction you
want to create.

Equilibrium Reactions (for RCSTR only)
To add equilibrium type reactions to your Powerlaw Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Powerlaw Reaction

ID.
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2. On the Edit Reaction dialog box, select Equilibrium from the Reaction Type
list. The reaction number is entered automatically.

3. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for equilibrium reactions.

4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional equilibrium reaction.

6. Select the Equilibrium tab on the Reactions form to open that sheet.

7. On the Equilibrium sheet, select a reaction from the list at the top of the
sheet.

8. Specify the phase in which the reaction will occur in the Reacting Phase list.
The default is the liquid phase.

9. If the reaction does not actually reach equilibrium, you can enter a
temperature approach to equilibrium in the Temperature Approach to
Equilibrium field. The number of degrees you enter will be added to the
reactor temperature to compute the equilibrium constant.

10. Choose whether you want to compute Keq from Gibbs energies or from a built
in polynomial expression by selecting the appropriate option.

If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute the Keq
from the reference state Gibbs free energy of the components.

11. If you choose Compute Keq From Built-In Expression, enter coefficients for
the built-in equilibrium constant expression, and choose a basis for the
equilibrium constant:

ln Keq = A + B/T + C*ln(T) + D*T

Where:

Keq = Equilibrium constant

T = Temperature in Kelvin

A, B, C, D = User-supplied coefficients
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The definition of Keq depends on the basis you select in the Keq Basis list.

Keq Basis Equilibrium Constant Definition†

Mole gamma (default) Keq = Π (xi γi)
υ

i  (liquid only)

Molal gamma Keq = Π (mi γi)
υ

i (electrolytes, liquid only)

Mole fraction Keq = Π (xi)
υ

i

Mass fraction Keq = Π (xi

m)υi

Molarity Keq = Π (Ci)
υ

i

Molality Keq = Π (mi)
υ

i (liquid only)

Fugacity Keq = Π (fi)
υ

i

Partial pressure Keq = Π (pi)
υ

i (vapor only)

Mass concentration Keq = Π (Ci

m)υi

 †  Where:
Keq= Equilibrium constant
x = Component mole fraction
xm = Component mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
f = Component fugacity (N/m2)
p = Partial pressure (N/m2)
Cm = Mass concentration (kg/m3)
υ = Stoichiometric coefficient (positive for products, negative for reactants)
i = Component index

 Π  is the product operator
 

12. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

13. Repeat steps 7 through 12 for each equilibrium reaction.

Rate-Controlled Reactions
To add kinetic type reactions to your Powerlaw Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Powerlaw Reaction

ID.

2. On the Edit Reaction dialog box, Reaction Type defaults to Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.
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3. Specify power law exponents for the components. These exponents represent
the order of the reaction with respect to each component. If you do not specify
an exponent for a component, Aspen Plus uses a default value of 0.

4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional kinetic reaction.

6. Select the Kinetic sheet.

7. On the Kinetic sheet, select a reaction from the list at the top of the sheet.

8. Specify in which phase the reaction will take place in the Reacting Phase
field. The default is the liquid phase.

9. Enter the pre-exponential factor (k), the temperature exponent (n), and the
activation energy (E) in the appropriate fields. The pre-exponential factor
must be in the SI units described later in this section. The temperature
exponent refers to temperature in Kelvin.

10. In the [Ci] Basis list, select the concentration basis. The concentration basis
determines which form of the power law expression will be used, as discussed
later in this section.

11. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

12. Repeat steps 7 through 11 for each kinetic reaction.

The power law expression depends on the concentration basis you select in the
[Ci] Basis list:

[Ci] Basis Power Law Expression†

(To is not specified)
Power Law Expression†

(To is specified)

Molarity (default) r = kTn e -E/RT Π (Ci)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (Ci)
α

i

Molality(electrolytes only) r = kTn e -E/RT Π (mi)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (mi)
α

i

Mole fraction r = kTn e -E/RT Π (xi)
α

I r = k (T/To)ne(-E/R)[1/T-1/To] Π (xi)
α

I

Mass fraction r = kTn e -E/RT Π (xi

m)αI r = k (T/To)ne(-E/R)[1/T-1/To] Π (xi

m)αI

Partial pressure(vapor only) r = kTn e -E/RT Π (pi)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (pi)
α

i

Mass concentration r = kTn e -E/RT Π (Ci

m)αI r = k (T/To)ne(-E/R)[1/T-1/To] Π (Ci

m)αI
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†
Where:
r = Rate of reaction
k = Pre-exponential factor
T = Temperature in degrees Kelvin
To = Reference temperature in degrees Kelvin
n = Temperature exponent
E = Activation energy
R = Universal gas law constant
x = Mole fraction
xm = Mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
Cm = Mass concentration (kg/m3)
p = Partial pressure (N/m2)
α = Concentration exponent
i = Component index
Π is the product operator.

The units of the reaction rate and the pre-exponential factor depend on the:

• Order of the reaction
• Concentration basis selected in the [Ci] Basis list box

The units for the pre-exponential factor are as follows:

When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)

Molarity

i

m

kgmole

m

kgmole

α∑








−

3

3sec

Molality

i

OHkg

gmole

m

kgmole

α∑







−

2

3sec

Mole fraction or Mass fraction

3sec m

kgmole

−

Continued

 
i

m

kgmole

m

Kkgmole n

α∑

−








−
−

3

3sec

 
i

OHkg

gmole

m

Kkgmole n

α∑

−








−
−

2

3sec

 
3sec m

Kkgmole n

−
− −
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When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)

Partial pressure

i

m

N

m

kgmole

α∑








−

2

3sec

Mass concentration

i

m

kg

m

kgmole

α∑








−

3

3sec

Reactions With Solids

When modeling reactive systems containing solids, there are many ways to account
for the effect of these solids in your simulation. Aspen Plus provides calculation
options to appropriately model the effect of your solids on the reaction
stoichiometry, the reaction rate, and volume basis for concentrations. The
information in this section is designed to help you specify Reaction IDs that most
accurately reflect your reactions.

Stoichiometry and Reaction Rate
When specifying a reaction on the Edit Reaction dialog box:

For Solids that Specify

Participate in reactions and control the
reaction rate.

Both stoichiometric coefficients and exponents.

Participate in reactions without controlling
the reaction rate.

Only the stoichiometric coefficients for these solids, without
entering exponents.

Act as  catalysts by controlling reaction
rates without participating in the reactions.

Only the exponents for these solids, without entering
stoichiometric coefficients.

Are inert.  Neither stoichiometric coefficients nor exponents.

 
i

m

kg

m

Kkgmole n

α∑

−








−
−

3

3sec

 
i

m

N

m

Kkgmole n

α∑

−








−
−

2

3sec



Aspen Plus User Guide 27-14
Version 10.1-0

Specifying
Reactions and
Chemistry

Volume Basis for Concentrations
When specifying information for the calculation of an equilibrium constant for
equilibrium reactions, or a reaction rate for kinetic reactions, solid components
can either be included or ignored in the denominator term of concentrations. To
control how these calculations are performed, use the Solids button on
Equilibrium sheet or the Kinetic sheet of your Reaction ID.

The Solids dialog box allows the following specifications with regard to the
denominator term of component concentrations:

• For liquid and vapor component concentrations, you can include the reacting
phase only, or the reacting phase and the solid phase, by clicking the
appropriate option in the For Liquid or Vapor Component frame. The default
is to include only the reacting phase.

• For solid component concentrations, you can include the solid phase only, or
the solid and total liquid phases, by clicking the appropriate option in the For
Solid Component frame. The default is to include only the solid phase.

• For wolid component concentrations, you can also include solid components in
all substreams, or only those in the substream of the reacting solid, by click
the appropriate option. The default is to include solids in all substreams.

Specifying LHHW Reactions for Reactors
and Pressure Relief Systems

To specify Langmuir-Hinshelwood-Hougen-Watson (LHHW) kinetics for the
reactor models RCSTR, RPlug, and RBatch, or for the pressure relief calculations
in Pres-Relief, you need to:

• Define the type and stoichiometry of the reactions
• Enter equilibrium or kinetic parameters
• Specify optional adsorption expressions

To specify LHHW reactions:
1. From the Data menu, point to Reactions, then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select LHHW in the Select Type list, and click OK.
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Once the Reaction ID is created, you can begin defining reactions within the
Reaction ID. There are two types of reactions allowed in a LHHW type
Reaction ID.

Type For

Equilibrium Equilibrium reactions

Kinetic Rate-controlled reactions

To specify the individual reactions within your LHHW Reaction ID, follow the
instructions in subsequent sections of this chapter for the type of reaction you
want to create.

Equilibrium Reactions for LHHW (for RCSTR only)
Specify equilibrium reactions for LHHW the same way as for Powerlaw
reactions. See Specifying Power Law Reactions for Reactors and Pressure Relief
Systems, this chapter.

Rate-Controlled Reactions for LHHW
For rate-controlled reactions, the LHHW rate expression can be written as:

γ =
( )kinetic factor)(driving force expression 

(adsorption expression)

Where:

Kinetic factor =
( )[ ]ToTRE

n

ae
To

T
k /1/1/ −−







Driving force expression = ( ) ( )ji v

j
v
i CKCK ∏−∏ 21

Adsorption expression = ( ){ }mv

ji
jCK ∏Σ
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Where:

r = Rate of reaction

k = Pre-exponential factor

T = Temperature in Kelvin

To = Reference temperature in Kelvin

n = Temperature exponent

Ea = Activation energy

R = Universal gas law constant

C = Component concentration

m = Adsorption expression exponent

K1, K2, Ki = Equilibrium constants

υ = Concentration exponent

i, j = Component index

Π is the product operator, and Σ is the summation operator.

The concentration terms Ci and Cj depend on the concentration basis you select:

[Ci] basis Concentration term C

Molarity Component molar concentration (kgmole/m3)

Molality Component molality (gmole/kg H2O)

Mole fraction Component mole fraction

Mass fraction Component mass fraction

Partial pressure Component partial pressure (N/m2)

Mass concentration Component mass concentration (kg/m3)

To add kinetic type reactions to your LHHW Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your LHHW Reaction ID.

2. On the Edit Reaction dialog box, Reaction Type defaults to Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.

3. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.
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4. Repeat steps 1 through 3 for each additional kinetic reaction.

5. Select the Kinetic sheet.

6. On the Kinetic sheet, select a reaction from the list at the top of the sheet.

7. Specify in which phase the reaction will take place using the Reacting Phase
list. The default is the liquid phase.

8. Enter the pre-exponential factor (k), the temperature exponent (n), and the
activation energy (E) in the appropriate fields of the Kinetic Factor frame.
The pre-exponential factor must be in the SI units described in Specifying
Power Law Reactions for Reactors and Pressure Relief Systems, this chapter.
The temperature exponent refers to temperature in Kelvin.

9. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

10. Click the Driving Force button.

11. On the Driving Force Expression dialog box, select the concentration basis in
the [Ci] Basis list. See Specifying Power Law Reactions for Reactors and
Pressure Relief Systems, this chapter, for the definitions of the concentration
basis options.

12. With the Enter Term value at the default of Term 1, enter the concentration
exponents for reactants and products, and the coefficients for the driving
force constant (A, B, C, and D) for term 1 of the driving force.

13. Select Term 2 in the Enter Term list.

14. Enter the concentration exponents for reactants and products, and the
coefficients for the driving force constant (A, B, C, and D) for term 2 of the
driving force expression.

15. Click Close when finished with both terms.

16. To specify optional adsorption expressions, click the Adsorption button.

17. On the Adsorption Expression dialog box, enter the overall exponent for the
adsorption term in the Adsorption Expression Exponent field.

18. Specify concentration exponents by selecting components and entering an
exponent for each term in the adsorption expression.

19. Specify adsorption constants by entering the Term No. and specifying the
coefficients.

The coefficients are for the following correlation:

ln Ki = Ai + Bi/T + Ci * ln(T) + Di * T
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Where:

Ki = Equilibrium constant

T = Temperature in Kelvin

Ai, Bi, Ci, Di = User-supplied coefficients

20. Repeat steps 6 through 19 for each additional LHHW kinetic reaction.

Specifying Reactions for Reactive
Distillation

To specify reactions for reactive distillation in the distillation models, RadFrac,
BatchFrac, and RateFrac, use the Reactions REAC-DIST forms to:

• Define reaction stoichiometry
• Enter equilibrium or kinetic parameters
• Specify parameters for user-defined kinetics

For RadFrac and RateFrac, you can also use the Reactions User forms to specify
user-defined kinetics (see Using a User-Kinetics Subroutine, this chapter). The
Reactions User forms is preferred because you can use the same user-defined
kinetics in reactor or pressure relief calculations.

To create a new distillation reaction ID:
1. From the Data menu, point to Reactions then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select REAC-DIST in the Select Type list, and click OK.

Once the Reaction ID is created, you can begin defining reactions within the
Reaction ID. There are four types of reactions allowed in a Reac-Dist Reaction
ID.
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Type For

Equilibrium Equilibrium  reactions

Kinetic Rate-controlled reaction

Conversion Fractional conversion reaction (RadFrac only)

Salt Electrolyte salt precipitation (RadFrac only)

5. To specify the individual reactions within your Reac-Dist reaction ID, follow
the instructions in subsequent sections of this chapter for the type of
reactions listed in the previous table.

Equilibrium Reactions
To add equilibrium type reactions to your Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction

ID.

2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type. Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, Reaction Type defaults to Equilibrium.
Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for equilibrium reactions.

4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional equilibrium reaction.

6. Click the Equilibrium sheet.

7. On the Equilibrium sheet, select a reaction from the list at the top of the
sheet.

8. Specify the phase in which the reaction will occur in the Reacting Phase list.
The default is the liquid phase.

9. Specify a calculation basis for the equilibrium constant by selecting an option
in the Keq Basis list. The basis you choose defines how the equilibrium
constant will be calculated, as discussed later in this section.

10. If the reaction does not actually reach equilibrium, you can specify
Temperature Approach to Equilibrium. The temperature approach you enter
will be added to the stage temperature to compute the equilibrium constant.
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11. Choose whether you want to compute Keq from Gibbs energies or from a built
in polynomial expression by selecting the appropriate radio button.

If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute Keq from
the reference state Gibbs free energy of the components. You can skip to step
12.

12. If you choose Compute Keq From Built-In Expression, you must enter
coefficients for the built-in equilibrium constant expression:

ln Keq = A + B/T + C*ln(T) + D*T

Where:

Keq = Equilibrium constant

T = Temperature in Kelvin

A, B, C, D = User-supplied coefficients

The definition of Keq depends on the basis you select in the Keq Basis list
box.

Kbasis Equilibrium Constant Definition†

Mole gamma (default) K=Π (xi γi)
υ

i  (liquid only)

Molal gamma K=Π (mi γi)
υ

i (electrolytes, liquid only)

Mole fraction K=Π (xi)
υ

i

Mass fraction K=Π (xi

m)υi

Molarity K=Π (Ci)
υ

i

Molality K=Π (mi)
υ

i (liquid only)

Fugacity K=Π (fi)
υ

i

Partial pressure K=Π (pi)
υ

i (vapor only)

Mass concentration K=Π (Ci

m)υi
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 †  Where:
K = Equilibrium constant
x = Component mole fraction
xm = Component mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
f = Component fugacity (N/m2)
p = Partial pressure (N/m2)
Cm = Mass concentration (kg/m3)
υ = Stoichiometric coefficient (positive for products, negative for reactants)
i = Component index
Π = Product operator

All properties refer to the phase selected in the Reacting Phase field.

13. Repeat steps 7 through 12 for each equilibrium reaction.

Rate Controlled Reactions
Reactive distillation kinetics can be represented with a built-in Power Law
expression, or a user kinetics subroutine. The following procedure shows how to
use either method.

To add kinetic type reactions to your Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction

ID.

2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type.  Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, select Kinetic from the Reaction Type list.

4. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products.

5. Specify Power Law exponents for each component. These exponents represent
the order of the reaction with respect to each component. If you wish to
specify a user kinetics subroutine to compute the reaction rates, do not enter
exponents on this sheet.

6. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

7. Repeat steps 1 through 6 for each additional kinetic reaction.

8. Select the Kinetic sheet.

9. On the Kinetic sheet, select the appropriate option to use the built-in Power
Law expression, or a user kinetic subroutine to represent the kinetics for the
current Reaction ID.
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10. Select a reaction from the list and specify in which phase the reaction will
take place using the Reacting Phase list. The default reacting phase is liquid.

11. To use a user kinetics subroutine, you do not need to enter any further
information on this sheet. Select the Subroutine tab of the reaction form, and
specify the subroutine name in the Name field.

For RadFrac and RateFrac, you can also specify user-defined kinetics on the
Reactions User forms (see Using a User-Kinetics Subroutine, this chapter).
The Reactions User forms is preferred because you can use the same user-
defined kinetics in reactor or pressure relief calculations. For more
information on using and writing user kinetics models, see Aspen Plus User
Models.

The rest of this procedure assumes you are using the built in Power Law.

12. To use the built-in Power Law expression, enter the pre-exponential factor
(k), the temperature exponent (n), and the activation energy (E) on the
Kinetic sheet of the Reactions form. The pre-exponential factor must be in the
SI units described later in this section.  The temperature exponent refers to
temperature in Kelvin.

13. In the [Ci] Basis list, select the concentration basis. The concentration basis
determines which form of the power law expression will be used, as discussed
later in this section.

14. Repeat steps 10 through 13 for each kinetic reaction.

The power law expression depends on the concentration basis you select in the
[Ci] Basis list box:
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[Ci] Basis Power Law Expression†

(To is not specified)
Power Law Expression†

(To is specified)

Molarity (default) r = kTn e -E/RT Π (Ci)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (Ci)
α

i

Molality (electrolytes only) r = kTn e -E/RT Π (mi)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (mi)
α

i

Mole fraction r = kTn e -E/RT Π (xi)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (xi)
α

I

Mass fraction r = kTn e -E/RT Π (xi

m)αi r = k (T/To)ne(-E/R)[1/T-1/To] Π (xi

m)αI

Partial pressure (vapor only) r = kTn e -E/RT Π (pi)
α

i r = k (T/To)ne(-E/R)[1/T-1/To] Π (pi)
α

i

Mass concentration r = kTn e -E/RT Π (Ci

m)αi r = k (T/To)ne(-E/R)[1/T-1/To] Π (Ci

m)αI

† Where:
r = Rate of reaction
k = Pre-exponential factor
T = Temperature in degrees Kelvin
To = Reference temperature in degrees Kelvin
n = Temperature exponent
E = Activation energy
R = Universal gas law constant
x = Mole fraction
xm = Mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
Cm = Mass concentration (kg/m3)
p = Partial pressure (N/m2)
α = Concentration exponent
i = Component index
Π is the product operator.

The units of the reaction rate and the pre-exponential factor depend on the:

• Order of the reaction
• Holdup basis used by the distillation block
• Concentration basis selected in the [Ci] Basis list box

The units for the pre-exponential factor are as follows:

When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)

Molarity

i

m

kgmole

unitholdup

kgmole

α∑







−

3

)(sec

Continued

i

m

kgmole

unitholdup

Kkgmole n

α∑

−








−
−

3

)(sec
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When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)

Molality

i

OHkg

gmole

unitholdup

kgmole

α∑







−

2

)(sec

Mole fraction or Mass fraction

)(sec unitholdup

kgmole

−

Partial pressure

i

m

N

unitholdup

kgmole

α∑








−

2

)(sec

Mass concentration

i

m

kg

unitholdup

kgmole

α∑








−

3

)(sec

Where holdup unit is When this is specified in the distillation block that uses the reactions

kgmole Mole holdup or residence time

kg Mass holdup

m3 Volume holdup

Fractional Conversion Reactions (for RadFrac only)
Another way to define reactions in a distillation column is to calculate a
conversion based on a built-in, temperature-dependent correlation.

To add conversion type reactions to your Reac-Dist Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction

ID.

)(sec unitholdup

Kkgmole n

−
− −

i

OHkg

gmole

unitholdup

Kkgmole n

α∑

−








−
−

2

)(sec

i

m

N

unitholdup

Kkgmole n

α∑

−








−
−

2

)(sec

i

m
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unitholdup
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−







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2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type.  Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, select Conversion from the Reaction Type
list.

4. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for conversion reactions.

5. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

6. Repeat steps 1 through 5 for each additional conversion reaction.

7. Select the Conversion sheet.

8. If you have multiple conversion reactions within your Reaction ID, specify
whether you want the conversion reactions to be computed simultaneously, or
in series. By default, conversion reactions are assumed to occur
simultaneously. If you want the conversions to be calculated in series, check
the Reactions Occur in Series box. You must specify the same type for all
conversion reactions. Series reactions take place in the order they are entered.

9.  Select a reaction from the list.

10. In the Conversion Expression frame, select the component on which you will
base the conversion of the selected reaction, in the Key Component list.
Conversion is defined as the fractional conversion of the key component.

11. Enter the coefficients (A, B, C and D) for the fractional conversion correlation:

Conv = A +  B/T + C*ln(T) + D*T

You can also enter the conversion on the RadFrac Reactions Conversion
sheet, to override the value computed from the conversion correlation.

Salt Precipitation Reactions (for RadFrac only)
In addition to liquid and vapor phase reactions, you also can specify salt
precipitation reactions. These reactions are liquid/solid phase equilibrium
reactions, where the solid phase consists of a single salt.

To add salt precipitation type reactions to your Reac-Dist Reaction ID:
1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction

ID.

2. On the Select Reaction Type dialog box, select Salt Precipitation in the
Choose Reaction Type frame.
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3. Select the component name of the salt in the Precipitating Salt list, and click
OK.

4. On the Edit Salt dialog box, enter components and stoichiometric coefficients
for the salt dissociation products.

5. Click Close when finished. You should see the new reaction displayed on the
Stoichiometry sheet referenced by the component name of the salt.

6. Repeat steps 1 through 5 for each additional salt precipitation reaction.

7. Select the Salt sheet.

8. On the Salt sheet, select a salt from the Salt list.

9. If the reaction does not actually reach equilibrium, you can specify the
Temperature Approach to Equilibrium. The temperature approach you enter
will be added to the stage temperature to compute the equilibrium constant.

10. Choose whether you want to compute the equilibrium constant (solubility
product) from Gibbs energies or from a built in polynomial expression by
selecting the appropriate radio button.

If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute Keq from
the reference state Gibbs free energies of the components.

11. If you choose Compute Keq From Built-In Expression, you need to enter
coefficients for the built-in equilibrium constant expression, and choose a
concentration basis for the equilibrium constant in the Keq Basis field.

The expression and equilibrium constant definitions are the same as for fluid
phase equilibrium reactions. For more information, see Equilibrium Reactions,
this chapter.

If no rate-controlled or fractional conversion fluid-phase reactions are present, it
is recommended that you specify salt precipitation reactions as electrolyte
chemistry reactions. The advantages are that Electrolyte Chemistry:

• Can be generated automatically by the Electrolytes Wizard
• Accesses the Aspen Plus electrolytes reaction database for equilibrium

constant data

See Specifying Electrolytes Chemistry, this chapter.
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Using a User-Kinetics Subroutine
To use a user-supplied kinetics subroutine to calculate reaction rates, you need to
specify the Fortran subroutine name. Use the Reactions User forms to specify
user-defined kinetics for:

• Reactor models (RCSTR, RPlug, and RBatch)
• Distillation models (RadFrac and RateFrac)
• Pressure relief calculations in Pres-Relief

For RadFrac and RateFrac, you can also use the Reactions Reac-Dist forms to
specify user-defined kinetics (see Specifying Reactions for Reactive Distillation,
this chapter). You can define equilibrium reactions to be solved simultaneously
with rate-controlled reactions. Only RCSTR, RadFrac and RateFrac can handle
equilibrium reactions.

To specify a user Fortran subroutine for reaction rates:
1. From the Data menu, point to Reactions then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select User in the Select Type list, and click OK.

5. On the Reactions Stoichiometry sheet click New.

6. On the Edit Reaction dialog box, the default reaction type is Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.

7. Click Close when finished. You should see your new reaction displayed on the
Stoichiometry sheet.

8. Repeat steps 7 through 9 for each additional user kinetic reaction.

9. Select the Kinetic sheet.

10. On the Kinetic sheet, select a reaction from the list and specify in which
phase the reaction will take place using the Reacting Phase list. The default
is the liquid phase.

11. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. See Reactions With Solids, this chapter for
details.

12. Select the Subroutine sheet.

13. On the Subroutine sheet, enter the name of the user subroutine, in the Name
field. For more information on using and writing user kinetics models, see
Aspen Plus User Models.
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For any equilibrium reactions within a User type Reaction ID, specify them
as you would for equilibrium reactions within a Powerlaw Reaction ID. For
details, see Specifying Power Law Reactions for Reactors and Pressure Relief
Systems, this chapter.

❖     ❖     ❖     ❖ 
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28 Property Sets

This chapter describes:
• What is a property set?
• How to specify a new or existing property set
• How to specify user properties for use in property sets
• Examples

About Property Sets
A property set is a collection of thermodynamic, transport, and other properties
that you can use in:
• Stream reports
• Physical property tables and Analysis
• Unit operation model heating/cooling curve reports
• Distillation column stage property reports and performance specifications
• Reactor profiles
• Design specifications and constraints
• Fortran and sensitivity blocks
• Optimization and Data-Fit blocks

Aspen Plus has several built-in property sets that are sufficient for many
applications. The list of built-in property sets is determined by the Template you
choose when creating a new run. For more information on Templates,see Chapter
2.

You can use a built-in property set and modify it to fit your needs, or you can
create your own property sets. To see the built-in sets available or select one, use
the drop-down list on any property set list box. The list prompts describe the
contents of each built-in property set.
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Defining a Property Set

To define a property set:
1. From the Data menu, click Properties.

2. Double-click on the Prop-Sets folder in the left pane of the Data Browser.

3. To create a new property set, click New. In the Create New ID dialog box,
enter a new property set ID or accept the default ID, and click OK.

4. Once the new property set has been created, to modify it (or any existing
property set), select the name from the Object Manager and click Edit.

On the Properties sheet of the Prop-Sets form, you can select properties from the
drop-down list in the Physical Properties field. Choose one or more properties to
be included in your property set. When you make a selection, a prompt appears
for each property.

Tip  Use the Search button to find the properties you want included in the
property set. For information on using the search dialog box see Using the Search
Dialog Box, this chapter.
5. Select one or more units for the property, using the Units fields.

If you select multiple units the property is reported in each of the units
selected.

6. On the Prop-Sets Qualifiers sheet, specify the following qualifiers for the
properties to be calculated:

• Phase (total mixture, total liquid, vapor, 1st or 2nd liquid, and solid)
• Components
• 2nd liquid key components (key component to identify the 2nd liquid

phase)
• Temperature
• Pressure
• Percent distilled(points on petroleum distillation curves)
• Water basis (wet or dry)
Some qualifiers, such as temperature and pressure are optional. For more
information, see Aspen Plus Physical Property Data, Chapter 4.

When you select multiple units and qualifiers, Aspen Plus computes the
properties for each units specification and each valid combination of qualifiers.
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Using the Search Dialog Box
If you want to search for a property by its common name, click the Search button
on the Prop-Sets Properties sheet. A dialog box appears where you can type the
name or a fragment of the name of the property you want. To add a property to
your property set, select the property you desire and click Add. Once you have
added all the properties you want, click OK to return to the Prop-Sets form.

Example of Using Search to Find Properties

Searching for the word “viscosity” shows a number of properties. Kinematic
viscosity has been selected and added to the property set.
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Specifying Phase Qualifiers
The default for phase is Total. If a property cannot accept Total phase as a
qualifier, you must enter an appropriate alternative (Liquid, Vapor, 1st liquid, 2nd

liquid, or Solid).

The phases you select should be consistent with the type of calculation desired.
For example, if you request 1st and 2nd liquid phase properties for a
heating/cooling curve for a Heater block, the block should perform either rigorous
three-phase or free-water calculations.

Specifying Temperature and Pressure Qualifiers
By default, Aspen Plus calculates properties at the stream conditions.
Alternatively, you can specify the temperature and pressure for property
calculations in the Temperature and Pressure fields of the Prop-Sets Qualifiers
sheet. These specifications do not affect the composition of vapor and liquid
phases, which are determined at the stream temperature and pressure.
Aspen Plus determines the units for the Temperature and Pressure specifications
from the Units-Set you specify.

Example of Property Set for Reporting Enthalpy

Define a property set consisting of the pure component liquid and vapor
enthalpies (H) of components C1, C2, and C3, as well as the mixture enthalpies
(HMX) for the vapor and liquid phases. HMX is calculated on both a mole and
mass basis.



Aspen Plus User Guide 28-5
Version 10.1-0

Chapter 28



28-6 Aspen Plus User Guide
Version 10.1-0

Property Sets

Example of Property Set for Activity Coefficients Over a Temperature
Range

Define a property set consisting of the activity coefficients for components C1 and
C2 in the liquid phase. The activity coefficients are evaluated at 100, 200, and
300°F.

The units for the temperatures entered will be the temperature units of the ENG
Units-Set, °F.
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User Defined Properties

You can define your own properties for use in property sets. You must supply a
Fortran subroutine to calculate each property. See Aspen Plus User Models for
more information about user subroutines.

To define an additional property for use in property sets:
1. From the Data menu, click Properties.

2. Open the Advanced folder by double-clicking on it in the left pane of the Data
Browser.

3. Select UserProperties.

4. On the UserProperties Object Manager, click New.

5. Enter a user property ID or accept the default ID, and click OK

6. On the Specifications sheet, select whether your user property will be a
standard property or an Assay curve property.

7. For standard properties, enter the name of the subroutine to be used for
calculating the property, in the User Subroutine Name field.

8. Use the remaining fields on the Specifications sheet to enter information
about the property.

9. On the Units sheet, specify whether you want any units conversion to be
performed automatically by Aspen Plus, or within your user subroutine.

❖     ❖     ❖     ❖ 
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29 Analyzing Properties

After you complete property specifications, you should analyze the properties
predicted by your model to ensure correct results. You can do this using the
Aspen Plus Property Analysis feature. Property Analysis generates tables of
physical property values, which can be plotted to visualize and better understand
the behavior of properties as predicted by your property specifications.

You can access Property Analysis via the following methods:

• Many commonly used tables and plots can be generated quickly and easily
through an interactive method accessed from the Tools menu.

• Alternatively, generating Property Analyses from the Properties Analysis
folder in the Data Browser Menu provides the most flexibility.

This chapter discusses each method of using the Property Analysis features and
includes several examples.

Topics include:

• About Property Analysis
• Generating Property Analyses Interactively

• Pure component properties
• Properties for binary systems
• Residue curves
• Stream properties

• Generating Property Analyses Using Forms
• Pure
• Generic
• Binary
• PT-Envelopes
• Residue curves

• Property Method Specifications for Property Analysis
• Examining Analysis Results
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About Property Analysis

The Property Analysis feature generates tables of properties from variations in:

• Temperature
• Pressure
• Vapor fraction
• Heat duty
• Composition

The tables include property values that are defined using Property Sets, and can
consist of thermodynamic, transport, and other derived properties. For more
information on Property Sets and the properties they can include, see chapters 7
and 28.

You can use Property Analysis:

• On a standalone basis
• In a Flowsheet run
• In a Data Regression run

To use Property Analysis on a standalone basis, specify Property Analysis in the
Run Type list on the Setup Specifications Global sheet. Or if you are creating a
new run, specify Property Analysis in the Run Type list of the New dialog box.

Generating Property Analyses
Interactively

This section describes how to generate many common analyses interactively,
using the Analysis commands from the Tools menu.

This method automates many of the steps required to generate a Property
Analysis, and defines built-in plots that provide quick and easy access to
commonly used information.

If the information you require can be generated from the interactive Analysis
commands, this is always quicker and easier than creating the Analysis using
forms.

If you require property information that is not available from the interactive
Analysis commands, you should create the Analysis manually using forms. See
subsequent sections of this chapter for details on creating Analyses manually
using forms.
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You can use the interactive Analysis commands at any time after you complete
the properties specifications.

The interactive Analysis commands can generate:

• Pure component properties
• Properties for binary systems
• Residue maps for ternary systems
• Stream properties. To generate stream properties, you must define at least

one material stream.

Pure Component Properties
Use the interactive Analysis Pure commands to calculate and display pure
component properties as a function of temperature to:

• Check pure component data and parameter values
• Compare properties for components that belong to the same family. Family

plots can reveal incorrect trends.
• Determine whether the property is extrapolated correctly when temperatures

are outside correlation limits

To generate pure component properties as a function of temperature, using the
interactive Analysis Pure commands:
1. Ensure your Setup, Components, and Properties specifications are complete.

2. From the Tools menu, click Analysis, then Property, then Pure.

On the Pure Component Properties Analysis dialog box, most of the required
information is set to defaults, including:

Item Information

Property Method The global property method is used, as specified on the Properties
Specifications Global sheet. You can select any Property Method that
appears on the Properties Specifications form.

Temperature The default is a temperature range from 0 to 25°C. You can enter a new
range by modifying the lower and upper temperatures, or you can change
from a temperature range to a temperature list, and specify a list of discreet
temperature values.

Number of points to be tabulated The default is 41 points. You can change the number of points, or enter a
temperature increment.

Pressure The default is 1 atm. You must change the default for vapor properties, for liquid
properties near the critical point., and properties generated from EOS property
methods.
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3. From the Property list box, select the property to be tabulated.

The Property list box displays the properties of the type shown in the
Property Type list box.

To focus your search for a property, you can change the property type to
Thermodynamic or Transport. To see a list of all available properties, change
the property type to All.

This table shows the available thermodynamic properties:

Property Property

Availability Free energy

Constant pressure heat capacity Enthalpy

Heat capacity ratio Fugacity coefficient

Constant volume heat capacity Fugacity coefficient pressure correction

Free energy departure Vapor pressure†

Free energy departure pressure correction Density

Enthalpy departure Entropy

Enthalpy departure pressure correction Volume

Enthalpy of vaporization† Sonic velocity

Entropy departure

†
Ideal and activity coefficient property methods only

This table shows the available transport properties:

Property Property

Thermal conductivity Surface tension

Viscosity

Optionally you can specify the units for the selected property in the Units list.
If you do not specify the units, they will be determined by the output results
Units-set specified on the Setup Specifications Global sheet.

4. Select the phase(s) for which you want the property to be reported, by clicking
one or more of the Phase check boxes: Vapor, Liquid or Solid. Liquid is the
default. Not all phases are valid for all properties. For a list of valid phases
for each property, see Aspen Plus Physical Property Data, chapter 4.

5. Choose components by selecting one or more from the Available Components
list, and clicking the right arrow button to move them to the Selected
Components list.
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6. When finished, click Go to generate the results.

– or –

Click Save As Form to save the interactive Property Analysis you have
created to forms within the Properties Analysis section of the Data Browser
menu. Saving an interactive Property Analysis as forms, allows you to
preserve the input and results of this Property Analysis to view or modify at a
later time. For more information on using forms to create Property Analyses,
see Creating A Property Analysis, this chapter.

Aspen Plus calculates the property at the temperature values you specify.
Results appear in a form window and a plot. The plot displays results for all
components you select.

Example of Examining Component Vapor Pressures

Calculate and display the vapor pressures of CCL4, CH2CL2, and CHCL3, between
50 and 200°F, using the IDEAL Property Method. To do this:
1. From the Tools menu, point to Analysis, then Property, then Pure.

2. The Pure Component Properties Analysis dialog box appears.
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3. When you have finished choosing your components, click Go to generate the
results.

Tabular results form:

Plotted results:
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Properties for Binary Systems
You can generate common phase diagrams for binary systems to:

• Check the validity of data and parameter values
• Assess the degree of nonideality
• Check for existence of azeotropes
• Check for existence of two liquid phases
• Check quality of extrapolation of the model

To generate properties for binary systems use the Analysis Binary commands. To
do this:
1. Ensure your Setup, Components, and Properties specifications are complete.

2. From the Tools menu, click Analysis, then Property, then Binary.

3. On the Binary Analysis dialog box, choose the type of Analysis in the Analysis
Type list box:

Use analysis type To tabulate

Txy Temperature (T) versus liquid (x) and vapor (y) compositions at given
pressures

Pxy Pressure (P) versus liquid (x) and vapor (y) compositions at given
temperatures

Gibbs energy of mixing Gibbs energy of mixing versus liquid compositions at given temperatures and
pressures. Used to detect the formation of two liquid phases.

For all three types of Binary Analysis, you can accept the default settings or
specify the following information:

Item Information

Components Two are required. Use the Component 1 and Component
2 lists to choose the pair of components you wish to study.
Only conventional components that are not solids or ions
are allowed. Defaults are the first two conventional
components listed on the Components Specifications
Selection sheet.

Composition basis - Mole fraction or mass fraction The default is mole fraction.

Composition component This designates which component’s composition is varied
to generate the results. The default is the component
selected as Component 1.

Continued
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Item Information

Composition - range or list To determine at what compositions Aspen Plus will
perform its calculations, you can specify a composition
range or a composition list. The default is the full
composition range between pure component 1 and pure
component 2. You can either modify the default
composition range, or change to a composition list, and
specify a list of discreet compositions.

Number of points to generate The default is 41 points. You can modify the number of
points, or specify an increment of composition. Note that
this only applies when using a composition range.

Property Method, Henry Components, Chemistry ID, and
simulation approach

Defaults are obtained from the Properties Specifications
Global sheet. For electrolyte systems, you should use the
apparent components approach.

The remaining specifications for an interactive Binary Analysis depend on the
Analysis type. The following sections provide instructions for specifying each type of
Analysis.

Completing the Specifications for Txy Binary Analysis

To complete the specifications for a Txy type Binary Analysis, you can either
modify the following specifications or accept the defaults.

For You can specify The default is

Valid Phases Rigorous Vapor-Liquid, Vapor-Liquid-
Liquid, or Vapor-Liquid-FreeWater
calculations

Vapor-Liquid

Pressure(s) You may specify a single pressure, or
multiple pressures by entering a list of
values, or by giving a range of values.
If you choose to specify a range of
values, you must enter number of
points or an increment size.

A single pressure of 1 atm

When finished, you can simply click the Go button to generate the Txy diagram,
or you can first click the Save As Form button to save the interactive Property
Analysis you have created, to forms within the Properties Analysis section of the
Data Browser menu.

Saving an interactive Property Analysis as forms allows you to preserve the
input and results of this Property Analysis to view or modify at a later time. For
more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, later this chapter.
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Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one pressure, Txy diagrams for all the pressures appear on
a single plot. In addition to the Txy diagram, you can display other plots from the
Txy analysis results using the Plot Wizard. The following plots are available:

Type of Plot Description

TXY Temperature versus liquid and vapor composition

TX Temperature versus liquid composition

YX Vapor versus liquid composition

Gamma Liquid activity coefficients of both components versus liquid composition

KVL K-values of both components versus liquid composition

Displaying Txy Plots

To display these plots:
1. On the Binary Analysis Results window containing the tabular data, click the

Plot Wizard button. The results window is behind the plot window.

2. On the Plot Wizard Step 1 window, click Next.

3. On the Plot Wizard Step 2 window, click the plot type you want.

4. To accept default plot settings, click Finish to generate the plot. Otherwise,
click Next to enter additional settings and follow the remaining steps.

5. On the Plot Wizard Step 3 window, in the Component to Plot list box choose a
component for which compositions will be displayed. If applicable, specify
units for the plot variables.

6. Click Finish to accept defaults for the remaining plot settings and generate
the plot.

– or –

Click Next to enter additional settings.

7. On the Plot Wizard Step 4 window, you can modify the defaults for plot title,
axis titles, display options, grid or line type. You can also specify whether you
want the plot to be automatically updated when new results are available.

8. Click Finish to generate the plot.
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Example of Generating Txy Curves

Generate Txy curves at 1 atm and 2 atm for a mixture of HNO3 and water, using the
ELECNRTL property method and GLOBAL solution chemistry.
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Tabular results form:

Plotted results:
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Completing the Specifications for Pxy Binary Analysis

To complete the specifications for a Pxy type Binary Analysis, you can either
modify the following specifications or accept the defaults:

For You can specify The default is

Valid Phases Rigorous Vapor-Liquid, Vapor-Liquid-
Liquid, or Vapor-Liquid-FreeWater
calculations

Vapor-Liquid

Temperature(s) More than one temperature by entering
a list of values, or by giving a range of
values.

If you choose to specify a range of
values, you must enter number of
points or an increment size.

A single temperature of 25°C

When finished, click Go to generate the Pxy diagram, or click Save As Form to
save the interactive Property Analysis to forms within the Data Browser.

Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.

For more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one temperature, Pxy diagrams for all the temperatures
appear on a single plot.

In addition to the Pxy diagram, you can display other plots from the Pxy analysis
results using the Plot Wizard. The following plots are available:

Type of Plot Description

PXY Pressure versus liquid and vapor composition

PX Pressure versus liquid composition

YX Vapor versus liquid composition

Gamma Liquid activity coefficients of both components versus liquid composition

KVL K-values of both components versus liquid composition
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Displaying Pxy Plots

To display Pxy plots:
1. On the Binary Analysis Results window containing the tabular data, click the

Plot Wizard button. The results window is behind the plot window.

2. On the Plot Wizard Step 1 window, click Next.

3. On the Plot Wizard Step 2 window, click the plot type you want.

4. To accept default plot settings, click Finish to generate the plot. Otherwise,
click Next to enter additional settings.

5. On the Plot Wizard window, in the Component to Plot list box choose a
component for which compositions will be displayed. If applicable, specify
units for the resulting plot.

6. Click Finish to accept defaults for the remaining plot settings and generate
the plot.

– or –

Click Next to enter additional settings.

7. On the Plot Wizard Step 4 window, you can modify the defaults for plot title,
axis titles, display options, grid type or marker size. You can also specify
whether you want the plot to be automatically updated when new results are
available.

8. Click Finish to generate the plot.

Completing the Specifications for Gibbs Energy of
Mixing

To complete the specifications for a Gibbs Energy of Mixing type Binary Analysis,
you can either modify the following specifications or accept the defaults.

Item Information

Units of Gibbs energy If you do not specify the units, they will be determined by the Units-set specified on the Setup
Specifications Global sheet.

Pressure The default is 1 atm

Temperature(s) The default is 25°C. You can specify more than one temperature, by entering a list of
temperatures, or you can specify a range of temperatures and a number of points or an
increment size.

When finished, click Go to generate the Gibbs energy of mixing versus x diagram,
or click Save As Form to save your interactive Property Analysis to forms within
the Data Browser.
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Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.

For more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one temperature, Gibbs energy of mixing diagrams for all
the temperatures appear on a single plot.

Example of Generating Gibbs Energy of Mixing

Generate a Gibbs Energy of Mixing diagram for methanol-cyclohexane at 25°C,
using the UNIF-LL property method.
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Tabular results form:

Plotted results:
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Residue Curves
Residue Curves (or maps) plot the composition trajectories of a ternary mixture
undergoing distillation at total reflux. You can use them to visualize the presence
of azeotropes and the constraints azeotropes impose on the degree of separation.

Use Residue Curves to predict feasible splits, select entrainers, and analyze
potential column operability problems.

Use Residue Curves with nonideal chemical systems, and property methods that
represent such systems. Examples are activity-coefficient-based property
methods, such as NRTL, Wilson, UNIQUAC, and UNIFAC. Do not use electrolyte
property methods.

Generating Residue Curves

To generate Residue Curves using the interactive Analysis Residue commands:
1. Make sure your Setup, Components, and Properties specifications are

complete.

2. From the Tools menu, point to Analysis, then Property, then Residue.

3. On the Residue Curves dialog box, Aspen Plus fills in defaults for all the
required information. You can accept the defaults, or make changes to any of
the following information:

Item Information

Components Three are required. Use the Component 1, Component 2, and
Component 3 lists to choose the three components you wish to
study. Only conventional components that are not solids or ions
are allowed. Defaults are the first three conventional components
listed on the Components Specifications Selection sheet.

Pressure The default is 1 atm

Valid Phases You can specify rigorous two phase (Vapor-Liquid) or three phase
(Vapor-Liquid-Liquid) calculations. The default is Vapor-Liquid.

Number of curves You can select 3-5 Curves, 10-15 Curves, or 15-20 Curves.

Property options Defaults are obtained from the Properties Specifications Global
sheet. For electrolyte systems, Aspen Plus uses the apparent
components approach.

4. When finished, click Go to generate the residue curves, or first click the Save
As Form button to save your interactive Property Analysis to forms within
the Data Browser.

Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.
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Aspen Plus displays the results in tabular form, in a form window and as a
triangular plot.

Example of Generating a Residue Map

Generate a residue map for the ternary system ethanol-water-ethyl acetate, at 1
atm, using the NRTL property method.

Tabular results form:
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Plotted results:

 

Stream Properties
You can calculate and display stream properties interactively as you create your
simulation model. You do not have to complete the flowsheet definition or input
specifications first. For example, to check your Property Method, you can analyze
a feed stream as soon as you define it. As you develop a flowsheet model
interactively, you can check the phase behavior of intermediate streams to help
you determine feasible specifications.

The following table shows the types of stream analyses you can perform:

Stream Analysis Types

Type Description

Point Stream properties for the total stream and each of the phases present. Properties include
temperature, pressure, phase fractions, flow rates, and many thermodynamic and transport
properties.

Component Flow Component flow rates for the total stream and each of the phases present. Mole, mass, and
standard liquid volume fractions are available.

Continued
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Type Description

Composition Component fractions for the total stream and each of the phases present. Mole, mass, and
standard liquid volume fractions are available. Partial pressure is also available.

Petroleum Point properties, plus API gravity, specific gravity, Watson K factor, and kinematic viscosity

Dist-Curve † Petroleum distillation curves (TBP, D86, D160, and vacuum)

Bubble/Dew†† Bubble point temperature and dew point temperature versus pressure curves

PV Curve†† Vapor fraction versus pressure curves at stream temperature

TV Curve †† Vapor fraction versus temperature curves at stream pressure

PT-Envelope†† Pressure-temperature envelope curves (For more information, see Pressure-Temperature
Envelopes, this chapter)

† Plots can be generated from this analysis.

†† These analyses automatically display plots of the curves.

Calculating and Displaying Stream Properties

To calculate and display stream properties interactively:
1. Ensure that Setup, Components, and Physical Properties specifications are

complete.

2. Ensure the Stream Specifications sheet for the stream is complete or the
stream has results that were calculated in the current session.

3. Click the stream on the flowsheet diagram to select it.

4. From the Tools menu, point to Analysis, then Stream, then the type of stream
analysis you want to perform. The Stream Analysis types will be inactive if
the conditions in steps 1,2 and 3 are not satisfied.

5. Make any selections and specifications in the dialog box for selecting options,
and click OK. Each stream analysis type has defaults for required input,
except temperature range for TV curves.

Stream analysis results appear in a form window. For some analysis types, a plot
of the results also appears. Print or view these results and plots as you would
with simulation results.

With the exception of the PT-Envelope type stream analysis, when you close the
resulting forms and plots, the results are not saved. On the Ptenvelope dialog
box, you are given the option to Save as Form, which will save the stream
Property Analysis you have created interactively, to forms within the Properties
Analysis section of the Data Browser menu. In all other types of stream analysis,
you must redo the calculations if you want to look at them again, once you close
the results forms.
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Saving an interactive Property Analysis as forms allows you to preserve the
input and results of this Property Analysis to view or modify at a later time. For
more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Example of Generating a Bubble/Dew Point Curve From Stream Analysis

The screens below show an example for generating a Bubble/Dew type stream
analysis for a stream containing an equimolar mixture of ethane and n-heptane.
The PENG-ROB property method is used.
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Tabular results form:

Plotted results:
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Generating Property Analyses Using
Forms

In addition to the many tables and plots available through interactive Property
Analysis, generating Property Analyses using forms provides the most flexibility
because it:

• Generates tables of physical property values using specifications you enter on
the Properties Analysis forms

• Allows you to report and study any property that you define in Property Sets

In general, you should only use manual Property Analysis when you need
functionality that is not available within the simpler interactive Analysis
commands.

The following Property Analyses types are available using forms:

Property Analysis Type For

Pure † Evaluation of pure component properties as a function of temperature and pressure

Binary † Generating common phase diagrams for binary systems, such as Txy, Pxy, or Gibbs energy of
mixing curves

Generic Property evaluations for multi-phase mixtures from flash calculations, or single-phase mixtures
without flash calculations

PT-Envelope Pressure-temperature envelopes and properties along a constant vapor fraction line

Residue Generating residue curve maps which plot the composition trajectories of a ternary mixture
undergoing distillation at total reflux

†
You cannot create these analysis types using forms. You must use the  interactive Analysis commands
for these analysis types because the appropriate property sets are defined automatically. You can modify
these analysis types using forms, but you should not modify the prop-sets created by the interactive
Analysis because the Plot Wizard may not produce the correct plots. .

Unlike the interactive method for using Property Analysis, when generating
Analyses from forms, you must run the simulation to generate results. You can
run the Property Analyses:

• On a standalone basis (Property Analysis run type)
• In a Flowsheet run
• In a Data Regression run

To use Property Analysis on a standalone basis, specify Property Analysis in the
Run Type list on the Setup Specifications Global sheet (or the New dialog box
when creating a new run).
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Creating A Property Analysis Using Forms
To manually create a Property Analysis using forms:
1. Make sure your Setup, Components, and Properties specifications are

complete.

2. From the Data menu, click Properties.

3. From the left pane of the Data Browser menu, click the Analysis folder.

4. On the Properties Analysis Object Manager, click New.

5. On the Create New ID dialog box, select the type of Analysis you want to
create in the Select Type list.

6. Enter an ID for the new Analysis, or accept the default ID.

7. Click OK.

The remaining specifications for using forms to generate a Property Analysis
depend on the Analysis type. The following sections provide instructions for
specifying each type of Analysis.

Pure
You must use the interactive Analysis commands to define your analysis, save
the specifications as forms using the Save As Form button, then edit the form to
add additional specifications. Use forms to modify pure component Property
Analyses only when you need flexibility not afforded by the simpler interactive
Analysis commands (for example results at multiple pressures).

Binary
You must use the interactive Analysis commands to define your analysis, save
the specifications as forms using the Save As Form button, then edit the form to
add additional specifications.

Generic
Use the Property Analysis Generic form to generate tables of properties of either:

• Multi-phase mixtures (for example, vapor and liquid) resulting from flash
calculations

• Single-phase mixtures without flash calculations
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The generic type of Property Analysis is the most flexible.

To generate a generic Property Analysis using forms:
1. On the System sheet of the Properties Analysis Generic Input form, click one

of the options in the Generate frame to specify whether you want to generate
properties at points along a flash curve for a multi-phase mixture resulting
from flash calculations, or at points for single-phase mixtures without flash
calculations.

Click either Points Along a Flash Curve or Point(s) Without Flash.

2. In the System section, choose either to Specify Component Flow or Reference
Flowsheet Stream. If you choose to specify component flow, enter the
flowrates of your system. If you choose to reference a flowsheet stream, enter
the Stream ID.

3. If you choose to specify component flow when generating points along a flash
curve, specify the valid phases for flash calculations in the Valid Phases list.
Choices are Vapor-Liquid, Vapor-Liquid-Liquid, or Vapor-Liquid-FreeWater.
The default is Vapor-Liquid.

4. If you choose to reference a flowsheet stream when generating points along a
flash curve, you can optionally specify the type of flash for the flowsheet
stream, in the Flash Type list (see Notes in step 6.)

5. Click the Variable sheet.

6. On the Variable sheet, specify the Adjusted Variables and their values to be
used in calculations.

Notes:

If a stream is referenced on the System sheet, you must either:

• Vary two of temperature, pressure, vapor fraction, and duty
– or –

• Specify Flash Type on the System sheet
If Flash Type is specified, any varied state variable must be consistent with
that specification. Unspecified state variables default to the stream values.
The number of valid phases is determined by the type of calculation
performed to generate the referenced stream.

If a stream is not referenced, you must either vary or specify on this form two
of temperature, pressure, and vapor fraction.
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You can define values for a varied variable by specifying either:

• A list of values
– or –

• Upper and lower limits for the variable and either the number of points or
the increment size.

 
7. Click the Tabulate sheet.

On the Tabulate sheet, specify the Property Set(s) that contain properties you
want to tabulate. To add a Property Set to the Selected Prop-Sets list, select it
from the Available Prop-Sets list, and click the right arrow button. To select
all available Property Sets, click the double right arrow button. Use the left
arrow buttons to remove items from the Selected Prop-Sets list. For more
information on creating Property Sets, see chapter 28.

Optionally you can click the Table Specifications button to enter a heading,
change the precision of the results, or specify the width of the tables
generated in the report file.

Further optional specifications include:

• Using the Properties sheet to change default property methods used to
generate the generic Property Analysis.

• Using the Diagnostics sheet to set how much information you receive
about warnings and errors from calculations.

Results for the generic Analysis can be viewed on the Properties Analysis Generic
Results form. For more information on Analysis results see Examining Property
Analysis Results this chapter.

Example of Using Forms to Create a Generic Property Analysis to Study
Rigorous 3-Phase Flash Behavior

Generate a table of properties at four pressures, using rigorous isothermal
three-phase flash calculations. Tabulate vapor fraction, liquid-liquid ratio (beta),
component mass fractions, and component flows for each of the three phases
separately, and for the combined liquid phases.
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The following two screens shows the property set, LIST-4, that defines the
properties to be tabulated.
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Tabular results:

To generate a plot of these results, select the variable on the Results sheet, then
use Plot from the main menu bar to specify the x-axis or y-axis variable. Select
Display Plot to view the plot.

Pressure-Temperature Envelopes
Use the PT-Envelope Property Analysis type to generate pressure-temperature
envelopes. These tables are parametric, consisting of one curve for each vapor
fraction, through the critical point, and its complementary vapor fraction. For
example, the complementary branch for a vapor fraction of 0.75 is 0.25.

The interactive PT-Envelope Analysis command for streams also provides a
complete facility for generating PT-Envelopes. Use the Property Analysis forms
only if you want to tabulate properties in addition to temperature, pressure, and
vapor fraction, or if you do not want to reference a stream.

You can generate PT-Envelopes from any property method except electrolyte
property methods (for example, ELECNRTL). However, PT-Envelopes generated
from activity coefficient-based and other non-equation-of-state property methods
will not pass through the critical point. Instead there will be separate curves for
each vapor fraction and its complementary branch.
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To generate a PT-Envelope using forms:
1. On the System sheet of the Properties Analysis PTEnvelope Input form,

choose either to Specify Component Flow or Reference Flowsheet Stream. If
you choose to specify component flow, enter the flow rates of your system. If
you choose to reference a flowsheet stream, enter the Stream ID.

2. Click the Envelope sheet. By default this sheet is already complete.

3. On the Envelope sheet, specify the vapor fractions for which tables will be
generated. By default, Aspen Plus generates the dew and bubble point curves
(vapor fraction = 1 and 0, respectively.) You can specify additional vapor
fractions. Aspen Plus generates one curve for each vapor fraction, through the
critical point, and its complementary vapor fraction. For example, if you
specify a vapor fraction of 0.25, Aspen Plus will generate one curve for the
0.25 and 0.75 vapor fraction branches.

You can also specify these options:

• Temperature or pressure of the first point
• Maximum number of points
• Termination point

Further optional specifications include:

• Using the Tabulate sheet to specify properties to calculate in addition to the
default temperature and pressure tabulations. Specify any additional
properties by adding Property Set IDs to the Selected Prop-Sets list (see
Chapter 28). You can also click the Table Specifications button to enter a
heading, change the precision of the results, or specify the width of the tables
generated in the Report file.

• Using the Properties sheet to change default property methods used to
generate the PT envelope.

• Using the Diagnostics sheet to set how much information you receive about
warnings and errors from calculations.

Results for the PT-Envelope can be viewed on the Properties Analysis PT-
Envelope Results form. For more information on Analysis results see Examining
Property Analysis Results this chapter.

Example  of  Using  Forms  to  Generate  a  Pressure-Temperature  Envelope

Generate a PT-Envelope for an equimolar mixture of ethane and n-heptane using
the PENG-ROB property method. Generate the phase envelope for vapor
fractions of 1, 0.5, and 0. Tabulate the mole fractions of the vapor and liquid
phases, in addition to the default temperature and pressure.
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This is the property set, LIST-3, that defines the additional properties (mole
fraction) to be tabulated:
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Tabular Results:
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To generate a plot of these results, choose Plot Wizard from the Plot menu of the
main menu bar, while viewing the above results form. This is the resulting
PT-Envelope plot, generated by accepting all the default settings of the Plot
Wizard:

Residue Curves
Residue Curves (or maps) plot the composition trajectories of a ternary mixture
undergoing distillation at total reflux. You can use them to visualize the presence
of azeotropes and the constraints azeotropes impose on the degree of separation.
Use Residue Curves to predict feasible splits, select entrainers, and analyze
potential column operability problems (Doherty, 1978 and Wahnschaft, 1992).

Use Residue Curves with nonideal chemical systems, and Property Methods that
represent such systems. Examples are activity-coefficient-based Property
Methods, such as NRTL, Wilson, UNIQUAC, and UNIFAC.
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To generate a Residue Curve using forms:
1. On the System sheet of the Properties Analysis Residue Input form, specify:

• Components for the ternary mixture you want to analyze, using the
Component 1, Component 2, and Component 3 list boxes.

• System pressure using the Pressure field. The default is 1 atm.
• Whether you want Aspen Plus to perform rigorous two-phase or three-

phase calculations. Choose either Vapor-Liquid or Vapor-Liquid-Liquid in
the Valid Phases list. The default is Vapor-Liquid.

• Number of curves to be generated. Choose either 3-5 Curves, 10-15
Curves, or 15-20 Curves. Note that more curves require more calculation
time. The default is 10-15 curves.

Optional specifications include:

• Using the Properties sheet to change default property methods used to
generate the Residue Curve.

• Using the Diagnostics sheet to set how much information you receive about
warnings and errors from calculations.

Results for the Residue Curve can be viewed on the Properties Analysis Residue
Results form. For more information on Analysis results see Examining Property
Analysis Results this chapter.

Property Methods Specifications for
Property Analysis

Property Analyses use default property methods. Aspen Plus determines these
defaults based on whether a flowsheet stream is referenced on the Property
Analysis System form.

Flowsheet stream referenced? Default property methods are

NO Specified on the Properties Specifications Global sheet.

YES The same as those used to calculate stream properties in the flowsheet simulation

You can override the default property specifications on the Properties Analysis
Properties sheet.
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Examining Property Analysis Results
To examine Property Analysis results:
1. From the Data menu, select Properties.

2. From the left pane of the Data Browser menu, double-click the Analysis
folder.

3. Double-click the folder for the Property Analysis you wish to examine.

4. Click the Results folder.

You can plot the results using the Plot Wizard from the Plot menu of the main
menu bar. For details on using the Plot Wizard, see chapter 13.

References
Doherty, M.F. and Perins, J.D., Chem. Eng. Sci., (1978), Vol. 33, p. 281.

Wahnschaft, O., "The Product Composition Regions of Single-feed Azeotropic
Distillation Columns," Ind. Eng. Chem. Res., (1992), Vol. 31, pp. 2345-2362.
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30 Estimating Property
Parameters

Aspen Plus stores physical property parameters in databanks for a large number of
components. If a required parameter is not in any Aspen Plus databank, it can be:

• Entered directly (see Chapter 8)
• Estimated using Property Estimation
• Regressed from experimental data using Data Regression (see Chapter 31)

About Property Estimation

You can use Property Estimation in the following two ways:

• On a standalone basis
• In a Flowsheet, Property Analysis, PROPERTIES PLUS, or Data Regression

run

This chapter includes the following information about estimating parameters
using Property Estimation:

• Property parameters Aspen Plus can estimate
• Defining molecular structure
• Estimating parameters
• Using experimental data to improve estimated parameters
• Comparing estimated parameters for components
• Examining parameter estimation results
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Property Estimation on a Standalone Basis
Property Estimation estimates all missing parameters listed in the tables on
pages 30-3—30-6. To create a standalone estimation run, do one of the following:

• Select the Property Estimation Run Type when creating a new run.
• From the Data menu select Setup, then select the Specifications form. On the

Global sheet, select Property Estimation in the Run Type list box.

Property Estimation in a Flowsheet, Property Analysis,
PROPERTIES PLUS, or Data Regression Run

Property Estimation estimates all missing parameters from the tables on pages 30-
3—30-6 that are required in the run.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus run types, it is important understand which
parameters will be used if a parameter is available from multiple sources.

If you select Estimate All Missing Parameters on the Estimation Input form,
Aspen Plus will estimate and use all missing parameters that are required in the
run. Parameters that are estimated, but are not missing, will not be used in the
run.

If you selectively specify the estimation of an individual parameter that is
required by the simulation, this estimated parameter will be used regardless of
whether another value is available in a databank, or on a Properties Parameters
input form.

What Property Parameters Can
Aspen Plus Estimate?

Property Estimation in Aspen Plus can estimate many of the property parameters
required by physical property models, including:

• Pure component thermodynamic and transport property model parameters
• Binary parameters for the Wilson, NRTL, and UNIQUAC activity coefficient

models

The following tables list the property parameters Aspen Plus can estimate.
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Property Names and Estimation Methods for Pure Component Constants

Description Parameter Method Information Required†

Molecular weight MW FORMULA Structure

Normal boiling point TB JOBACK
OGATA-TSUCHIDA
GANI
MANI

Structure
Structure
Structure
TC, PC, Vapor pressure data

Critical temperature TC JOBACK
LYDERSEN
FEDORS
AMBROSE
SIMPLE
GANI
MANI

Structure, TB
Structure, TB
Structure
Structure, TB
MW, TB
Structure
TC, PC, Vapor pressure data

Critical pressure PC JOBACK
LYDERSEN
AMBROSE
GANI

Structure
Structure, MW
Structure, MW
Structure

Critical volume VC JOBACK
LYDERSEN
AMBROSE
RIEDEL
FEDORS
GANI

Structure
Structure
Structure
TB, TC, PC
Structure
Structure

Critical compressibility factor ZC DEFINITION TC, PC, VC

Standard heat of formation DHFORM BENSON
JOBACK
BENSONR8
GANI

Structure
Structure
Structure
Structure

Standard Gibbs free energy of
formation

DGFORM JOBACK
BENSON
GANI

Structure
Structure
Structure

Acentric factor OMEGA DEFINITION
LEE-KESLER

TC, PC, PL
TB, TC, PC

Solubility parameter DELTA DEFINITION TB, TC, PC, DHVL, VL

UNIQUAC R UNIQUAC R BONDI Structure

UNIQUAC Q UNIQUAC Q BONDI Structure

Parachor PARC PARACHOR Structure

Solid enthalpy of formation at 25
C

DHSFRM MOSTAFA Structure

Solid Gibbs energy of formation
at 25 C

DGSFRM MOSTAFA Structure

Continued
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Property Names and Estimation Methods for Pure Component Constants
(Continued)

Description Parameter Method Information Required†

Aqueous infinite dilution Gibbs
energy of formation for the
Helgeson model

DGAQHG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

DGAQFM
DGAQFM, S025C
DGAQFM
S025C

Aqueous infinite dilution
enthalpy of formation for the
Helgeson model

DHAQHG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

DGAQFM
DGAQFM, S025C
DGAQFM
S025C

Entropy at 25 C for the
Helgeson model

S25HG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

S025C
DGAQFM, DHAQFM
DGAQFM
DHAQFM

Helgeson OMEGA heat
capacity coefficient

OMEGHG HELGESON S25HG, CHARGE

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure
forms. Data indicates that correlation parameters are determined directly from experimental data you
enter on Properties Data forms. When another parameter is required, such as TB, it can come from a
databank or from another estimation method. Or you can enter it on a Properties Parameters form.

Property Names and Estimation Methods for Temperature-Dependent
Properties

Description Parameter Method Information Required†

Ideal gas heat capacity CPIG DATA
BENSON
JOBACK
BENSONR8

Ideal gas heat capacity data
Structure
Structure
Structure

Vapor pressure PL DATA
RIEDEL
LI-MA
MANI

Vapor pressure data
TB, TC, PC
Structure, TB
TC, PC, Vapor pressure data

Enthalpy of vaporization DHVL DATA
DEFINITION
VETERE
GANI
DUCROS
LI-MA

Heat of vaporization data
TC, PC, PL
MW, TB
Structure
Structure
Structure, TB

Liquid molar volume VL DATA
GUNN-YAMADA
LEBAS

Liquid molar volume data
TC, PC, OMEGA
Structure

Continued
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Property Names and Estimation Methods for Temperature-Dependent
Properties (Continued)

Description Parameter Method Information Required†

Liquid viscosity MUL DATA
ORRICK-ERBAR
LETSOU-STIEL

Liquid viscosity data
Structure, MW, VL, TC, PC
MW, TC, PC, OMEGA

Vapor viscosity MUV DATA
REICHENBERG

Vapor viscosity data
Structure, MW, TC, PC

Liquid thermal conductivity KL DATA
SATO-RIEDEL

Liquid thermal conductivity data
MW, TB, TC

Vapor thermal conductivity KV DATA Vapor thermal conductivity data

Surface tension SIGMA DATA
BROCK-BIRD
MCLEOD-SUGDEN

Surface tension data
TB, TC, PC
TB, TC, PC, VL, PARC

Solid heat capacity CPS DATA
MOSTAFA

Solid heat capacity data
Structure

Helgeson C heat capacity
coefficient

CHGPAR HG-AQU
HG-CRIS

HG-EST

OMEGHG, CPAQ0
OMEGHG, S25HG, CHARGE, IONTYP

OMEGHG, S25HG

Liquid heat capacity CPL DATA
RUZICKA

Liquid heat capacity data
Structure

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure
forms. Data indicates that correlation parameters are determined directly from experimental data you
enter on Properties Data forms. When another parameter is required, such as TB, it can come from a
databank or from another estimation method. Or you can enter it on a Properties Parameters form.

In Flowsheet, Property Analysis, Properties PLUS, or Data Regression runs,
Aspen Plus estimates missing binary parameters only if you request them on the
Properties Estimation Input Binary sheet. If infinite dilution activity coefficients
are estimated or supplied on the Properties Data Mixture form at only one
temperature, then the parameters in brackets [ ] are set to zero.

Property Names and Estimation Methods for Binary Parameters

Description Parameter Method Information Required†

Wilson parameters WILSON/2
[WILSON/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure
Structure
Structure
Structure
Structure

Continued
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Property Names and Estimation Methods for Binary Parameters
(Continued)

Description Parameter Method Information Required†

NRTL parameters NRTL/2
[NRTL/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure
Structure
Structure
Structure
Structure

UNIQUAC parameters UNIQ/2
[UNIQ/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure
forms. Data indicates that correlation parameters are determined directly from experimental data you
enter on Properties Data forms. When another parameter is required, such as TB, it can come from a
databank or from another estimation method. Or you can enter it on a Properties Parameters form.

Property Names and Estimation Methods for UNIFAC Group Parameters

Description Parameter Method Information Required†

UNIFAC R UNIFACR BONDI Structure

UNIFAC Q UNIFACQ BONDI Structure

Lyngby UNIFAC R UNIFLR BONDI Structure

Lyngby UNIFAC Q UNIFLQ BONDI Structure

Dortmund UNIFAC R UNIFDR BONDI Structure

Dortmund UNIFAC Q UNIFDQ BONDI Structure

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure
forms. Data indicates that correlation parameters are determined directly from experimental data you
enter on Properties Data forms. When another parameter is required, such as TB, it can come from a
databank or from another estimation method. Or you can enter it on a Properties Parameters form.
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Required Information for Parameter
Estimation

The minimum information required for parameter estimation is:

• Normal boiling point temperature (TB)
• Molecular weight (MW)
• Molecular structure, preferably entered using the General method

Property Estimation uses normal boiling point and molecular weight to estimate
many parameters. You can greatly reduce the propagation of errors in estimating
other parameters by using the experimental value of TB. If you do not supply TB
and MW but you enter the general molecular structure, Property Estimation can
estimate TB and MW.

To obtain the best possible estimates for all parameters, enter all the
experimental data that is available.

Defining Molecular Structure Using the
General Method

When you use the general method to describe the atoms and bonds in a compound,
Aspen Plus automatically generates the required functional groups for the
estimation methods used in a particular run.

To use the general method:
1. Sketch the structure of the molecule on paper.

2. Assign a number to each atom, omitting hydrogen. The numbers must be
consecutive, starting from 1.

3. From the Data menu, click Properties.

4. In the left pane of the Data Browser, click Molecular Structure.

5. From the Molecular Structure Object Manager, select a component ID for
which you want to specify the molecular structure, then click Edit.
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On the General sheet, define the molecule by its connectivity, one pair of
atoms at a time.

In this field Enter

Number Unique number identifying an atom in the molecule. This should be the atom number that you
assigned in your preliminary drawing.

Type Atom type (for example, carbon or oxygen)

Bond type Type of bond that connects a pair of atoms (for example, single or double)

Atom numbers and atom types appear on the correspondence list at the
bottom of the form.

Atoms Numbers and Types
When you enter an existing atom number, Aspen Plus displays the atom type
(except for the first pair of atoms). You can omit specifying values in the Number
and Type fields for the first atom of a pair. Aspen Plus will automatically use the
atom number and type of the second atom for the previously entered pair. Enter
a number for the second atom of the current pair.

You can use the following bond types to simplify the task of entering the
structure of common ring compounds and saturated hydrocarbons:

Special Bond Type Description

Benzene ring Benzene ring

Sat. 5-member ring Saturated 5-member ring

Sat. 6-member ring Saturated 6-member ring

Sat. 7-member ring Saturated 7-member ring

Sat. hydrocarbon chain Saturated hydrocarbon chain

When you use these special bond types, the atom numbers assigned to the
members of the carbon ring or carbon chain must be consecutive.

Example of Defining Molecular Structure Using the General Method

Define the molecular structure of isobutyl alcohol (C4H10O) using the general
method.
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CH 3

CH     CH 2         OH

CH 3

Assign a number to each atom, omitting hydrogen.

Defining Molecular Structure Using
Method-Specific Functional Groups

Use the Properties Molecular Structure Functional Group sheet to enter
method-specific functional groups. For each group-contribution method, specify:

• Functional groups
• Number of times each group occurs in the compound

Functional groups are defined and numbered differently for each method. For
functional group definitions, see Aspen Plus Physical Property Data, or browse
through the Group Number list.

You can enter any number of pairs for group numbers and number of
occurrences, with one exception. For the UNIFAC, UNIF-LL, UNIF-DMD, and
UNIF-LBY methods the limit is 12.
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To specify method specific functional groups:
1. Sketch the structure of the molecule on paper.

2. From the Data menu, click Properties.

3. In the left pane of the Data Browser, click Molecular Structure.

4. From the Molecular Structure Object Manager, select a component ID for
which you want to specify the molecular structure, then click Edit.

5. Click the Functional Group sheet.

6. On the Functional Group sheet, select the estimation method from the
Method list box.

7. In the Group Number list, select a functional group for the method, that
represents a functional group contained in your molecule. The prompt area
displays a description of the functional group.

8. Count the number of times this group occurs in the molecule and enter that
number in the Number of Occurrences field. The default is one.

9. Repeat steps 7 and 8 until all functional groups in your molecule are
represented with the appropriate number of occurrences.

Example of Defining Molecular Structure Using Method-Specific
Functional Groups

The structure of isobutyl alcohol is defined using the Lydersen method. The
Lydersen functional groups are -CH3, >CH2, >CH-, and -OH. The corresponding
group numbers are 100, 101, 102, and 121, respectively.

CH 3

CH     CH 2         OH

CH 3
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Identifying Parameters to be Estimated
In a standalone Property Estimation run, Aspen Plus estimates all missing
parameters listed in the tables on pages 30-3—30-6, using default methods. You
can use the Properties Estimation Input form to request parameter estimation and
to:

• Specify the properties and components for which parameters are to be
estimated

• Select estimation methods
• Request estimation for parameters that are not missing

In a Flowsheet, Data Regression, or Property Analysis run, you must request
estimation of missing parameters. Aspen Plus estimates all missing required
parameters using default methods, unless you specify otherwise on the Input
form.

To request parameter estimation:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select Estimation then Input.
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3. On the Setup sheet, specify one of the following Estimation options.

Option Estimates

Do not estimate any parameters Nothing. This is the default.

Estimate all missing parameters All missing required parameters and any parameters you
request on the Pure Component, T-Dependent, Binary,
and UNIFAC Group sheets

Estimate only the selected parameters Only the types of parameters you specify on the Setup
sheet. Specific estimations must be specified on the
sheets identified by your parameter types selection on this
sheet.

The Estimate All Missing Parameters option is strongly recommended unless
you:

• Know exactly what parameters are missing and want to estimate only
those parameters

• Want to evaluate the estimation methods only for certain parameters
4. If you selected Estimate Only the Selected Parameters, specify the type(s) of

parameters to estimate by checking the appropriate checkboxes. Go to the
appropriate sheet to specify the desired parameters and methods.

You must supply all information required to estimate the parameters.

5. If you selected Estimate All Missing Parameters, you can override default
estimation methods. Go to the appropriate sheet to specify parameters and
methods for the different types of parameters.
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Use these sheets to select parameters and methods:

Form What is Specified

Pure Component Parameter names and estimation methods for pure component constants

T-Dependent Parameter names and estimation methods for temperature-dependent parameters

Binary Parameter names and estimation methods for binary parameters

UNIFAC Group Parameter names for UNIFAC group parameters

See subsequent sections of this chapter for more information on these sheets.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus run types, if you manually request the estimation
of specific parameters using the sheets in the table above, these estimated values
are used preferentially over any values available in a databank or on a Properties
Parameters form.

You can specify more than one estimation method for a parameter. This allows
you to compare the estimates predicted by different methods.

When you specify multiple estimation methods for a parameter required in a
Flowsheet, Property Analysis, Data Regression, or Properties Plus run type, the
simulation uses the value estimated by the first estimation method selected.

The tables on pages 30-3—30-6 list the estimation methods Aspen Plus provides
for each parameter. For details on the accuracy and applicability of each
estimation method, see Aspen Plus Physical Property Methods and Models,
Chapter 8.

Estimating Pure Component Parameters
Use the Estimation Input Pure Component sheet to request estimation of pure
component constants, such as critical temperature (TC).

To request estimation of a pure component constant:
1. From the Data menu, click Properties

2. In the left pane of the Data Browser Menu, select Estimation, then Input.

3. On the Setup sheet, choose estimation options. For more information, see
Identifying Parameters to be Estimated on page 30-11.

4. Click the Pure Component sheet.

5. On the Pure Component sheet, select a parameter you want to estimate using
the Parameter list box.
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6. In the Component list box, select the component for which you want to
estimate the selected parameter. If you want to estimate the chosen
parameter for multiple components, you may continue to select additional
components individually, or you may select All to estimate the parameter for
all components.

7. In the Method list box for each selected component, choose the estimation
method you want to use. You can specify more than one method.

8. To request estimation of additional pure component parameters, select a
different parameter in the Parameter list box, and repeat steps 6 and 7.

If you specify more than one method, only the value estimated by the first
method is used. Results for all the methods specified are displayed on the
Estimation Results form. See Examining Parameter Estimation Results on page
30-22.

The only reason for specifying more than one method is to evaluate the accuracy
of methods used in estimating a given parameter. See Comparing Estimated
Parameters to Experimental Data on page 30-21.

Example for Estimating Critical Temperature

This estimation problem is set up to evaluate the accuracy of three methods
(Joback, Lydersen, and Ambrose) for estimating TC for isobutyl alcohol:
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Estimating Temperature-Dependent Properties
Use the Estimation Input T-Dependent sheet to request estimation of correlation
parameters for temperature-dependent properties (such as parameters for the
extended-Antoine vapor pressure). Property Estimation uses estimation methods
based on group contributions and corresponding-states theory. In addition,
Property Estimation accepts experimental property versus temperature data and
uses them to determine the correlation parameters by regression.

To request estimates of temperature-dependent properties:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Estimation subfolder.

3. On the Setup sheet, choose estimation options. For more information, see
Identifying Parameters to be Estimated on page 30-11.

4. Click the T-Dependent sheet.

5. On the T-Dependent sheet, specify the property you want to estimate in the
Property list box.

6. In the Component list box, select the component for which you want to
estimate the selected property. If you want to estimate the chosen property
for multiple components, you may continue to select additional components
individually, or you may select All to estimate the property for all
components.

7. In the Method list box for each selected component, choose the estimation
method you want to use. You can specify more than one method for each
property. To do this, list the component again, and choose a different method.

8. To request estimation of additional temperature dependent properties, select
a different property in the Property list box, and repeat steps 6 and 7.

If you specify more than one method for a component, only the estimated
value of the first method is used. Results for all the methods specified are
displayed on the Results form.  See Examining Parameter Estimation Results
on page 30-22.

The only reason for specifying more than one method is to evaluate the
accuracy of methods used in estimating a given property. See Comparing
Estimated Parameters to Experimental Data on page 30-21.

9. If you want to restrict estimation to a temperature range, enter the lower
temperature limit in the Lower Temp. field, and enter the upper temperature
limit in the Upper Temp. field.

10. If you have experimental property versus temperature data, enter them on
the Properties Data Pure-Comp form.
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When you select Then Aspen Plus

DATA in the Method field Uses the experimental data you enter on the Properties
Data Pure-Comp form to determine the correlation
parameters by regression

DATA in the Method field, and Upper Temp. and Lower
Temp.

Uses only the experimental data within the temperature
ranges you specify

A method other than DATA Uses the specified method to estimate the property over a
range of temperatures (Upper Temp. and Lower Temp.).
Aspen Plus determines the correlation parameters that
best fit the estimated data

A method other than DATA and you check the Use Data
check box

Combines the experimental data you enter on the
Properties Data Pure-Comp form with the estimated
values using the method you specified to determine the
best correlation parameters

If you combine the experimental data and estimated values (by selecting the
Use Data check box), you can assign a weight to the experimental data in the
Weight field. The weight is relative to 1.0 for estimated values.

Estimating Binary Parameters
Use the Estimation Binary Input sheet to request estimates of binary
parameters, such as WILSON/1 and WILSON/2 for the Wilson model. Aspen Plus
estimates binary parameters using infinite-dilution activity coefficient data.

To request estimates of binary parameters:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, click Estimation then Input.

3. On the Setup sheet, choose estimation options. For more information, see
Identifying Parameters to be Estimated on page 30-11.

4. Click the Binary sheet.

5. On the Binary sheet, click New then specify the parameter you want to
estimate in the Parameter list box.

6. In the Method list box, choose the estimation method you want to use. You
can specify more than one method for each parameter.

When Method is Then Aspen Plus uses

DATA The infinite dilution activity coefficient data you enter on the Properties Data Mixture
form. For more information see Using Infinite Dilution Activity Coefficient Data on page
30-20.

A method other than DATA The method to estimate infinite dilution activity coefficients
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7. In the Component i and Component j list boxes, specify two components for
which you want to estimate interaction parameters. If you want to estimate
the chosen parameter for multiple component pairs, you may continue to
select additional component pairs individually, or you may select All to
estimate the parameters for all component pairs.

8. In the Temp field, you can specify the temperature(s) of the infinite-dilution
activity coefficient data. The default temperature is 25 C. If you select DATA
in the Method field, the default is all the data you entered on the Properties
Data Mixture form.

When you Aspen Plus estimates

Enter no temperature value, or enter only one temperature
value

Only the second element of the parameter (for example,
WILSON/2 for Wilson)

Enter more than one temperature value Elements one and two of the parameter (for example,
WILSON/1, WILSON/2)

9. To request estimation of additional binary parameters, select a different
parameter in the Parameter list box, and repeat steps 6, 7 and 8.

Example for Estimating Binary Parameters

Estimate Wilson binary parameters from infinite-dilution activity coefficients
generated by UNIFAC. Estimate the infinite-dilution activity coefficients at 30
and 40°C for component pair C1-C2; and at 30°C for component pair C2-C3. For
C1-C2, the WILSON/1 and WILSON/2 binary parameters are estimated because
two temperatures are requested. For C2-C3, only the WILSON/2 parameter is
estimated because only one temperature is requested.
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Estimating UNIFAC Group Parameters
Use the Properties Estimation UNIFAC Group sheet to request parameter
estimation for UNIFAC functional groups. Group parameters for all UNIFAC
groups are built into Aspen Plus. You do not need to estimate them.

If you define a new UNIFAC group on the Components UNIFAC-Groups form:

Use this sheet To

Properties Molecular Structure Functional Group Define the structure of the UNIFAC group using the Bondi method

Properties Estimation Input UNIFAC Group Estimate group parameters

To request parameter estimation for UNIFAC functional groups:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select Estimation then Input.

3. On the Setup sheet, choose estimation options. For more information, see
Identifying Parameters to be Estimated on page 30-11.

4. Click the UNIFAC Group sheet.

5. In the Parameter list box, specify the UNIFAC group parameter you want to
estimate .

6. In the Group ID fields, enter the UNIFAC Group IDs for which you want to
estimate parameters.

UNIFAC group IDs must have been defined on the Components UNIFAC-
Groups form.

Using Experimental Data to Improve Estimated
Parameters

You can use any experimental property data available to improve the quality of
your parameter estimation. Whenever possible, supply experimental data to
minimize the propagation of errors due to the uncertainty of estimated values.

Temperature-dependent property data (such as vapor pressure versus
temperature data) can be used directly to determine correlation parameters by
regression. Infinite-dilution activity coefficient data are used to estimate binary
parameters.
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Use this form To enter this type of property data

Properties Parameters Pure Component Scalar Scalar property constants, such as normal boiling point (TB)
or critical temperature (TC) (See Chapter 8)

Properties Parameters Pure Component T-Dependent Temperature-dependent correlation parameters, such as
PLXANT for the extended Antoine vapor pressure model
(See Chapter 8)

Properties Data PURE-COMP Temperature-dependent property data, such as vapor
pressure versus temperature points (See Chapter 31))

Properties Data MIXTURE Infinite dilution activity coefficient data versus temperature for
binary systems  (See Chapter 31)

Using Temperature-Dependent Property Data

Use the Properties Data PURE-COMP form to enter temperature-dependent
property data.

Enter the data as pairs of temperature and property values.

To enter temperature-dependent property data: listed in the table on page 30-4:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data subfolder.

3. To create a new Data ID, on the Data Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for the data, or accept the
default ID. Choose PURE-COMP from the Select Type list box, and click OK.

5. To modify an existing Data ID, select the ID from the Data Object Manager,
and click Edit.

6. On the Setup sheet, select the category For Estimation, then specify the
property for which you have data, in the Property list box.

7. Select the component for which you have data, in the Component list box.

8. If your data was measured at a constant temperature or pressure, you can
enter this value in the Constant Temperature or Pressure frame.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.
The first column in the data table, Usage, will be filled in automatically when
you begin entering your data points.

The first row of the data table is filled in with default values of standard
deviation. These standard deviations are not considered in Property
Estimation however. They are only used in Data Regression. (See Chapter 31)
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To combine the experimental pure component data to estimate temperature-
dependent property parameters:
1. Select the Properties Estimation Input T-Dependent sheet.

2. Select the property you wish to estimate in the Property list box.

3. Specify the component then select DATA in the Method list box.

You can combine experimental temperature-dependent property data with
estimated data. For example, you can combine experimental vapor pressure data
with values estimated by the Riedel method. The combined data are then used to
determine the best set of PLXANT parameters. You can use this feature to
extrapolate limited experimental data. For more information, see Estimating
Temperature-Dependent Properties on page 30-15.

The experimental data you enter can be used in three ways:

• By Data Regression, to obtain correlation parameters by regression.
• By Property Estimation, to obtain correlation parameters by regression.
• By Property Estimation, together with other estimated values, to obtain

correlation parameters.

Using Property Estimation is similar to using Data Regression to regress pure
component temperature-dependent property data or infinite-dilution activity
coefficient data. However, with Data Regression you can:

• Mix VLE and pure component data
• Regress any parameter, such as an equation-of-state parameter
• Control which parameters in a correlation to regress
• Provide standard deviations (weightings) for individual variables and data

points

For detailed information about data regression, see Chapter 31.

Using Infinite Dilution Activity Coefficient Data

Use the Properties Data MIXTURE form to enter infinite-dilution activity
coefficient (gamma infinity) data for binary systems.

To enter infinite-dilution activity coefficient data:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select the Data subfolder.

3. To create a new Data ID, on the Data Object Manager, click New. On the
Create New ID dialog box, enter an ID for the data, or accept the default ID.
Choose MIXTURE from the Select Type list box, and click OK.

4. To modify an existing Data ID, select the ID from the Data Object Manager,
and click Edit.
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5. On the Setup sheet, select the category For Estimation in the category list
box, then GAMINF in the Data Type list box.

6. Select the components for which you have data from the Available
Components list, and use the right arrow button to move the two components
of interest to the Selected Components list.

7. Click the Data sheet.

8. On the Data sheet, enter the experimental data in the appropriate fields as
described in the table below. The first column in the data table, Usage, will be
filled in automatically when you begin entering your data points.

The first row of the data table is filled in with default values of standard
deviation. These standard deviations are not considered in Property
Estimation however. They are only used in Data Regression. (See Chapter 31)

Field Enter

TEMP1 Temperature corresponding to the infinite-dilution activity coefficient of component 1 (GAMINF1)

GAMINF1 Infinite-dilution activity coefficient of component 1

TEMP2 Temperature corresponding to the infinite-dilution activity coefficient of component 2 (GAMINF2)

GAMINF2 Infinite-dilution activity coefficient of component 2

If one infinite-dilution activity coefficient value is missing, leave both the
TEMP and GAMINF fields blank.

To use the experimental infinite-dilution activity coefficient data to estimate
binary parameters:
1. Select the Properties Estimation Input Binary sheet.

2. Select the parameter you want to estimate in the Parameter list box.

3. Select DATA in the Methods list box.

4. In the Component i and Component j fields, specify the two components for
which you have entered infinite-dilution activity coefficient data.

Comparing Estimated Parameters to Experimental Data
Use the Properties Estimation Compare form to compare estimated parameters
to experimental data. You can also compare the estimated values of components
to results for other components. This feature can help you select the best method
for estimating parameters for a nondatabank component when only limited
experimental data is available.

To evaluate the accuracy of estimation methods used for a parameter and to
select the best methods for estimating parameters for a nondatabank component:
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1. Identify databank components that are similar to the nondatabank
component in terms of molecular structure or functional groups.

2. Request parameter estimation for these databank components using all
methods available on the Estimation Input form.

3. Use the Estimation Compare form to compare the estimated parameters to
the experimental data.

From the comparison you can determine the best method for each parameter.
The best methods for the databank components should also be best for the
nondatabank component.

To compare estimated parameters to experimental data:
1. From the Data menu, click Properties

2. In the left pane of the Data Browser Menu, double-click the Estimation
subfolder.

3. Select the Compare form.

4. On the Compare Setup sheet, use the Components and UNIFAC Group IDs
list boxes to enter components or groups to be compared with experimental
data.

Examining Parameter Estimation Results
To examine parameter estimation results:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, double-click the Estimation
subfolder.

3. Select the Results or the Compare Results form.

The Estimation Results form displays the estimated properties and parameters
that you requested on the Estimation Input form. Estimated parameters are also
placed on appropriate Properties Parameters forms. The Compare Results form
displays comparisons between estimated and experimental data , as requested on
the Estimation Compare form. Comparisons between components are not
displayed on the Compare Results form, they are contained in the reports.

To view comparisons between components:

From the View menu, click Reports.
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Example of Pure Component Estimation Results

This example shows the estimated values of TC for isobutyl alcohol using three
methods (Joback, Lydersen, and Ambrose).

Using Estimated Parameters

If you estimate parameters, you can choose whether the results are automatically
written to Properties Parameters input forms or not.

If you estimate parameters in a standalone Property Estimation run, and then
want to use them in a Flowsheet, Property Analysis, Data Regression, or
Properties Plus run:

➤ On the Setup Specifications Global sheet, change the Run Type.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus runs, if you select Estimate All Missing
Parameters, Aspen Plus estimates and uses all missing parameters that are
required in the run. Aspen Plus does not estimate any parameters that are not
missing.

If you specifically request the estimation of an individual parameter, this
estimated parameter will be used preferentially over any databank value, or any
value entered on Properties Parameters forms.
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Saving Estimation Results Automatically
If you estimate parameters, by default the results are automatically written to
Properties Parameters input forms.

This means that when you are satisfied with your estimation results, you can
turn off Property Estimation because the estimated parameters have been
preserved on the Parameters forms for use in subsequent simulation runs.

To turn off Property Estimation:

➤ On the Setup sheet of the Properties Estimation Input form, check Do Not
Estimate Any Parameters.

Not Saving Estimation Results Automatically
If you do not want the estimation results to be written to the Parameters forms
automatically:
1. From the Tools menu, click Options.

2. Click the Component Data tab.

3. Clear the Copy Regression and Estimation Results onto Parameters Forms
checkbox.

❖     ❖     ❖     ❖ 
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31 Regressing Property Data

You can use experimental property data to determine the physical property model
parameters you need for an Aspen Plus simulation.

The Aspen Plus Data Regression System fits parameters of physical property
models to measured data for pure component or multicomponent systems. You
can enter almost any kind of experimental property data, such as:

• Vapor-liquid equilibrium
• Liquid-liquid equilibrium
• Density
• Heat capacity
• Activity coefficients

You can use Data Regression for all property models in Aspen Plus, including
electrolyte and user models.

This chapter includes the following information about Data Regression:

• Setting up a regression
• Entering pure component, phase equilibrium, and mixture data
• Plotting experimental data
• Formulating a regression case
• Evaluating the accuracy of known model parameters
• Examining and plotting regression results
• Comparing results from several cases
• Using the Dortmund Databank (DDB) interface
• Data regression example



31-2 Aspen Plus User Guide
Version 10.1-0

Regressing
Property Data

Setting Up a Regression

To set up a Data Regression:
1. Start Aspen Plus and create a new run from a Template as described in

Chapter 2.

2. On the New dialog box, select Data Regression in the Run Type list box.

– or –

From the Data menu, click Setup. Then choose Data Regression in the Run
Type list box on the Setup Specifications Global sheet.

3. Define components on the Components Specifications Selection sheet. See
Chapter 6.

4. Select a property method on the Properties Specifications Global sheet. See
Chapter 7.

5. Enter or estimate any supplemental property parameters on the Properties
Parameters and Properties Estimation forms. See Chapters 9 and 30.

6. Enter experimental data on the Properties Data forms, described later in this
chapter.

7. Specify the regression case on the Properties Regression form. See
Formulating a Regression Case on page 31-11.

Use Next to guide you through these steps.

Selecting a Property Method

You must select a property method that uses the property model for which you
want to determine parameters.

For example, to fit UNIQUAC binary parameters, choose one of the following
property methods:

• UNIQUAC
• UNIQ-HOC
• UNIQ-NTH
• UNIQ-RK
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Choose the same property method you will use for simulation runs using the
fitted parameters. For example, if you want to use UNIQUAC with the Hayden-
O'Connell vapor phase association property method (UNIQ-HOC) in a simulation
run, you must also use the UNIQ-HOC property method in your Data Regression
run.

There is one important exception. Do not use property methods ending in -2 in
Data Regression, even when fitting LLE data. For example, to determine
parameters to use with the UNIQ-2 property method, use the UNIQUAC
property method in the Data Regression run. In the simulation run, use the
UNIQ-2 property method. The binary parameters you determined in the Data
Regression run will be available on the Properties Parameters Binary Interaction
form.

Entering Supplemental Parameters

If any component being regressed is not in the Aspen Plus databank, do one of the
following:

• Enter the required parameters on Properties Parameters forms
• Estimate the parameters using the Properties Estimation forms

For example, suppose you are regressing binary VLE data using the WILSON
property method and a component is not in the databank. You must enter or
estimate the following parameters:  MW, TC, PC, ZC, DHVLWT, PLXANT, and
CPIG.

You can also enter values of the parameters to be determined on a Properties
Parameters form. Data Regression will use these values as initial guesses.

Fitting Pure Component Data

To fit pure component temperature-dependent property data, such as vapor
pressure data:
1. Use the Properties Data PURE-COMP form to enter the experimental data as

a function of temperature.

2. Use the Properties Regression Input form to specify the property method,
experimental data, and parameters to be regressed.
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Entering Pure Component Data

Use the Properties Data PURE-COMP form to enter experimental data for pure
component properties as a function of temperature. For example, you can enter
vapor pressure versus temperature data.

To enter pure component data:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager.

4. In the Create New ID dialog box, enter an ID or accept the default. Choose
PURE-COMP in the Select Type list box, and click OK.

5. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

6. On the Setup sheet, select the type of property data in the Property list box.
Prompts describe each property. You can limit the types of property data
under the Property list box, by selecting a property category in the Category
list box. The default category is All.

7. In the Component list box, specify the component for which you have
experimental data.

8. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure. A value entered in these fields applies to all data
points, and simplifies the entering of isothermal or isobaric data.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.

11. Enter standard deviation values for the property data or accept the system
defaults. See Entering Standard Deviations of Measurements, this chapter.

If you want Aspen Plus to ignore some data or standard deviations that have
already been entered, go to the Usage field, click on the row, and select Ignore.
Aspen Plus will not use the data point in any subsequent regressions.
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Fitting Phase Equilibrium and Mixture
Data

To fit phase equilibrium and mixture data, such as vapor-liquid equilibrium and
mixture density data:
1. Use the Properties Data MIXTURE form to enter experimental data. See the

following section.

2. Use the Properties Regression Input form to specify the property method,
experimental data, and the binary or pair parameters to be regressed. See
Formulating a Regression Case, this chapter.

Entering Phase Equilibrium and Mixture
Data

Use the Properties Data MIXTURE form to enter experimental data for phase
equilibrium and mixture properties as a function of temperature, pressure, and
composition. For example, you can enter Txy vapor-liquid equilibrium data for
two components.

To enter phase equilibrium and mixture data:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager. In the
Create New ID dialog box, enter and ID or accept the default. Choose
MIXTURE in the Select Type list box, and click OK.

4. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

5. On the Setup sheet, choose the type of property data in the Data Type list
box, from the choices in Tables 31.1 and 31.2. You can limit the types of
property data under the Property list box, by selecting a property category in
the Category list box. The default category is All.

6. Select the components from the Available Components list, and use the right
arrow button to move them to the Selected Components list.

7. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure. A value entered in these fields applies to all data
points.
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8. In the Composition Basis list box, specify the basis of the composition data.
You can enter composition data as mole fraction, mass fraction, mole percent,
or mass percent. Mole fraction is the default.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.

11. Enter standard deviations for the property data or accept the system defaults.
See Entering Standard Deviations of Measurements, this chapter.

If you want Aspen Plus to ignore some data or standard deviations that have
already been entered, go to the Usage field, click on the row, and select Ignore.
Aspen Plus will not use the data point in any subsequent regressions.

Data Types

Vapor-Liquid Equilibrium Data

Select For this data

TXY Isobaric VLE

PXY Isothermal VLE

TPXY T-P-x-y VLE

ALPHA Relative volatility. Defined with respect to the first component listed on the form.

Liquid-Liquid Equilibrium Data †

Select For this data

TXX T-x-x

PXX P-x-x

TPXX T-P-x-x

TPXXY† T-P-x-x-y

† Vapor-liquid-liquid equilibrium data

†† Use with NRTL or UNIQUAC-based property methods; the ELECNRTL property method; or SR-
POLAR, PRWS, PRMHV2, RKSWS, RKSMHV2, and PSRK equation-of-state property methods.

Mixture Property Data

Select For this data

CPLMX Liquid heat capacity

CPVMX Vapor heat capacity

CPSMX Solid heat capacity

Continued
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Mixture Property Data (Continued)

Select For this data

GLXS Excess liquid Gibbs free energy

HLMX Liquid enthalpy

HLXS Excess liquid enthalpy

HVMX Vapor enthalpy

HSMX Solid enthalpy

KLMX Liquid thermal conductivity

KVMX Vapor thermal conductivity

KSMX Solid thermal conductivity

MULMX Liquid viscosity

MUVMX Vapor viscosity

RHOLMX Liquid mass density

RHOVMX Vapor mass density

RHOSMX Solid mass density

SIGLMX Liquid surface tension

USER-X User property versus x

USER-Y User property versus y

VLMX Liquid molar volume

VVMX Vapor molar volume

VSMX Solid molar volume

Partial Property Data (Data for Components in a Mixture)

Select For this data

DLMX Liquid diffusion coefficients

DVMX Vapor diffusion coefficients

GAMMA Liquid activity coefficients

GAMMAS Solid activity coefficients

HENRY Henry's constants

KLL Liquid-liquid distribution coefficients

KVL Vapor-liquid K-values

USERI-X User partial property versus x

USERI-Y User partial property versus y
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Data Types for Electrolyte Systems

Select For this type of data To

GAMMAM Mean ionic activity
coefficient†

Determine parameters for the electrolyte activity coefficient
model

HLMX Liquid molar enthalpy Determine the temperature dependency of binary or pair
parameters for the activity coefficient model††

OSMOT Osmotic coefficient Determine parameters for the electrolyte activity coefficient
model

PH pH Determine chemical equilibrium constants (use only the
apparent component approach)

TPX Salt solubility††† Regress parameters for the electrolyte activity coefficient model
and chemical equilibrium constants for precipitating salts.
Obtain electrolyte-electrolyte pair parameters for the electrolyte
NRTL model

TX Salt solubility†††

TXY, PXY, or TPXY Vapor liquid equilibrium Regress electrolyte activity coefficient model parameters,
Henry's constants, and chemical equilibrium constants

TXX, TPXX, or TPXXY Liquid liquid equilibrium Regress electrolyte activity coefficient model parameters and
chemical equilibrium constants

VLMX Liquid molar volume Determine parameters for the Clarke density model

†
You can enter only the molality scale mean ionic activity coefficient data of single electrolyte systems.

††
Use data at several temperatures to ensure accurate representation of heat of mixing.

†††
Enter at saturation, for single or mixed electrolyte solutions. You must specify the salt precipitation
reactions on the Reactions Chemistry form.

Generating Binary VLE and LLE Data

You can generate VLE and LLE data for a two-component system, using a specified
property method. Aspen Plus can then use the generated data to regress
parameters for another property method. With this feature you can convert
parameters between different property models.

For example, you can generate VLE data using the UNIFAC predictive property
method, then use the generated data to determine the binary parameters for the
WILSON property method.
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To generate binary VLE and LLE data:
1. From the Data menu, click  Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager.

4. In the Create New ID dialog box, enter an ID or accept the default. Choose
MIXTURE in the Select Type list box, and click OK.

5. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

6. On the Setup sheet, choose the type of property data in the Data Type list
box:

Select To generate this data

TXY, PXY, or TPXY VLE

TXX or TPXX LLE

Do not select the GEN-TPXY or GEN_TPXX data type

7. Select the components from the Available Components list and click the right
arrow button to move them to the Selected Components list.

8. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure at which the data will be generated.

9. Click the Data sheet.

10. On the Data sheet, click the Generate Data button.

11. In the Generate Binary VLE or LLE Data dialog box, select a property
method, and a Henry’s Components ID and Chemistry ID, if applicable.

12. Click the Generate button to generate the data.

The Data sheet displays the liquid phase compositions for which data are to
be generated for the regression.

Entering Standard Deviations of
Measurements

The standard deviation of a measurement variable is an estimate of the magnitude
of random error. Data Regression assigns reasonable default values for standard
deviations, based on the property or data type you select. If you know the standard
deviations of your data, enter them on the Properties Data Data sheet.
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Data Regression assigns the following default standard deviation values:

For Value

Temperature 0.1 degrees†

Pressure 0.1%

Liquid compositions 0.1%

Vapor compositions 1.0%

Properties 1.0%

†
For Txx or TPxx data, the default is 0.01

You can assign a set of standard deviation values to:

• A single data point
• Several data points
• All data points in a data group

To enter a standard deviation row on a Properties Data Data sheet, go to the
Usage field, and select Std-Dev. The values you enter will apply to all subsequent
data points until another Std-Dev row is encountered. Enter the standard
deviation in percent or as an absolute value. Data Regression does not require
precise values of standard deviations. Usually you only need to determine the
appropriate order of magnitude and ratios.

A variable that has a standard deviation value of zero is treated as error-free.
Only state variables with little or no random error can have standard deviations
of zero. Properties such as vapor pressure or density cannot. You cannot enter all
standard deviation values as zero.

For phase equilibrium data, such as TPXY data, the number of non-zero
standard deviations must be greater than or equal to the number of phase
equilibrium constraints (or equivalently, the number of components in the
mixture that participate in phase equilibrium). For example, for TPXY data of
two components, you can assign a standard deviation of zero to only two
variables. Either T or P, and either X(1) or Y(1) can have zero standard
deviations. An exception is TPX data. You can set the standard deviation of X
and either T or P to zero.

Unrealistically small standard deviations for "noisy" measurement variables
cause convergence problems.

Plotting Experimental Data
You can display a plot of the experimental data you entered using the Plot
Wizard from the plot menu.
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Depending on the type of data you entered, the Plot Wizard allows the following
types:

Plot Typet Description

T-xy T-xy plot for isobaric VLE data

P-xy P-xy plot for isothermal VLE data

T-x T-x plot for isobaric VLE data

P-x P-x plot for isothermal VLE data

y-x y-x plot for VLE data

T-xx T-xx plot for LLE data

P-xx P-xx plot for LLE data

Prop-x Property vs. Composition

Prop-T Property vs. Temperature

Triangular Triangular diagram for ternary LLE data

Formulating a Regression Case

Use the Properties Regression forms to formulate a regression case.

A regression case requires:

• Experimental data
• Parameters for regression

To formulate a regression case:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Regression folder.

3. To create a new Regression ID, click New on the Regression Object Manager.
In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

4. To edit an existing ID, select the Regression ID from the Object Manger, and
click Edit.
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5. In the Property Options frame of the Regression Input Setup sheet, specify
property method, Henry Components ID, Chemistry ID, and electrolyte
calculation method. The global properties specifications you entered on the
Properties Specifications Global sheet are the default. You can select any
property method already entered on the Properties Specifications form.

6. At the bottom of the Setup sheet, use the Data Set list boxes to enter the Data
set IDs for the experimental data to be regressed. To assign more weight to
data sets, enter a value greater than 1 in the Weight field.

7. For each Binary VLE Data set referenced, you can choose whether you want a
thermodynamic consistency test performed, using the Perform Test check box.
If you choose to perform a consistency test, you can use the Test Method list
box to choose the type of consistency test. Also select whether you want to
reject data sets that fail the consistency test, using the Reject check box. For
more information see Thermodynamic Consistency Test for VLE Data, this chapter.

8. Click the Parameters sheet.

9. Enter the Parameters to be regressed, according to the procedure in the
following section, Specifying Parameters to be Regressed.

In many cases Aspen Plus will automatically complete the Regression Input form
based on the property method and Data sets you have specified. For example,
suppose you select the NRTL property method and enter Txy data for a binary
system. Aspen Plus completes the Regression Input form by:

• Filling in the Data ID field
• Specifying that the NRTL binary parameters are to be regressed

Specifying Parameters to be Regressed
In cases where the parameters to be regressed are not specified automatically, or
when you want to modify the default parameters or add additional parameters,
you can use the Regression Input Parameters sheet.

To specify parameters to be regressed:
1. In the Type field of the Regression Input Parameters sheet, select one:

Option For

Parameter Pure component parameter

Binary parameter Binary parameter

Group parameter UNIFAC group parameter

Group binary parameter UNIFAC group binary parameter

Pair parameter Electrolyte NRTL model pair parameter

Chemistry Equilibrium constants for electrolyte chemistry
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2. In the Name/Element list box, select the parameter names. The prompt
identifies parameters.

3. Enter the element number of the parameter in the field just to the right of the
parameter name. For group interaction parameters for the Lyngby-modified
UNIFAC and the Dortmund-modified UNIFAC models, only the first element
can be regressed.

4. Enter the component(s) or UNIFAC group IDs in the Component/Group list
boxes.

5. For each parameter, use the Usage list box to:

Specify If you want the parameter to be

Regress† Used in the current regression case

Exclude Excluded from the current regression case.†† The value in the Initial Value field is
ignored.

Fix Set to the fixed value given in the Initial Value field†††

† Default

†† If the parameter is in the databank or has been entered on the Properties Parameters
forms, Aspen Plus uses this value in the property calculation during the regression.

††† You can fix a parameter to a given value in one case, then set it to another value in
another case to study the effect on the fit. For example, you can fix the third element of the
NRTL binary parameter (the nonrandomness factor) in a case study to see which value gives
the best results.

6. You can enter Initial Value, Lower Bound, Upper Bound, and Scale Factor for
the parameter.

Thermodynamic Consistency Test for VLE
Data

Aspen Plus tests the binary VLE data you enter on the Data Mixture form for
thermodynamic consistency when you supply both of the following:

• Composition data for both the liquid and vapor phases
• At least five data points, not counting pure component data points (x=0.0 and

x=1.0)

Aspen Plus provides two methods for testing consistency:

• The area test of Redlich-Kister
• The point test of Van Ness and Fredenslund
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Both methods use the Gibbs-Duhem equation. For detailed information on both
tests, see J. Gmehling and U. Onken, Vapor-Liquid Equilibrium Data Collection,
DECHEMA Chemistry Data Series, Vol. I, Part 1, ed. Dieter Behrens and Reiner
Eckermann (Frankfurt/Main: DECHEMA, Deutsche Gesellschaft fur Chemisches
Apparatewesen, 1977).

By default, Aspen Plus performs the area test. To select another test method or
to change the test tolerance, use the Regression Input Setup sheet. On the Setup
sheet you can also specify whether you want to use or reject the data sets that
fail the consistency tests.

The Consistency Tests sheet on the Regression Results form indicates whether
your data passes or fails the consistency test. Failed data can cause accuracy and
convergence problems in your simulation. The test can fail because:

• The data contains errors, either in the original data or occurring during data
entry

• The vapor phase equation-of-state model does not appropriately account for
the vapor phase nonideality

• You do not have enough data points or the data cover only a small
concentration range. To obtain meaningful consistency test results, enter data
for the entire valid composition range.

If your data fail the test, check the data values and units in the Txy, Pxy, or TPxy
data you entered on the Data Mixture form.

To obtain meaningful consistency test results, enter data for the entire valid
composition range. You can ignore the test results if your data covers only a
narrow composition range.

Evaluating the Accuracy of Known Model
Parameters

You can use Data Regression to evaluate the accuracy of known model parameters.
Compare the calculated results obtained using the model with your experimental
data.
1. Select a property method on the Properties Specifications Global sheet. See

Chapter 7.

2. Enter the experimental data on the Properties Data forms. See Entering Pure
Component Data, and Entering Phase Equilibrium and Mixture Data, this
chapter.
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3. Enter the known model parameters on the Properties Parameters forms. See
Chapter 8. To evaluate parameters stored in the databanks, skip this step.

4. Specify the property method and experimental data to be used in the
evaluation on the Regression Input Setup sheet. See Formulating a
Regression Case, this chapter.

5. In the Calculation Type frame on the Regression Input Setup sheet, select
Evaluation.

Running the Regression

To run the regression, select Run from the Run menu or the Control Panel. If you
have more than one regression case, the Data Regression Run Selection dialog box
appears. All cases are listed in the Run area. The Don't Run area is empty. You
can:

• Run all the cases by clicking on OK.
• Change the order in which the cases are executed. Select a case and use the

Up and Down arrows.
• Exclude certain Regression cases from the run. Select a case, then use the left

arrow to move the case into the Don't Run area.

The order in which the regression cases are run may be significant. The
regressed parameter values from a regression case are used automatically in all
subsequent regression cases. Aspen Plus will execute the regression cases in the
order they appear in the Run area.

Using Regression Results

This section discusses examining, plotting and comparing regression results.

Examining Regression Results
To examine regression results:
1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Regression folder.
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3. From the Data Browser menu tree, double-click the Regression ID of interest,
and select Results.

The Regression Results form appears, containing these sheets:

Sheet Shows

Parameters Final parameter estimates, final parameter standard deviations, number of iterations
and the property method used

Consistency Tests Thermodynamic consistency test results

Residual Residual for each property: the experimental value; regressed value; standard
deviation; difference between the experimental and regressed values; the percent
difference. A summary of the deviation, including average and maximum deviations
can be obtaining by clicking the Deviations button

Profiles All experimental and calculated values. These data are used on all pre-defined
plots. (see Plotting Regression Results this chapter)

Correlation Parameter correlation matrix: intercorrelation between the parameters

Sum of Squares Objective function, regression algorithm, initialization method, final weighted sum of
squares and residual root mean square error

Evaluation Property method, final weighted sum of squares and residual root mean square
error for the evaluation of experimental data. This result sheet is only active for
Evaluation cases.

Extra Property Residuals for extra properties when VLE data is used, as requested on the
Regression Input Report sheet (for example, activity coefficients and K-values)

Problems with Data Regression Results

If your Data Regression run fails to converge, the Properties Data forms probably
contain data entry errors. Check the data values and units. Plot the data to check
for errors or outliers using the Plot Wizard from the Plot menu.

Inappropriate standards deviations may have been used for the data. See
Entering Standard Deviations of Measurements on page 9, for guidelines.

If you use binary VLE data, the data may not be thermodynamically consistent.
Request consistency test on the Setup sheet. Rerun the regression. Examine the
test results on the Regression Results Consistency Tests sheet.

When fitting different models to the same data set, choose the model that gives
the smallest residual root mean square error value.

On the Regression Results Correlation sheet, the off-diagonal elements of the
matrix indicate the degree of correlation between any two parameters. When the
parameters are completely independent, the correlation coefficient is zero. A
number close to 1.0 or -1.0 indicates a high degree of correlation. If possible,
select parameters that are not correlated. An important exception: asymmetric
binary parameters for activity coefficient models are highly correlated. Both the
ij and ji parameters are required for best fits.
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How to Identify Unsatisfactory Data Regression Results

It is possible for your Data Regression run to converge without errors, but with
results unsuitable for use in a simulation run. Use these Regression Results
sheets to identify bad fits:

• Parameters
• Sum of Squares
• Consistency Tests

These signs indicate a bad fit:

• A standard deviation for a regressed parameter is 0.0, indicating the
parameter is at a bound.

• A large residual root mean square error value. Normally, this value should be
less than 10 for VLE data and less than 100 for LLE data.

• Your VLE data fail the thermodynamic consistency test.

If any of these conditions exist, check the original data source and the data and
units on the Properties Data forms for errors. Plot the data using the Plot Wizard
from the Plot menu. Use the Regression Results Residual sheet to see how well
each data point was fitted. Look for out-liers.

Plotting Regression Results
When viewing the Regression Results form, you can use the Plot Wizard to
generate useful plots of the regression results. Aspen Plus provides a number of
predefined plots.

To start the Plot Wizard, choose Plot Wizard from the Plot menu on the main
menu bar while viewing the Regression Results form. Depending on your type of
regression, some of the plots below will be available:

Name of Plot Description

T-xy Temperature versus liquid and vapor composition for isobaric VLE data

P-xy Pressure versus liquid and vapor composition for isobaric VLE data

T-x Temperature versus liquid composition for isobaric VLE data

P-x Pressure versus liquid composition for isobaric VLE data

y-x Vapor versus liquid composition

T-xx Temperature versus liquid 1 and liquid 2 composition for LLE data

P-xx Pressure versus liquid 1 and liquid 2 composition for LLE data

Prop-x Property versus liquid composition

Prop-T Property versus temperature

Continued
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Name of Plot Description

(y-x) vs. x Vapor minus liquid composition versus liquid composition

Triangular Triangular diagram for ternary LLE data

Exp vs. Est Experimental versus calculated

Residual Residual versus property

The residual versus property plot shows how the errors are distributed. If the
measurement data contain no systematic errors, the deviations should distribute
randomly around the zero axis.

Predefined plots such as T-xy or P-xy display the experimental data as symbols
and the calculated values as lines. These plots allow you to assess the quality of
the fit. You can also identify bad data points by comparing the experimental data
with the calculated results.

You can use the Property Analysis capabilities (see Chapter 29) to plot T-xy or P-
xy diagrams at other conditions to check the extrapolation of the regressed
parameters.

Comparing Results from Several Cases
You can plot the results from several Regression cases on a single plot. This
allows you to compare several property models in fitting the same sets of data. To
plot results from several cases, select Add to Plot on the Plot Wizard (step 3). For
example, you could make a Txy plot using results from two cases:
1. From the Plot menu of a results form of the first case, use the Plot Wizard to

generate a T-xy plot.

2. Select the data group and component to plot. Click Next or Finish to display
the plot

3. Go to the Regression Results form. Do not close the plot.

4. Use the Plot Wizard from the Plot menu. Select the T-xy plot type. Click Next

5. Select the same data group and component as in step 2

6. For select Plot Mode, select Add to Plot, then select the first plot from the list
box

7. Click Next of Finish to display the combined plot.

You can change the plot attributes as necessary, by using the Properties option
from the right mouse button menu.



Aspen Plus User Guide 31-19
Version 10.1-0

Chapter 31

Using Regression Results in a Flowsheet Run
The parameters determined by regression are placed automatically on the
appropriate Properties Parameters forms. To use the regressed parameters in a
flowsheet run:
1. From the Data Browser, select the Setup Specifications Global sheet.

2. In the Run-type field, select Flowsheet.

You can copy regression and estimation results onto parameters forms on the
Component Data sheet:
1. From the Tools menu, select Options.

2. Click the Component Data tab.

3. Check the Copy Regression and Estimation Results Onto Parameters Forms
check box.

Retrieving Data From DETHERM and the Internet
You can retrieve a wide range of experimental data from DETHERM and the
internet. DETHERM contains the world's most comprehensive collection of
thermo physical property and phase equilibrium data. If you have a valid license
to use DETHERM, click the DETHERM icon on the main application tool bar to
search for the experimental data you need. Experimental data you retrieve will
appear on the Properties Data forms and are ready for use in data regression.
Please call your account manger at Aspen Technology to register to use Internet
DETHERM.
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Example of Regressing Vapor Liquid Equilibrium Data for Ethanol and
Ethyl-Acetate

For an ethanol-ethyl acetate system, the following vapor liquid equilibrium data
are available.

40C and 70C data of Martl, Collect. Czech. Chem. Commun.  37,266
(1972):

           T=40C                                 T=70C

P MMHG   X ETOAC  Y ETOAC              P MMHG   X ETOAC  Y ETOAC
136.600  0.00600  0.02200              548.600  0.00650  0.01750
150.900  0.04400  0.14400              559.400  0.01800  0.04600
163.100  0.08400  0.22700              633.600  0.13100  0.23700
183.000  0.18700  0.37000              664.600  0.21000  0.32100
191.900  0.24200  0.42800              680.400  0.26300  0.36700
199.700  0.32000  0.48400              703.800  0.38700  0.45400
208.300  0.45400  0.56000              710.000  0.45200  0.49300
210.200  0.49500  0.57400              712.200  0.48800  0.51700
211.800  0.55200  0.60700              711.200  0.62500  0.59700
213.200  0.66300  0.66400              706.400  0.69100  0.64100
212.100  0.74900  0.71600              697.800  0.75500  0.68100
204.600  0.88500  0.82900              679.200  0.82200  0.74700
200.600  0.92000  0.87100              651.600  0.90300  0.83900
195.300  0.96000  0.92800              635.400  0.93200  0.88800
                                       615.600  0.97500  0.94800

Atmospheric data of Ortega J. and Pena J.A., J. Chem. Eng. Data  31,
339 (1986):
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T C       X ETOAC  Y ETOAC        T C       X ETOAC  Y ETOAC
78.450    0.00000  0.00000        71.850    0.44700  0.48700
77.400    0.02480  0.05770        71.800    0.46510  0.49340
77.200    0.03080  0.07060        71.750    0.47550  0.49950
76.800    0.04680  0.10070        71.700    0.51000  0.51090
76.600    0.05350  0.11140        71.700    0.56690  0.53120
76.400    0.06150  0.12450        71.750    0.59650  0.54520
76.200    0.06910  0.13910        71.800    0.62110  0.56520
76.100    0.07340  0.14470        71.900    0.64250  0.58310
75.900    0.08480  0.16330        72.000    0.66950  0.60400
75.600    0.10050  0.18680        72.100    0.68540  0.61690
75.400    0.10930  0.19710        72.300    0.71920  0.64750
75.100    0.12160  0.21380        72.500    0.74510  0.67250
75.000    0.12910  0.22340        72.800    0.77670  0.70200
74.800    0.14370  0.24020        73.000    0.79730  0.72270
74.700    0.14680  0.24470        73.200    0.81940  0.74490
74.500    0.16060  0.26200        73.500    0.83980  0.76610
74.300    0.16880  0.27120        73.700    0.85030  0.77730
74.200    0.17410  0.27800        73.900    0.86340  0.79140
74.100    0.17960  0.28360        74.100    0.87900  0.80740
74.000    0.19920  0.30360        74.300    0.89160  0.82160
73.800    0.20980  0.31430        74.700    0.91540  0.85040
73.700    0.21880  0.32340        75.100    0.93670  0.87980
73.300    0.24970  0.35170        75.300    0.94450  0.89190
73.000    0.27860  0.37810        75.500    0.95260  0.90380
72.700    0.30860  0.40020        75.700    0.96340  0.92080
72.400    0.33770  0.42210        76.000    0.97480  0.93480
72.300    0.35540  0.43310        76.200    0.98430  0.95260
72.000    0.40190  0.46110        76.400    0.99030  0.96860
71.950    0.41840  0.46910        77.150    1.00000  1.00000
71.900    0.42440  0.47300

1. Start Aspen Plus and create a new run, selecting Data Regression as the Run
Type.

2. Enter the components on the Components Specifications Selection sheet:
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Note  A complete backup file with results for this example is available in the
Aspen Plus Online Applications Library. The filename is DRS1.

In this example three activity coefficient models will be fitted to the VLE
data, each in a separate case.

3. Select the property method.

 Use the Properties Specifications Global sheet to choose a property method.
This example compares fitting results for the Wilson, NRTL, and UNIQUAC
property methods. Select one of the three on the Global sheet and the
remaining two on the Referenced sheet. In this example, the Wilson model is
chosen on the Global sheet.

 

 

4. Enter experimental data.

 Use the Properties Data Mixture form to enter the vapor liquid equilibrium
data. Three data sets are required, one for each set of VLE data. The
following setup and Data sheets are for the 40°C isothermal data set.
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5. Specify the regression case.

 Use the Properties Regression form to formulate a regression case. In this
example, Aspen Plus has already completed the Properties Regression Input
form. Since the WILSON property method is the Global property method, it is
used as the default in the regression. All the VLE data groups you entered in
Step 4 are on this form. Aspen Plus will test the data for thermodynamic
consistency, using the Area test.
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 Since the VLE data cover a wide temperature range, Aspen Plus selects
elements 1 and 2 of the Wilson binary parameters for regression. Aspen Plus
uses the databank values for the binary parameters as initial guesses in the
regression.

 

 

 

6. Specify additional regression cases.
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Use the Regression Object Manager to specify two additional cases. Use the
same set of experimental data, but with the NRTL and UNIQUAC property
methods. Again Aspen Plus completes the Regression Input form. However,
since the WILSON property method is the global property method , it is the
default. Specify NRTL in the Method list box on the Setup sheet, so that the
NRTL property method is used in the second case. When the NRTL property
method is used, the NRTL binary parameters must be regressed. Specify the
NRTL binary parameter elements 1 and 2 as the regression parameters.
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Repeat this step for the UNIQUAC property method.

7. Run the regression.

 Run all three cases. Click OK on the Data Regression Run Selection dialog
box. You can also run selected cases. Move the cases you do not want to run
into the Don't Run area, using the left arrow.

 

 

8. Examine the results on the Regression Results form.
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 Use the Regression Results Parameters sheet to examine the final parameter
values.

 

 

 Use the Regression Results Sum of Squares sheet to examine the weighted
sum of squares and residual root mean square errors.

 

Use the Regression Results Consistency Tests sheet to examine the results of
thermodynamic consistency tests. All data groups passed the Redlich Kister
area test.

Use the Regression Results Residual sheet to examine the residual for the fit
of pressure, temperature, and composition.
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Use Plot Wizard from the Plot menu to plot the residual of pressure for case
VLE 1.

You can also plot the residual of other variables.

It is most useful to compare experimental data with calculated results. From the
Plot menu, use the Plot Wizard to generate a P-xy plot for the first data group.
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Add the results from the NRTL and UNIQUAC cases to the plot for WILSON.
(See Comparing Results From Several Cases, this chapter.)

❖     ❖     ❖     ❖ 
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32 Petroleum Assays and
Pseudocomponents

This chapter explains how to use the Assay Data Analysis and Pseudocomponent
System (ADA/PCS) to define and characterize petroleum mixtures.

Topics include how to:

• Use ADA/PCS
• Create assays and enter assay data
• Create a blend and enter blend specifications
• Generate and define pseudocomponents
• Define and modify petroleum properties
• Examine ADA/PCS results

About ADA/PCS

You can use ADA/PCS for defining and characterizing petroleum mixtures.

You can enter data for any number of assays. The minimum assay data consists
of a distillation curve and a bulk gravity value. You can enter optional data, such
as:

• Light-ends analysis
• Gravity curve
• Molecular weight curve

You can enter any number of petroleum property curves, such as:

• Sulfur content
• Metal content
• Freeze point



32-2 Aspen Plus User Guide
Version 10.1-0

Petroleum
Assays and
Pseudocomponents

• Octane numbers

Given data for any number of assays, ADA/PCS:

• Converts the distillation data into the true boiling point basis
• Performs extrapolations on assay curves and estimates any missing data
• Generates blends from two or more assays
• Develops sets of pseudocomponents to represent the assays and blends
• Reports distillation curves for assays and blends in user-specified bases
• Estimates physical properties for each pseudocomponent

You can define your own pseudocomponents and use ADA/PCS to estimate their
physical properties.

Using ADA/PCS

You can use ADA/PCS in:

• A standalone Assay Data Analysis run
• A Flowsheet simulation run

To use ADA/PCS on a standalone basis, specify Assay Data Analysis in the Run
Type list on the Setup Specifications Global sheet. Or specify Assay Data
Analysis in the Run Type list on the New dialog box when creating a new run.

In an Assay Data Analysis run, only ADA/PCS calculations are performed. You
can display and plot the distillation curves for assays and blends in different
bases, and examine the generated pseudocomponents and their properties.

In a Flowsheet run, you can use assays, blends, and pseudocomponents to define
process feed streams for the simulation. If you entered petroleum properties,
Aspen Plus automatically associates these properties with the streams.

Creating Assays

You can define an assay using one of the following:

• Components Specifications Selection sheet
• Assay-Blend Object Manager
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Defining an Assay Using the Components Specifications
Selection Sheet

To define an assay using the Components Specifications Selection sheet:
1. From the Data menu, select Components, then Specifications.

2. On the Components Specifications Selection sheet, enter a name for the assay
in the Component ID field.

3. In the Type list, select Assay as the component type.

4. In the left pane of the Data Browser, click the Assay/Blend folder.

5. In the Assay/Blend Object Manager, select the Assay ID for which you are
entering assays, then click Edit. The Components Assay/Blend Basic Data
form appears:

Select the appropriate Assay sheet to enter assay data.

Defining an Assay Using the Assay-Blend Object
Manager

To define an assay using the Assay-Blend Object Manager:
1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, click New.

3. In the Create New ID dialog box, choose Assay in the Select Type list.
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4. Enter an ID for the assay, or accept the default ID.

5. Click OK.

The Assay Input Menu appears. Select the appropriate Assay sheet to enter assay
data.

Entering Assay Data

For each assay you must enter:

• At least four points on a distillation curve
• Either a bulk gravity or a gravity curve

Instructions for enter this required data, as well as other optional data, are
contained in the subsequent discussions of sheets and forms.

Entering a Distillation Curve and Bulk Gravity Value
The assay distillation curve and bulk gravity value are entered on the Dist Curve
sheet of the Components Assay/Blend Basic Data form.

To enter the required distillation curve and gravity input:
1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, select the assay for which you wish to
enter data, and click Edit.

3. On the Dist Curve sheet, select a type of curve in the Distillation Curve Type
list.

4. In the Percent Distilled and Temperature columns, enter at least four pairs of
distillation percent and temperature values for the curve.

5. In the Bulk Gravity Value frame, enter either Specific Gravity or API
Gravity, by clicking the appropriate radio button, and typing in the value.

- or -

Click the Gravity/UOPK tab to open that sheet, and enter in a gravity curve.
(See next section for details on entering a gravity curve.)

By default Aspen Plus reports the distillation curve in the input and the true
boiling (liquid volume) basis. You can use the Optional sheet to request
additional distillation curves to be reported for the assay.
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Use the remaining sheets on the Basic Data form, as well as the Property
Curves form, to enter optional information as described below.

Entering a Gravity Curve
If you do not enter a bulk gravity value on the Dist Curve sheet, you must enter a
gravity curve using the Gravity/UOPK sheet. You may enter either:

• Gravity curve data
• Watson UOP K curve data

Gravities you specify on this sheet are normalized to match the bulk gravity
value specified on the Dist Curve sheet.

To enter a gravity curve:
1. On the Gravity/UOPK sheet of the Components Assay/Blend Basic Data form,

select the type of gravity data you wish to enter by clicking one of the options
in the Type frame.

2. Enter at least four pairs of mid-percent and gravity values to define the
profile in the columns for data.

If you enter a Watson UOPK curve, you must enter an average gravity on the
Assay Basic Data Dist Curve sheet. If the distillation type is True Boiling Point
(weight basis) or Vacuum (weight basis), you cannot enter a Watson UOPK
curve.

Entering a Molecular Weight Curve
You can enter a molecular weight curve using the Molecular Wt sheet of the
Assay/Blend Basic Input form. If you do not enter a molecular weight curve,
Aspen Plus estimates it from the distillation curve and gravity you specify.

To enter a molecular weight curve:

➤ On the Molecular Wt sheet, enter at least four pairs of values in the Mid
Percent Distilled and Molecular Weight fields to define the curve.
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Entering Light-Ends Analysis
You can enter light-ends analysis for an assay in terms of the compositions of
light-ends components. If you enter light-ends analysis, Aspen Plus does not
generate pseudocomponents for the light-ends portion of the assay. If you wish to
specify light-ends analysis, do this on the Light Ends sheet of the Components
Assay/Blend Basic Data form.

To enter a light-ends analysis:
1. In the Light Ends Analysis frame of the Light Ends sheet, use the Component

and Fraction columns to enter the component IDs and light ends fractions
that make up the analysis. For your fractions, you can select a basis of Mass,
Mole, or Standard Liquid Volume at the top of the column.

2. If the light-ends component is not in the databank, specify gravity and
molecular weight in the Gravity and Molecular Weight fields of the analysis
table.

3. Optionally, at the top of the sheet, enter the light-ends fraction as a fraction
of the assay, in the Light Ends Fraction field.

If you enter this value, the specified individual component fractions are
normalized to this overall value. If you omit this value, individual component
fractions are treated as fractions of the entire assay mixture.

Entering Petroleum Property Curves
You can enter any number of petroleum property curves for an assay, using the
Petro Properties sheet of the Components Assay/Blend Property Curves form.
Aspen Plus allows a variety of built-in curve types. Based on these curves,
Aspen Plus assigns property values to individual pseudocomponents in the
simulation.

Examples of petroleum properties include:

• Sulfur content
• Metal content
• Octane numbers

To enter petroleum property curves:
1. On the Petro Properties sheet, select a petroleum property in the Property

Type list.

2. In the Property Curve Data frame, enter at least four pairs of values in the
Mid Percent Distilled and Property Value fields, to define the curve.
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3. Optionally, enter a bulk value for the property in the Bulk Value field. If you
enter a bulk value, Aspen Plus normalizes the individual curve values to the
bulk value.

4. To enter additional property curves, repeat steps 1 through 3 for each
additional property.

Entering Viscosity Curves
You can enter viscosity curves at different temperatures for an assay using the
Viscosity sheet of the Components Assay/Blend Property Curves form. Viscosity
curves can be entered as either absolute or kinematic viscosity values as a
function of percent distilled for the assay. Based on these curves, Aspen Plus will
assign viscosity to pseudocomponents generated for the assay.

To enter viscosity curves:
1. On the Viscosity sheet of the Components Assay/Blend Property Curves form,

choose a type of viscosity (Absolute or Kinematic) by clicking on the
appropriate option in the Type frame.

2. In the Temperature list, select New.

3. In the New Item dialog box, enter a temperature for the viscosity curve, and
click OK.

4. In the Mid Percent Distilled and Viscosity fields, enter at least four pairs of
values to define the curve.

5. To enter viscosity curves at additional temperatures, repeat steps 1 through 5
for each curve.

To compute viscosity at multiple temperatures from the curves in the simulation,
you must enter viscosity curves for at least two temperatures.

Creating a Blend

You can create a blend from any number of assays.

Aspen Plus performs blending on all available assay data:

• Distillation curves
• Gravity curves
• Molecular weight curves
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• Light-ends analysis
• Petroleum properties curves
• Viscosity curves

Petroleum and viscosity curves are blended using the built-in or user-supplied
blending rules. See Modifying Petroleum Property Definitions, this chapter.

When you define a stream using a blend, Aspen Plus automatically associates the
petroleum properties and viscosity for the blend with the stream.

You can define a blend using either of the following:

• Components Specifications Selection sheet
• Assay-Blend Object Manager

Defining a Blend Using the Components Specifications
Selection Sheet

To define a blend using the Components Specifications Selection sheet:
1. From the Data menu, select Components, then Specifications.

2. On the Components Specifications Selection sheet, enter a name for the blend
in the Component ID field.

3. In the Type list, select Blend as the component type.

4. In the left pane of the Data Browser, click the Assay/Blend folder.

5. In the Assay/Blend Object Manager, select the Blend ID you just created, and
click Edit. The Components Assay/Blend Mixture form appears:
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To enter the blend specifications, see Entering Blend Specifications, this chapter.

Defining a Blend Using the Assay-Blend Object
Manager

To define a blend using the Assay-Blend Object Manager:
1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, click New.

3. In the Create New ID dialog box, choose Blend in the Select Type list.

4. Enter an ID for the blend, or accept the default ID.

5. Click OK.

The Components Assay/Blend Mixture form appears. To enter the blend
specifications, see Entering Blend Specifications, this chapter.

Entering Blend Specifications

To enter blend specifications, use the Specifications sheet of the Components
Assay/Blend Mixture form:
1. On the Specifications sheet, select two or more assays in the Assay ID

column, and specify the corresponding fraction of each assay, in the Fraction
column. You can enter the assay blending fractions on a mole, mass or
standard liquid volume basis.

2. By default Aspen Plus reports the distillation curve for the blend using the
input basis and the true boiling point (liquid volume) basis. If you want to
request additional distillation curve reports for the blend, you can specify this
by clicking the desired curves in the Report Distillation Curve As frame.

Specifying Assay Analysis Options

Aspen Plus provides several options for:

• The assay data analysis procedure
• Converting and extrapolating distillation curves
• The initial and final boiling points for distillation curves
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The defaults are appropriate for most applications.

To override the default options:
1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Analysis Options
folder.

3. On the Assay Procedures sheet, choose the preferred analysis procedure by
clicking one of the options in the Assay Data Analysis Procedure frame:

Version 9 or later

 - or -

Version 8 or earlier

4. In the Curve Processing Options frame, you can optionally modify any of the
following specifications from their defaults:

Specification Default

Initial boiling point 0.5

Final boiling point 99

Extrapolation method Probability

Spline fitting method Harwell

5. In the Distillation Curve Conversion Method frame, you can optionally modify
the default conversion methods.

Modifying Petroleum Property
Definitions

Aspen Plus has a list of pre-defined petroleum properties. You can enter property
curves for these petroleum properties, as discussed in Entering Petroleum Property
Curves, this chapter.

Examples of the built-in petroleum properties include:

• Sulfur content
• Metal content
• Freeze point
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• Octane numbers

You can modify the definition of these pre-defined properties, or you can define
new properties. See Defining a New Petroleum Property, this chapter.

To modify the definition of a petroleum property:
1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Analysis Options
folder.

3. On the Analysis Options form, select the Blend Options sheet.

4. In the Property list, select a petroleum property you wish to modify.

5. In the Blend Method field, select a property blending method.

6. If you are using a user blending subroutine, enter an option code in the Blend
Option field. See Aspen Plus User Models for instructions on writing this
subroutine.

7. If the property curve does not encompass 0 and 100 percent, specify whether
it is to be extrapolated in the Extrapolate field.

About Pseudocomponents

You can specify how assays and blends are used to generate pseudocomponents.
ADA/PCS can generate one or more sets of pseudocomponents for a group of assays
and blends. You can use a particular assay or blend to generate only one set of
pseudocomponents.

If you do not enter any specifications for pseudocomponent generation, ADA/PCS
generates one average set of pseudocomponents for all the assays and blends.
The average set uses equal weighting for each assay and blend.

You should use ADA/PCS to generate pseudocomponents only for assays and
blends used to define flowsheet streams. This achieves the best characterization
for a simulation. Typically you enter data for several assays to create a blend,
then use the blend to define flowsheet streams. Generate pseudocomponents for
the blend only.

In general, one average set of pseudocomponents for all assays and blends in the
simulation is sufficient. Assign weighting factors to assays and blends to reflect
their relative flow rates.
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At times you can improve characterization accuracy by generating a separate set
of pseudocomponents for each assay and blend. Use separate sets of
pseudocomponents when multiple assays and blends define flowsheet streams,
and in the assay/blend:

• Distillation curves have significant overlaps.
• Gravities and Watson K factors are very different.

Multiple sets of pseudocomponents in the simulation increase computation time.

Entering Specifications for Generation of
Pseudocomponents

To generate a set of pseudocomponents:
1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, select the Generation folder.

3. In the Generation Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for the set of
pseudocomponents, or accept the default ID.

5. Click OK.

The Components Petro Characterization Generation form appears with the
Specifications sheet selected:
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6. On the Specifications sheet, select the assays and blends for which an average
set of pseudocomponents is to be generated, using the Assay/Blend ID list.

7. In the Weighting Factor field, you can assign weighting factors to reflect the
relative importance of each assay or blend in the generation of
pseudocomponents. By default each assay or blend is given an equal weight of
one.

8. At the bottom of the sheet, select a property method in the Property Method
list. This property method represents the models to be used in the estimation
of all pseudocomponent properties. By default ADA/PCS uses the ASPEN
pseudocomponent property method to estimate pseudocomponent properties.
See About Pseudocomponent Property Methods, this chapter, for a description
of the built-in property methods.

Specifying Cut Points

By default Aspen Plus generates pseudocomponents using a standard set of cut
points:

TBP Range ( F) Number of Cuts Increments ( F)

100 – 800 28 25

800 – 1200 8 50

1200 – 1600 4 100

To override the standard cut points, use the Cuts sheet on the Generation form to
specify a list for one of the following:

• Cut temperatures
• Cut ranges. For each range, enter either the number of cuts or the

temperature increment for each cut.

Pseudocomponent Naming Options

By default the generated pseudocomponents are named according to their mean
average normal boiling point. You can use the Naming Options sheet on the
Generation form to select from five built-in naming conventions. If you choose
User Defined List, you must enter the pseudocomponent IDs in the
Pseudocomponent fields of the Preview of Pseudocomponent Names frame. These
IDs then appear on the Stream Input Specifications sheets, allowing you to enter
pseudocomponent flows.
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Defining Pseudocomponents and
Entering Pseudocomponent Properties

In addition to allowing Aspen Plus to automatically generate pseudocomponents for
your specified assays and blends, you also can choose to define pseudocomponents
directly.

To create user-defined pseudocomponents, first enter them on the Components
Specifications form:
1. From the Data menu, select Components, then Specifications.

2. On the Selection sheet, enter the names for the user-defined
pseudocomponents in the Component ID fields.

3. Select PseudoComponent as the component type in the Type list. Leave the
Component Name and Formula fields blank for pseudocomponents.

Entering Basic Properties for Pseudocomponents
Once the pseudocomponents are defined on the Components Specifications form,
enter the basic properties for the pseudocomponent on the Components Pseudo
Components Specifications sheet:
1. From the Data menu, select Components, then PseudoComponents.

The Components PseudoComponents form appears with the Specifications
sheet displayed:
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2. On the Specifications sheet, the pseudocomponents you defined on the
Components Specification form are listed in the Pseudocomponents column.
For each pseudocomponent, enter at least two of the following properties to
characterize the pseudocomponent:

• Average normal boiling point
• Gravity/Density
• Molecular weight
Gravity or density can be entered in any of the following formats:

• API gravity
• Specific gravity
• Standard liquid density

3. If you wish to modify the default pseudocomponent property method, select a
new method in the Property Method list. About Pseudocomponent Property
Methods, this chapter, for descriptions of the built-in option sets.

The default view of the PseudoComponents Specification sheet is the Basic
Layout view. This view allows for a single pseudocomponent property method,
and a single type of gravity or density to represent all pseudocomponents. If you
wish to specify different property methods, or different types of gravity or density
for individual pseudocomponents, you can select Advanced Layout from the View
list at the top of the sheet. The Advanced Layout allows individual specifications
of property methods and gravity or density types for each pseudocomponent.

Entering Temperature-Dependent Properties for
Pseudocomponents

From the basic pseudocomponent properties you entered on the
PseudoComponents Specifications sheet, Aspen Plus estimates all pure
component properties needed for flowsheet simulation.

Optionally, you also can provide vapor pressure, viscosity, and water solubility
data as a function of temperature for pseudocomponents. This improves the
accuracy of the characterization.

To enter these temperature-dependent properties:
1. From the Data menu, select Components, then PseudoComponents.

2. On the Components PseudoComponents form, there are separate sheets for
Vapor Pressure, Viscosity, and Water Solubility. Click the appropriate sheet
for the type of data you wish to enter.

3. On the selected sheet, choose a pseudocomponent from the Component ID list.
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4. In the frame below the Component ID, enter the property data as a function
of temperature.

5. To enter data for other components, repeat steps 3 and 4.

6. To enter another property, repeat steps 2 through 4.

About Pseudocomponent Property
Methods

A pseudocomponent property method is a collection of models for estimating
pseudocomponent properties needed for flowsheet simulation. Pseudocomponent
properties that are estimated include:

• Molecular weight
• Critical properties
• Acentric factor
• Vapor pressure
• Liquid molar volume
• Water solubility
• Viscosity
• Ideal gas heat capacity
• Enthalpy of vaporization
• Standard enthalpy and free energy of formation
• Equation of state properties

You can use a pseudocomponent property method in one of two ways:

On sheet Specify a pseudocomponent property method for

Components Petro Characterization Generation
Specifications

Pseudocomponents generated from assays

Components PseudoComponents
Specifications

User-defined pseudocomponents
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You can choose from five built-in pseudocomponent property methods:

Method Description

API-METH Uses procedures recommended by the American Petroleum Institute (API) Data Book.

COAL-LIQ Uses correlations developed for coal liquids.

ASPEN Based on the API-METH property method, with proprietary AspenTech enhancements for
selected properties. (Default option set)

LK Uses correlations by Lee and Kesler.

API-TWU Based on the ASPEN property method, but uses correlations by Twu for critical properties.

You also can create your own pseudocomponent property methods. Use your own
property methods in the same way as the built-in option sets. For details on
creating your own pseudocomponent property methods, see the following section.

Creating Pseudocomponent Property
Methods

You can create your own pseudocomponent property methods by starting with a
built-in method, and modifying individual models for different pseudocomponent
properties.

Aspen Plus provides several built-in models for each pseudocomponent property.
Or you can supply your own model using a user-supplied subroutine. See
Aspen Plus User Models for instructions on writing this subroutine.

To create a new pseudocomponent property method:
1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Properties folder.

3. In the Petro Characterization Properties Object Manager, click New.

4. In the Create New ID dialog box, enter an ID (name) for the new method, or
accept the default ID.

5. Click OK.

6. On the Basic sheet of the Properties form for the new method, select one of
the built-in methods, by selecting from the Copy All Models From list. The
chosen property method will be used as a basis for the new method.

The remaining fields on the sheet (as well as the Thermodynamic sheet and
the EOS sheet) display the models used by the base method for each property.
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7. Use the remaining fields on the Basic sheet, the Thermodynamic sheet and
the EOS sheet, to specify the property models which make up the property
method.

Defining a New Petroleum Property

You can use a new petroleum property in the same ways as a pre-defined
petroleum property. You can enter the curve data of this property for any assay.
See Entering Petroleum Property Curves, this chapter.

You can define any number of additional petroleum properties to be used on the
Prop-Sets Properties sheet and the Assay/Blend Property Curves form.

To define a new petroleum property:
1. From the Data menu, select Properties, then Advanced.

2. In the left pane of the Data Browser window, click the User Properties folder.

3. In the User Properties Object Manager, click New.

4. In the Create New ID dialog box, enter an ID (name) for the new property, or
accept the default ID.

5. Click OK.

6. On the Specifications sheet of the Properties Advanced User Properties form,
click the Assay Curve Property radio button at the top of the sheet.

7. In the Assay Curve Property Frame, select a blending method from the
choices provided. The default method is Standard Liquid Volume Averaging.

If you choose to use a user blending subroutine, enter an option code in the
Blending Option field. See Aspen Plus User Models for instructions on writing
this subroutine.

8. In the Default Property Used for Light Ends list, select a property to provide
values for light-ends components.

9. At the bottom of the sheet, you can choose whether you want to extrapolate
curve data that does not encompass the entire composition range (0-100%).
Extrapolation is turned on by default. To turn off this option, click the check
box to deselect it.

10. Click the Units sheet.

11. Click the appropriate check box to specify how you want the units conversion
to be calculated.
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12. If you choose to let Aspen Plus perform the units conversion, select the type of
units in the Units type list.

13. If you choose to perform the units conversion in a user subroutine, enter a
units label in the Units Label field. This label will be used in stream reports
and property curve results.

Examining ADA/PCS Results

Aspen Plus produces a variety of ADA/PCS results. You can examine

• ADA results
• Pseudocomponent property results

Examining ADA Results
To examine ADA results:
1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay/Blend Object Manager, select the assay or blend for which you
want to display results, and click Edit.

3. In the left pane of the Data Browser window, click the Results form beneath
the selected assay or blend.

The Assay-Blend Results form appears, containing these sheets:

Sheet Shows

Light Ends Analysis Results of the light ends analysis

Pseudocomp Breakdown Pseudocomponent and light ends breakdown results

Curves Distillation curves and bulk properties results

Blend Fraction (Blends only) Compositions of blends

4. From the Curves sheet, you can generate plots of distillation temperatures
versus percent distilled. See chapter 13 for instructions on generating plots.
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Examining Pseudocomponent Property Results
To examine pseudocomponent property results:
1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser, click the Results folder.

The Summary sheet on the Components Petro Characterization Results form
displays the key properties for each pseudocomponent in table format.

3. You can generate plots of pseudocomponent properties versus boiling points
or any other property. See Chapter 13 for instructions on generating plots.

❖     ❖     ❖     ❖ 
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